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Welcome to ADR Manager
ADR Manager is a comprehensive database system for Automated Dialogue Replacement professionals. It has been used worldwide on hundreds of feature films and television shows, and has garnered praise for its ease of use and power.

For sales and support information, please visit our website at www.slanecon.com.

This online help system can be accessed at any time from within ADR Manager by choosing Help for ADR Manager under the Help menu, or by clicking on the question mark button in most windows.
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Introduction

ADR Manager is a powerful way to spot and maintain Automatic Dialogue Replacement cues for film and television. It was designed to be easy to learn, but fine-tuned to give you maximum speed and efficiency. ADR Manager lets you:

Spot cues in timecode or feet and frames, either by manually entering values or grabbing times from another application such as Pro Tools. Switch between time formats at any time.
Find cues by many different attributes, including dialogue, character, notes, or priority. Perform complex multi-step searches with ease.
Audition takes, then rate and/or circle them. Drop them into a Pro Tools session, or reveal the sound file in the Finder. Import take information from text files, Pro Tools sessions, or by scanning a folder. Build a searchable, auditionable library
of all the production and ADR recordings for your project.
Generate many different kinds of reports, including actor cue sheets, editor cue sheets, mixer/recordist cue sheets, master cue sheets, line count tables, character lists, reel lists, and continuity lists. You can completely customize the default
reports to your liking.
Batch print multiple reports with a single click of the mouse. Print all of the actors’ cue sheets for the entire project, for instance, with a separate report for each actor. Or generate a line count table of cues that have yet to be recorded.
Keep track of characters, reels and scenes. Create and store any number of dupes for each reel.
Lift and hold entire regions of cues and insert them elsewhere, as in a rebalance.
Automatically create unique cue names for each cue as you’re entering them, or assign cue names afterwards with one command. Customize how cues are named, then use that naming convention to perform automatic linking between sound
files, takes, and cues.
Import and export cues, reels, characters, scenes, and reports in a variety of file formats.
Manage your ADR information with a simple, efficient interface.
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Who should use ADR Manager

This application is designed for ADR supervisors, editors, assistants, mixers, and recordists. It assumes familiarity with the nomenclature and processes used in film and television ADR. A basic understanding of your computer is also required.

Changing font sizes and styles, or adding, deleting, or moving things around on reports is easy to do. An intuitive graphical interface is available to let you change things quickly. However, if you wish to write your own scripts for the reports, you will
need some knowledge of the 4th Dimension programming language. Contact Slanecon Digital for more information.
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What’s new in ADR Manager 5

New features in version 5 of ADR Manager include:

Lion compatible. This version is Universal Binary, which means not only is it compatible with 10.7, it runs faster too. Requires an Intel processor.
Import change lists. Import an Avid change note, then conform your cues by performing the changes one at a time or all at once. Print the change note in an easy to read format.
Window customization. Customize the look of various windows. Choose which columns are displayed, and what font type/size/style/color/alignment you want in each. Set up the window so that each row changes height and nothing gets cut
off. For example, you can display character pictures in the Character List window.
Pro Tools 10 support. Import cues or scenes from session text files created with Pro Tools 10. Drop takes into a Pro Tools session trimmed to the cued start and end time, stacked vertically over multiple tracks or placed end to end on the
same track, synced to their recorded time, and/or placed on multichannel tracks.
Cue creation and modification dates. Do searches based on when a cue was created or modified. Find out what you changed today, yesterday, or last week.
Take access. View all of the takes for a cue in the Modify Cue window. Click on a take and audition it directly in the window.
Report impovements. A new report called "Editor cuesheet w/takes" displays a list of takes for each cue in the cuesheet. Show circled take numbers and recording notes for each take. Display all notes without without worrying about having
them truncated.
Diagnostics and logs. New diagnostics tools built into the application help you troubleshoot problems.
Ease of use. Buttons appear at the top of each List window for common tasks.

ADR Manager 5 User Manual  11



Installing ADR Manager
This chapter describes how to install the ADR Manager program.

The ADR Manager installer can be downloaded from the Slanecon Digital website at:

http://www.slanecon.com/support.php

You will also need an iLok copy protection key with the proper authorization in order to run the application. ILok copy protection keys can be purchased from PACE Anti-Piracy Inc. at:

http://www.ilok.com

Authorizations can be purchased at:

http://www.slanecon.com/buy-now.php

IMPORTANT NOTE: Do not lose the copy protection key. If you lose it (and the authorization within it), you will have to purchase another copy of the program, since the purpose of the key is to prevent software piracy.

IMPORTANT NOTE: Please note that the protection insurance available from PACE Anti-Piracy, Inc. called “zero downtime coverage” does not work with ADR Manager.
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Requirements

ADR Manager runs on any Macintosh desktop or laptop computer with the following requirements:

Intel processor
1GB RAM minimum (2GB RAM recommended)
Mac OS X 10.5.8 or later
400 megabytes of hard disk space to install the application and other files, and an additional 5-7 megabytes of hard disk space for a typical project’s data.
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Before you install the software

Before you install ADR Manager, remove any older versions of the program from your hard disk. To remove old versions of ADR Manager for the Macintosh, simply drag the ADR Manager folder to the trash. Be sure to check for and remove any data
files you may have created in the ADR Manager folder before throwing it out.
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Installed components

Once you’ve finished the installation, you should have a folder called “ADR Manager” in your “Applications” folder. The ADR Manager folder will contain:

ADR Manager application
Default Reports folder - Ccontains default reports you can use to print cue sheets, line count tables, reel LFOA lists, etc. The reports in this folder are automatically imported when you create a new datafile.
Documentation folder – Contains all the documentation you need to use ADR Manager. It contains The ADR Manager User’s Manual (this manual). It is stored in Adobe Acrobat (PDF) format, so you will need Acrobat Reader, available for
free from Adobe. A “What’s new” file, which describes the new features or bug fixes that have been added since the last version, is also inside this folder.
Scripts folder – Contains example AppleScripts you can use to control and customize ADR Manager.
Utilities folder – Contains utilities that let you port old datafiles to the newest version.
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Installing the copy protection key

Only one person can use ADR Manager at a time, although you can have the software installed on many computers. This is enforced by a device called a copy protection key. Whenever you use ADR Manager, the software checks to see if the copy
protection key is plugged into your computer. If it is not plugged in when you start up, the program will give you the option to buy it at the Slanecon Digital website or quit. If the key is unplugged while you’re using ADR Manager, the program will quit.

The copy protection key must be plugged into a USB (Universal Serial Bus) port. Your keyboard and mouse are plugged into USB ports. To install the copy protection key, simply plug the copy protection key into an available USB port. We’ve found
that a powered USB port works best, such as a port on a USB hub – plugging the key into a port on the keyboard does not work well.

For more information about the iLok copy protection key, please visit www.ilok.com.
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Using older database files with ADR Manager

You can migrate data from database files created with older versions of ADR Manager into version 5. The AM2 Exporter and AM3 Exporter utilities let you open and export data from ADR Manager v2 and ADR Manager v3 database files,
respectively. These utilities are available in the ADR Manager > Utilities folder. You can then import the data into a new v5 database.

See Migrating data from old versions for more information.
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If you need help
There are several ways to get help if you have problems or questions about ADR Manager. The first way is by referring to this manual. The second way is to use our web site and the user group. If all else fails, you can get further support by
contacting Slanecon Digital technical support.

Using online help

Great care has been taken to make the online help comprehensive and accurate. It is your best resource to answer questions and help you learn how to use ADR Manager. You can access online help by choosing ADR Manager Help under the
Help menu at any time.

You can also get help for a specific window or command by clicking on the Help button available in most windows: 

We welcome any comments or criticisms regarding online help.

Web site

Check out our web site for software updates, frequently asked questions, free reports, and other information regarding ADR Manager. The address of the web site is:

http://www.slanecon.com/support.php

User group

A public group exists for ADR Manager users to share tips and information about the product. It can be found at the following URL:

http://tech.groups.yahoo.com/group/adrmanager/

Technical support

If you are having trouble with the program, please refer to the manual first. In most cases, the manual will answer your question. If not, check the Read Me file that was installed with the program. If the web site doesn’t help either, technical support is
available by phone or e-mail. Replies generally take 2-3 business days. Please have the following information ready when calling or writing:

The iLok account of the copy protection key you are using
Your name, company name, and phone number and e-mail address where you can be reached
Information about the computer you are running ADR Manager on:

What model of computer you are using
How much RAM it has
How much hard disk space is remaining
What system software is running
What is the resolution of the monitor (i.e. 1024 x 768)
What kind of printer you are using

Ways to reach us:

You can e-mail Slanecon Digital at support@slanecon.com (preferred method).
Or you can call Slanecon Digital during normal business hours (Monday through Friday, 9 a.m. to 5 p.m. Pacific Time) at (415) 479-6967. You may leave a message at this number if no one is available to take your call. We will return your call
within 2 business days.
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Quick start
For people who don’t like reading manuals, here is a brief rundown of what to do to get started with ADR Manager.

1. Create a new database by double-clicking on the ADR Manager application. A dialog appears asking you whether you want to create a new data file or open an existing one. Click on the Create button, change the default name “ADR
Manager” to the name of your project. Save it in a place where you can find it again easily, such as the desktop.

2. Enter the name of the project and setup the time formats you’ll be using in the Welcome dialog (see Creating the project).
3. Enter the reels in your project. If the New Reel window is not open already, make the Reel List Window active (choose Windows > Reels) and select Add empty reel under the Manage menu (see Creating reels).
4. You may want to enter the list of characters in your project, but you don’t have to now. Make the Character List Window active (choose Windows > Characters) and select Add character under the Manage menu. You can also add

characters on the fly as you enter cues.
5. You may want to enter the continuity list before you begin spotting cues, although this is optional. Open the Scene List Window by selecting Scenes under the Windows menu. You can enter the scenes one at a time by opening the New

Scene window (see Creating scenes), or you can import a text file with a list of the scenes (see Importing and exporting). You can do this before entering cues so that ADR Manager automatically looks up what scene the cue is in while you
enter the cue’s information. This is a great way to make sure you’ve entered the correct reel and start time for a cue.

6. Once you’ve entered the project info and reels, open the ADR Cue List Window. Add cues by opening the New Cue window (see Creating cues). To grab times from Pro Tools, go to the Edit > Preferences… > External Sources tab and
setup MIDI communication with Pro Tools (see External sources preferences). Add characters by entering them into the Character field. If they have not been defined yet, the New Character window will appear and you can enter info about the
character there (see Creating characters).

7. Customize the default reports that live inside the database to fit your particular printer. To do this, open the Report List Window (select Reports under the Windows menu) and double-click on a report. Click on the Page Setup button and
choose your printer options, then click on OK. If the report needs to be resized, a dialog will appear. Click on Adjust. To save yourself the hassle of doing this each time you make a new database, save the adjusted reports to disk so that they
can be imported into new databases you create in the future (see Exporting a report to a record file).

8. To search for cues, open the Search Window. Check the character and reels you wish to search in, as well as other criteria, then click on Search (see Searching).
9. To modify a cue, double-click on it. To modify several cues at once, select them and choose Modify selected cues under the Manage menu. To rename cues, select them and choose Rename selected cues under the Manage menu.

10. When it comes to print a report, you simply need to bring to the front the window that shows the database records you want printed, then choose Print under the File menu. For example, to print cue sheets, make the ADR Cue List Window
active, choose Print under the File menu, select the report you wish to print and click Print. To print a line count table, make the Character List Window active and repeat the process. To print an LFOA list, make the Reel List Window active.
To print a continuity list, make the Scene List Window active.

11. To conform picture changes, create a new dupe of a reel by highlighting it in the Reel List window and choosing Manage > Create new reel dupe. Give the new dupe the new version and dupe date. You cannot change the LFOA here - you
must close the window and perform the changes, which will automatically update the dupe's LFOA. Choose Manage > Conform selected dupe to open the Change Event List window. You can add changes manually or import them from an
Avid change note. In any case, once you've entered them in, you can perform them one at a time, or skip them, or perform them as a batch. For each change, ADR Manager will ask you to choose what to do about cues that overlap the
changed segment of time.
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The basics
ADR Manager is a pretty intuitive program. Most experienced Mac users are up and running in a few minutes. However, there are some basic rules that you’ll need to know to use the program effectively.

Most of these rules are based on general Macintosh principles, so if you are an experienced user who has used other Mac programs in the past, then you’ll probably be familiar with most of the concepts explained in this section. However, there are a
few ways of doing things that are particular to ADR Manager, so you may want to skim this section nonetheless.

If you are new to your computer, it is essential that you practice using it before using ADR Manager in a deadline-driven environment. In particular, familiarize yourself with how to start up and shutdown applications, how to switch between
applications, how to move and copy files on your drive, and how to open and save files from within applications. There are many great resources to help you learn these things, including thousands of “how-to” books, user groups, internet web sites
and news groups, night classes, friends who are proficient users, etc.
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Where the information lives

All of the information for a particular project - characters, reels, cues, takes, scenes, reports, etc. - lives in a set of datafiles. To move the database from one computer to another, move all of the datafiles together. They all share the same name (the
name you entered when you created the datafile), following by a suffix such as "4DD", "4DR", "4DIndx", and "Match". Note that the“4DD” file may have its suffix hidden when viewed in the Finder, in which case it would appear as simply the datafile
name.

When selecting a database to open, choose the .4DD file.

Note that reports are imported and stored within the database. To use a report (such as those found in the Default Reports folder), you must import it into the Report List window.
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Launching the application

To launch the application, double-click on the application icon. You can launch the application by double-clicking on a datafile, but this may not open the datafile within the application. ADR Manager always tries to open the last used datafile, regardless
of how the application was launched (see Opening a database for more information). One way to force ADR Manager to present an Open File window during startup is to hold down the option key. This gives you the opportunity to manually select the
datafile you wish to open. If ADR Manager has already opened a datafile, the Welcome window gives you another opportunity to choose a different file.

If your iLok copy protection key is missing or not installed properly, you will get the following dialog:

If you get this dialog and you have a valid iLok key, check to make sure the key is seated properly in the USB Bus port, the port is adequately powered, and the InterLok (iLok) extensions are installed. Instructions on how to download and install the
InterLok extensions will appear if you do not have them installed properly. ADR Manager will not run until the iLok is installed properly.

Software updates

By default, ADR Manager will check to see if there is a newer version of the program available on the Slanecon Digital website each time it launches. You can turn off this setting in the Preferences window. If there is a new version available, a window
will appear describing what improvements have been made in the new version, as well as a button to direct your web browser to the downloads page.
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Creating a new database

Double-click on the ADR Manager application icon to launch the application. If ADR Manager could not find the last used datafile, a dialog similar to the one below will appear. If you have never used ADR Manager on this computer before, then there is
no "last used datafile" and the Create Database dialog will appear. If a Welcome splash screen appears, see Opening a database. If a message appears complaining about the log file not matching or missing, see Using a log file.

In this dialog you can either open an existing database or create a new one. To create a new one, click on the “Create" button. Another dialog appears, asking you to name and save the new database:

By default, the new datafile is given the name “ADR Manager” and is located within the ADR Manager application itself. However, ADR Manager will not let you open a datafile in this location - you must choose another location outside of the application.
Rename the datafile to something more appropriate, such as the name of your project, and save it to a more appropriate place, such as your desktop. Several files will be created with that name, each with a different suffix. If you want to move your data
somewhere else, you must move all of the files together.

You can also create a new datafile after you start up ADR Manager by clicking on the New database button in the Welcome screen, or by choosing the New database… menu item under the File menu (once a data file is open).
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The Welcome dialog displays the iLok key that the program is currently using, and the newly created datafile name and location.
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Opening a database

Double-click on the ADR Manager application icon to launch the application. A dialog similar to the one below will appear:

If the ADR Manager Welcome dialog appears (the picture with the woman's face - see below) instead of the above dialog, then the application has automatically opened the datafile you last used. To prevent the application from automatically opening
the last datafile used, hold down the option key while the application is launching. The following dialog will appear:

In this dialog you can either open an existing database, or create a new one. Choose "Select another data file" and select the file you wish to open. Once you’ve opened the desired data file, a welcome dialog will appear:
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The Welcome dialog displays the iLok key that the program is currently using, and the currently selected datafile name and location. Buttons at the bottom of the window give you an opportunity to open or create another datafile other than the one
currently selected.

Click Open to proceed with the currently selected one.

If the data file was saved with ADR Manager 4, it must first be converted to v5 format.

Note: Once you convert a datafile to v5 you will no longer be able to open it in ADR Manager 4.

A special dialog will appear:
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Click on Convert database. A backup is put in a folder called "Replaced Files (Conversion)" in the same folder as the datafile, then the datafile is converted. After conversion, a confirmation dialog appears to ask you whether you want to update the
data file:

If you don't want to update the datafile, click No and the program will quit. Otherwise, click Yes and the data file will be updated to the latest version:

You can see the changes that were made by viewing the log file(s) that are created for each version that the data file was updated to.

ADR Manager 5 User Manual  27



ADR Manager 5 User Manual  28



Saving your database

You can save your database at any time by choosing Save under the File menu. This will flush any changes you have made out to disk.

ADR Manager automatically saves the data file when you open it, close it, and every 15 minutes while it is open.
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Editing records

Adding, deleting, and modifying records is done by opening the record’s List window and making it active. Once a record’s list window is active, the Manage menu will change to reflect the things you can do to that table. For instance, when the ADR Cue
List window is active, the Manage menu looks like this:

The Manage menu will change each time you make a different window active. All other menu items remain constant. Common menu items can also be triggered by clicking the toolbar buttons at the top of a List window. Sometimes menus may
disappear when you open an editing window, such as the New Cue window. The menus will return to normal if you close the editing window or make a list window active. In some cases, you must close certain editing windows before you can perform an
action (i.e. conforming). This is to prevent data corruption.

The windows and menus for each table are described in detail in the appropriate chapters in this document.
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Entering field values

Each record in the database consists of various fields, which are boxes that appear in various windows. Throughout ADR Manager you will need to enter text, time values, and other information into these fields. There are several ways you can
quickly enter data:

Hitting the return key will enter the value you just typed into the field, and then select the entire field.
Hitting the tab key will enter the value you just typed into the field, and then select the next field in the window.
Hitting command-tab will enter the value you just typed, and then select the previous field in the window.
Hitting the enter key will enter the value you just typed into the field, and then click the OK button in the dialog for you.
Typing command-period is the same as clicking the Cancel button in most dialogs.
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Entering times

There are many places in ADR Manager where you must enter a time. You may be creating a cue, or entering the LFOA for a reel, or inserting time into a reel. Before you enter a time, you should be aware of what time format you are currently using.
Open the Project Info window by choosing Project under the Windows menu to see which time format is currently being used, if you are unsure.

Time fields will accept values in several ways. You can:

Type the number in longhand
Type the number in shorthand
Paste a value from the clipboard
Put the current time in the field using a menu command, keyboard shortcut, or applescript. The current time is the time displayed in the Transport Control window.
Run an applescript that copies both the start and end times in the Pro Tools Edit window and pastes them into the start and end times for a cue in ADR Manager.

Entering times using longhand

To type in a time value longhand means you must type in all punctuation for the value. For SMPTE times, that means typing in colons (or periods) between hours, minutes, seconds, and frames.

For feet and frames, that means typing in a plus sign (or period) between the feet and the frames.

Entering times using shorthand

To enter a time using the shorthand method, type only the digits, hit return or tab, and let ADR Manager put in the appropriate punctuation. For example, if you are entering a SMPTE time of 03:13:22:00, simply enter 3132200 and hit return or tab:

 hit return or tab: 

If want to enter feet and frames of 212+10, enter 21210 and hit return or tab:

 hit return or tab: 

Note you must always enter digits for the frames in timecode or feet and frames. In other words, if you wanted to enter 1 foot and 0 frames, you must enter 100, not just 1.

The shorthand method allows you to enter data faster, especially if you have a numeric keypad. You can only use the shorthand method when in a time field, not in a text field.

If you type an invalid value in a time field, ADR Manager will display an error and revert the field to its previous value. If you’d rather have the application attempt to correct the value by recalculating subfields, check the Normalize time values preference
under the Data Entry tab in the Preferences window. For example, if you are spotting in non drop timecode and you enter 01:00:00:45, ADR Manager would typically display an error. If this preference were turned on, however, the value would be
replaced with 01:00:01:15 and no error would be posted.

Entering times by pasting from the clipboard

You can cut, copy, and paste to the Mac OS X clipboard when entering data in any window.

Entering times by grabbing the current time

The current time is a time value that is available throughout ADR Manager for stuffing into time and text fields. It is always in the currently displayed time format. The current time is updated using MIDI messages received from an external MIDI source
such as Pro Tools. You must setup MIDI communication between ADR Manager and Pro Tools in order to enable the use of current time. See Grabbing times from Pro Tools for more information.

Entering times by running an applescript
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You can enter times into certain fields using applescripts found in the ADR Manager > Scripts folder. See Applescripts for more information.
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Entering dates

You can enter dates as abbreviated or full dates. If you enter only the month and day, it should be in the format month/day or month.day, and the year will be assumed to be the current year. If you enter a full date, it should be in the format
month/day/year or month.day.year, where the year can be 2 or 4 digits. If you enter 2 digits for the year, ADR Manager will interpret any number from 60 through 99 to mean the years 1960 through 1999. Any number from 0 through 59 will be
interpreted as the years 2000 through 2059.

Dates are displayed throughout ADR Manager according to your system preferences. You can access your system preferences in Mac OS X 10.6 by going to System preferences > Language & Text > Formats.
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Backing up a database

You can backup your database at any time by choosing Backup… under the File menu, or you can have ADR Manager automatically backup your data file at specified times. Backup settings, such automatic scheduling, are done using the
Preferences > Backup tab dialog (see Updating and backup preferences). ADR Manager creates a backup archive file that is stored separately from the data file. Refer to the complete description of 4th Dimension’s backup capabilities (4th
Dimension is the database engine upon which ADR Manager is built).
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Using a log file

You may want to use a log file as a preventitive measure, in case the database gets corrupted later and you need to restore it (see Updating and backup preferences). The log file’s pathname is stored in the database, so if you move the database to
another computer, the pathname may become invalid. In this case, when you open the database on the new computer, ADR Manager will complain that the log file could not be found:

In this case, you must either find the log file or create a new one. Click OK to proceed. A Standard File Open dialog appears, with a New... button:

Search for the log file and click Open, or click on the New... button in the bottom left corner to create a new log file. If you select a log file that was not the one last used with the database, an error message will appear and the program will quit:
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To create a new log file, click on the New... button and a Standard File Save dialog will appear. Generally you should store the log file on a volume other than the one that the database lives on, in case the volume dies or becomes corrupted. Note that if
you create a new log file, any old log files will become invalid.

If you cancel the dialog, the application will quit.
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Restoring a database

You can restore a data file to a previously backed up state by selecting Restore under the File menu.

Note that ADR Manager always performs a self-check of a data file when the file is first opened. If any problems are found, details of the corruption are presented and you are given the opportunity to restore the data file from a previously backed up
state. If you prefer, you can also have ADR Manager automatically restore corrupt data files without user intervention (see Updating and backup preferences for more information).

Refer to a more detailed description of ADR Manager's restore capabilities.
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Fixing database problems
If you start noticing strange behavior or incorrect data, you may need to check the database for corruption or inconsistencies. These issues can be caused by operator error, bugs in the software, or hardware malfunctions.

To correct issues with a datafile, select Windows > Diagnostics to open the Diagnostics window. This window allows you to run a series of tests to determine whether there is a problem with the data. You can perform high level tests on individual
tables, or low level tests on the datafile in general.
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Running diagnostics
You can run diagnostics on the records in the database to detect and fix high level logic corruption that may have been caused by bugs in the software or user error. You can also verify that there are no low level problems in the datafile.

To run diagnostics, choose Diagnostics under the Windows menu. The Diagnostics window opens with the high level diagnostics tab:

Check the tables you want to analyze, then click Run diagnostics. ADR manager runs a specific set of diagnostics for each table. These tests are done on a high level. To run low-level tests on the records and fields, choose the Datafile tab and click
on Verify datafile:

Repairs are made in memory, however any changes are not actually saved until you click Done or close the window. This gives you the opportunity to see what is wrong with the database first before fixing it.

Once the diagnostics tests are finished, the window automatically switches over to the Log tab to show the results:
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Once the diagnostics tests are finished, the window automatically switches over to the Log tab to show the results:

Most data errors can be corrected, but some cannot. In the case of a low level verify (under the Datafile tab), no changes are made to the database. If there are errors detected, you must reopen the database and run the Maintenance and Security
Center tool. In the case of a high level verify (under the Tables tab), most data errors are corrected automatically but data inconsistencies that require manual correction are noted with "NO ACTION TAKEN." Be sure to check these records after running
the diagnostics test and correct any anomolies. For instance, if the log says a cue name is used in more than one cue lineage, you should change the current reel set to the "All reel dupes" set and search for that cue name in all reel dupes, then take
appropriate action for the different cues that have the same name.

You can copy and paste the text in this text box to the clipboard for use in another program. The log is also stored in the Logs List if you want to view it later.

To close the window, click Done. If changes were made to the database, you will be asked whether you want to save the changes or discard them. If you want to discard the changes, click No.
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Running maintenance
To correct low level datafile corruption you can launch ADR Manager in "Maintenance and Security" mode. This mode is provided by 4D Inc., the database engine upon which ADR Manager is built. The utility checks the low level datafile structure,
looking for problems in the tables and indexes. Some issues it may correct include:

Restoring records that have "disappeared"
Resolving issues that are flagged by errors when starting up ADR Manager
Restoring loss of data when moving a database between workstations

You should use the maintenance tools after you have tried running high level diagnostics from within ADR Manager.

To use the maintenance mode, follow these steps:

1. If ADR Manager is running, make a note of the location and name of the database you are having trouble with by choosing About ADR Manager under the Apple menu.
2. Quit ADR Manager.
3. Launch ADR Manager again, but this time hold the option key down while it is launching. Keep it held down until the following dialog appears:

4. Choose "Open the Maintenance and Security Center" and click Continue.
5. Choose the Repair tab on the left side of the window.
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6. If you want to repair a different data file, change it by clicking on the "..." button beside the pathname of the data file to be repaired.
7. Choose the "Standard repair" option.
8. Click on the Repair button in the "Repair data file" section. The program will attempt to repair the database. When it is done you can view what changes were made, if any, by clicking on the "Open log file" button.
9. Close ADR Manager.

10. Reopen the database with ADR Manager (without holding the option key down).
11. Check to see if the problem has been fixed.

You can run the maintenance tools more than once on a data file. Sometimes repairing a data file will bring other problems to the surface and require another pass with the maintenance tools.

If there still seems to be corruption with the datafile after repairing it, you can try a more drastic approach:

1. Follow steps 1-6 above.
2. Choose the "Recover by record headers" option. This does a low-level reconstruction of the database file.
3. Close ADR Manager.
4. Reopen the database with ADR Manager (without holding the option key down).
5. Check to see if the problem has been fixed.

ADR Manager 5 User Manual  43



Displaying logs
Logs are created when ADR Manager updates a data file to a new version of the program, runs diagnostics, or imports records. You can view the results of these actions by opening a log in the Logs List window. The Logs List window is opened by
selecting Logs from the Windows menu.

Double click on a log to view it:

The log shows when it was created and what it was named. You can copy the text in this window to the clipboard, then paste it in another program. Any changes you make to the text in this window are not saved.
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Migrating data from old versions

You can migrate data from database files created with versions 2 and 3 of ADR Manager into version 5 by using AM2 Exporter and AM3 Exporter. (You can open v4 datafiles directly with ADR Manager v5). These utilities let you open older
datafiles and export the data to XML files. The exporter utilities are available in the Utilities folder, which exists in the Applications > ADR Manager folder after a full installation.

To migrate your data, follow these steps:

1. Make a backup copy of the database file you want to migrate, since you won't be able to open the file with older versions of ADR Manager once the migration is complete. You will be able to open the migrated file with the exporter utility
again.

2. Choose which utility you need: AM2 Exporter opens v2.3f6 databases, and AM3 Exporter opens v3.1f2 databases (AM4 databases can be opened directly by AM5 without needing to export).
3. Double-click on the utility, then immediately hold down the option key. Once the Open File dialog appears, release the option key.
4. Choose the database file you want to migrate. If the file you want to convert cannot be selected or appears greyed out, change its name so that it ends with ".4DD" and try again.
5. If you get the following message, you are not using the correct exporter utility for the database file you selected:

In some cases, you may need to "link" the database file to the exporter utility. If this is the case, a dialog will appear:

Click OK. Another dialog will appear, letting you enter a "signature" for the database file:
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For v2.3f6 files, enter "ADR Mgr 2.0d8" (this is case-sensitive). For v3.1f2 files, enter "ADR Mgr 3". Click OK.

6. If the database file can be "linked" to the exporter utility, the following message will appear:

Note that you will not be able to open the database with older versions of ADR Manager once you convert it.
7. Click Convert.
8. The welcome window appears:

Click OK.
9. The main dialog appears. All of the tables to be exported are listed, with the number of records in each table:
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Click on the Export... button.
10. The Save File dialog opens. Choose a name and location for the XML file and click on Save. The data is exported to the XML file.
11. Quit the exporter utility.
12. Launch ADR Manager using the techniques described in Opening a database or Creating a new database. If you created a new database, see Creating a project for details about importing the data into a brand new database. If you want to

import the data into an existing database, see Projects in the Importing and Exporting chapter for a discussion about importing multi-table XML files into a database.

ADR Manager 5 User Manual  47



The Project
Each database you create with ADR Manager will hold all of the ADR information for one project. The database is stored on your hard disk as a single file with the suffix ".4DD". This has the advantage of storing all of your information in one place,
and allows for faster searching and report generating.
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Creating the project

Once you've created a new database file, you can either setup a blank project to start entering data, or fill the database with data from an XML file. To fill the database with XML data, click on the Import from XML... button and import the XML file. If you
are creating a blank database, enter the name of the production and choose what time format you will initially be spotting in:

You must enter a project name. You can always change the name of the production later. As a default, the project name has been set to the name of the database you just created, without the file type suffix. It is usually a good idea to have the name of
the document and the name of the project match, so that you can tell in the Finder which project resides in which document.

Define the feet and frames format and timecode format you will be using. If you are using Pro Tools in conjunction with ADR Manager, you should set your formats to match your Pro Tools session setup. You should then define the beginning of each
reel in ADR Manager to match the beginning of your Pro Tools session, assuming each Pro Tools session corresponds to a reel (see Creating reels).

You can specify what counting mode and frame rate you want for both the feet and frames time and timecode formats by changing the appropriate popups.

The following timecode formats are available:

Non-drop timecode running at 30 fps or 29.97 fps
Drop frame timecode running at 29.97 fps or 30 fps
25 frame timecode running at 25 fps or 24.975fps
24 frame timecode running at 24 fps or 23.976 fps

The following foot and frame formats are available:

35mm feet and frames running at 25 fps, 24 fps or 23.976 fps

Select the preferred time format you will be working in by choosing “Feet and frames” or “Timecode” in the Preferred time format popup. You can change the individual time formats or the preferred time format at any time (see Changing time formats).

You can store notes with the database by clicking on the Notes tab and entering any amount of text.

Click on OK to initialize the database. Once ADR Manager has initialized the database, it will automatically import various default reports as well as default keyboard shortcuts. Reports must live in the database in order to be used. You can import
additional reports at any time, including actor cue sheets, editor cue sheets, mixer cue sheets, master cue sheets, line count tables, reel lists, character lists, and continuity lists. See Importing a report from a record file for more information on how to do
this.

After the default reports and keyboard shortcuts are imported, the Reel List window will open. The New Reel window will also be opened for you to start entering the reel information. Please see Creating reels for an explanation on how to use the New
Reel window.
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Viewing and changing project information

Information about the project is displayed in the Project Info window by choosing Project under the Windows menu.

This window gives you general information about the project. You can view what the current preferred time format is, what the timecode and feet and frames formats are set to, and what notes you’ve entered about the project.

To modify project settings, change them in the window and click on Apply changes.

The settings under the Timelines tab display current time formats (see Changing time formats for more information).

The text box under the Notes tab displays any text you may want to store with the project.
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Changing time formats

In the Project Info window under the Timelines tab, the time format you are currently using is shown at the top of the tab area. This is the format used to input and display time fields for all cues, scenes, and reels in the database. To change to another
format, select another format in the popup menu.

Changing the preferred time format or changing the mode or frame rate of the currently preferred time format will cause all time-related records (cues, reels, and scenes) to be updated based on the new settings. If you are changing the frames per
second rate of the preferred time format, you can retain the existing times for all time-related records or have them all recalculated based on the new rate.

Click on Keep to retain the displayed times, or click on Recalculate to recompute the displayed times. If you choose to recalculate the displayed times, each time field will be converted to seconds relative to the beginning of the record's respective
timeline, then converted into the new time format. For instance, a cue's start time will be converted to seconds relative to it's reel's FFOS time, then back to the new time format.

Note that the incoming MIDI timecode format is separate from the database timecode format. See External sources preferences for more information.
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List windows

An ADR Manager database consists of many different tables. Each table has its own List window in which you can view its records. For instance, character records are displayed in the Character List window and cue records are displayed in the ADR
Cue List window. The List windows can be opened using the Windows menu.

 

To make an open window active, simply click anywhere in the window. This brings it to the front of all other ADR Manager windows.

At the top of each List window is a set of buttons which you can use as shortcuts to using the Manage menu:

You can customize the look of a window by clicking on the Customize list button, and get help for a List window by clicking on the Help button.
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Customizing a List window

A List window consists of rows and columns for a particular table. You can customize how the rows and columns look by clicking on the Customize List button at the top of the window.

The Customize List dialog opens:

The Customize List Window dialog is divided into 3 tabs.

Under the List tab, you can set general settings for the list and rows:

You can show horizontal or vertical gridlines by checking the Gridlines boxes.
To display a different background color on every other row check the Rows have alternating colors checkbox. This can make the list easier to read. If you click on Alternate color... button you can set the background color. By default the
color is light grey.
Rows can be a fixed height, specified in pixels, or the height can vary from row to row based on the amount of text in the cells. In the Columns tab, you can choose which cells will control row height (see below).

A sample of what the list might look like is shown under the settings.
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A sample of what the list might look like is shown under the settings.

Under the Columns tab, you can select which columns are displayed and what they look like:

All of the possible columns you can display are listed on the left side of the window. To make a column visible, check its box. To setup how the column looks, click on the name to highlight it. Depending on the type of column (text vs. picture), the
possible options are displayed on the right side of the window:

For text fields, you can set the font name, size, style, and color.
For text and picture fields, you can set the background color, horizontal and vertical justification.
The format setting differs depending on whether the field is a picture, a text field, a number, or a date.
For text fields, you can choose to have the text wrap within the cell rather than continue to the right
For all types, you can choose to have the cell resize the row height so that the entire field is displayed (see List tab above). If the list rows are set at a fixed height, this option is disabled.

A sample of what the column looks like is displayed at the bottom of the pane.

Under the Sorting tab, you can set how you want the rows ordered in the list:
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Rows are sorted in order of the columns listed. In the example above, the cues would be sorted first by reel name, then by start and end time, then by character name, etc. To change the order, drag a column name to a new position. You can specify
whether you want a column sorted in ascending or descending order by changing the Sort to Up or Down.
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Cues
Cues are the entities that contain information about each ADR line you wish to record. ADR Manager stores a significant amount of information about each cue, specifically:

Which reel and scene the cue is in
What character the cue belongs to
The unique name of the cue
What time the cue starts and ends
What dialogue the cue contains
General notes about the cue
Priority and status information about the cue
Whether the cue is locked or unlocked

You assign cues to reels and characters when you create them. Reels must be created beforehand. A cue must have a start time that is within the limits of the reel you’ve assigned it to (between the FFOA and LFOA, inclusively). Cues are
automatically assigned to scenes based on the cue’s reel and start time. A cue’s dialogue can contain virtually any amount of text, while notes are limited to 80 characters. Cues also store status information about themselves. You can lock and
unlock cues to prevent them from accidentally being modified.
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Cue statuses

Certain information stored in a cue warrants special attention: the cue status information. A cue always has a particular status. You typically change the status of a cue after you’ve done some action to it, such as spotting, recording, or cutting.
Keeping a cue’s status up-to-date lets you search and print reports based on those statuses. The 8 status “levels”, in order, are:

Spotted
Printed
Recorded
Transferred
Loaded
Cut
Premixed
Final mixed

Statuses represent increasing levels of completeness, so “Recorded” is considered a greater status than “Printed”. This hierarchy is important to remember when you search for cues based on status, or print reports such as “To Be Recorded” line
count tables.

You can also mark a cue as omitted without deleting it from the database. This may be the case if the cue was spotted, then omitted for various reasons, only to be recalled again later. Sometimes it is helpful to keep omitted cues in the database as
a log of what has already been spotted, whether or not it was recorded. Omitted cues are affected along with “normal” cues during conforming. Some reports automatically leave omitted cues out when printing, or you can manually remove omitted
cues from reports before they are printed.
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Cue lineage

When you create a new dupe of a reel, the cues are copied (not moved) into the new dupe, and lineage ties are created between the original cues and the copies. The lineage tie ensures that changes you make to a cue in an old dupe get reflected
in its descendants in later dupes (a cue in an older dupe is considered the ancestor of a cue in a newer dupe). For example, let’s say you have three versions of reel 6 - v1, v2, and v3 - and you are recording an actor to version 2 of reel 6. When the
session is done, you’ll want to change the status of the actor’s cues in reel 6 v2 to “recorded”. Then, you would have to open up v3 of reel 6, find the corresponding related cue, and change it to “recorded” as well. You also may want to update the
status of the ancestor cue in version 1 of reel 6. Since ADR Manager knows what cues are related to other cues, it will save you time (and potential errors) by automatically updating ancestor and descendant cues.

Changes are always propagated to descendant cues. Changes are propagated to ancestor cues only if you choose to do so by setting a preference (see Cue status preferences). Changes that get propagated are:

Cue name (always propagated to all ancestor and descendant cues)
Dialogue, unless it has an embedded time
Public notes, unless it has an embedded time
Private notes, unless it has an embedded time
Status
Priority
Omitted
Locked/unlocked

Note that when cues are conformed, they may be split up into several pieces, such as when you insert time in the middle of a cue. When a cue is split, the pieces may or may not remain in the "family tree" depending on whether the cue is recorded
or not. If the cue has not been recorded yet, the first piece remains in the family tree and the other pieces start new trees; that is, they are no longer linked to the original ancestor and their cue names are erased. If the cue has been recorded, all
pieces remain in the family tree. In this case, be aware that if you modify a descendant piece and propagate the changes to the ancestor, the descendant's siblings will not get the change.

Also note that imported cues are not inserted into any family trees even though they may have the same cue names as other cues in the database.
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Embedded times in text fields

Sometimes you may want to denote when a specific event occurs within the dialogue or notes fields of a cue. You can do this by embedding a time within the field. Embedded times are recognized by ADR Manager and converted when you change
time format. They are also conformed when the cue is conformed.

For example, you could use an embedded time if a character is offscreen and then appears onscreen halfway through his cue. You could denote the time at which he appears onscreen like this:

(Offscreen) Look, Joe. I don’t care 
(onscreen @ 02:04:12:22) if you like 
him or not…

There are several ways to enter embedded times:

You can enter a time manually by using the longhand method as described in Entering times. You cannot use the shorthand method. If the time value is typed in shorthand, ADR Manager will not recognize it as a time value.
You can select Insert current time from the Manage menu to grab the current incoming MIDI time (shown in the Transport Control window) and insert it at the cursor location. If text is already selected in the field, it will be replaced by the
inserted time. If the cursor is not in a time or text field, the command is ignored.
You can tell ADR Manager to insert the current time from an applescript. See Apple scripts for information.

Be careful not to type text that may be interpreted by ADR Manager as a time field. For example, if you entered a keycode such as 123456+12 into the Notes field and then tried to change the database's displayed time format to timecode, ADR
Manager will attempt to convert the keycode string to timecode. At best this would flag an error, at worst the keycode would be silently replaced with a timecode value. If you want to store time strings in text fields but don't want them recognized by
ADR Manager, add a space before or after the colon or plus signs so that they do not have proper time field syntax.
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Spell checking cue fields

You can run a spelling checker on text fields in the New Cue and Modify Cue windows. Choose Spell check under the Manage menu when the window is front most and the cursor is in one of the following fields:

Dialogue
Public notes
Private notes

If a potential spelling error is encountered, a window appears:

You can choose to:

Ignore this occurrence and continue checking the rest of the field
Ignore this occurrence and stop checking the field
Add the word to the dictionary
Change the word to a word found in the dictionary (if any)
Change all occurrences of this word in the field
Do none of the above and quit spell checking

The spelling dictionary is saved with the application, so any additions you make to the dictionary will be used when spell checking other records in this database, as well as when you spell check fields in other databases you open or create from now on.
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Displaying cues

Cues are displayed in the ADR Cue List window. See List windows for a description of the buttons at the top of the window. Adding, duplicating, deleting, and modifying cues can be done only when the ADR Cue List Window is active:

To open the ADR Cue List Window, select ADR cues from the Windows menu, or type command-G. If the ADR Cue List Window is already open, a checkmark will appear beside ADR cues. If the ADR Cue List Window is behind another window or is
inactive, select ADR cues to make the ADR Cue List Window active. You can close the ADR Cue List Window by clicking on its close box, or typing command-W or command-period.

At the bottom of the ADR Cue List Window is some information describing how many cues are currently displayed in the window, how many are selected, and how many total cues are in the current reel set.

The ADR Cue List window displays the following columns as a default. You can customize the window by clicking on the Customize List button in the upper right corner.

Locked – Shows whether the cue is locked. If a cue is locked, it cannot be modified except during a conform.
Reel number – Which reel the cue is in. If the “All reel dupes” set is active, the reel column also displays the reel version or dupe date.
Scene name – Which scene the cue falls under.
Cue name – The cue’s name, if one has been assigned.
Start and end time – The start and end time of the cue, in the currently displayed time format.
Character name – The character to which this cue belongs.
Dialogue – The first three lines of dialogue for the cue.
All Notes – The public notes on the first line(s), followed by the private notes on successive lines.
Status and priority – The status (i.e. “Spotted”, “Recorded”, etc) of the cue (first line), followed by whether the cue was omitted or not (second line), followed by the priority of the cue (third line).

When the ADR Cue List Window is active, the Manage menu will change slightly:
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Use these menu items to add, delete, duplicate, or modify cues. You can rename cues using this menu and lock or unlock cues. You can also create and find takes for the currently selected cues.

Use the Customize List button to change the way cues are sorted in the window.
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Sorting cues that start at the same time

To control how cues are sorted, use the Customize List dialog. If you choose to sort cues by start time, and some cues start at the same time, you can further sort them using a special function.

To rearrange cues at the same start time, option-drag a cue up or down in the ADR Cue List window. A rectangle will appear around each row as you drag over it, showing you where the cue will be dropped when you release the mouse. Drop the
cue on another cue that has the same start time. The dragged cue will be positioned where you dropped it, shuffling the other cues up or down.

If you drop the cue on a cue that does not share the same start time, ADR Manager will find the nearest displayed cue that does have the same start time and assume that is where you wanted to drop it. You cannot change the start time of a cue by
option-dragging it, only the order in which it appears with other cues of the same start time.

The ability to sort cues within a start time is particularly useful for cues in the WILD reel, which all share the same start time of 0. The new order will appear in the ADR Cue List window and on reports.
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Creating cues

You can manually create cues, or import them from various types of files such as Pro Tools session text files or tab delimited text files. To find out more about importing, such as spotting in Pro Tools then importing the session into ADR Manager, see
Importing and exporting. This section describes how to spot cues manually.

To create a cue, you must have the ADR Cue List Window open and active. Select Add cue from the Manage menu, or type command-N. The following dialog will appear:

Enter the cue’s reel, character, cue name , start and end times, dialogue, status, priority, public notes, and/or private notes. For more information about how to enter values into the various fields, see Entering information for a cue.

To enter a value into each field, simply type into it then press the tab key to move to the next field in the dialog. To move back to the previous field, type shift-tab. Tabbing can be a great time saver since you can maneuver around the window without
using the mouse. You can choose between two different tabbing orders in the New Cue window (see Data entry preferences).

The New Cue window can be resized vertically. The dialogue and private notes boxes will grow accordingly.
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Entering information for a cue

The New Cue and Modify Cue windows share many of the same fields. This section describes those fields.

The following fields can be entered for an ADR cue:

Reel number - The first time you open the New Cue Window for a project, the reel number field will be selected. You can either enter a valid reel number here, or select “WILD” from the Reel popup menu. If you select “Reel” then you must
enter the number of a reel that is in the current reel set. Type in the reel number, then hit tab or click on another field. The version or dupe date of that reel appears so you know you are adding this cue to the correct reel dupe. If you select
“WILD,” the reel number and version or dupe date fields disappear. Other fields disappear as well; namely the cue start and end time fields, and the scene name and description fields.
Cue name - The cue name field can be left blank for now or you can enter a value. If you leave it blank, you can have ADR Manager automatically generate a cue name for this cue. If the cue is in the WILD reel, the cue name will be
generated once you’ve entered the character. If the cue is in a numbered reel, the cue name will be generated once you have entered a valid reel number, start time, end time, and character. You can also rename cues later using the Rename
command (see Renaming cues). Cue names must follow the naming convention defined in the Cue Naming tab in the Preferences window. Hit tab or click on another field to deposit the cue name.
Start time - Enter the start time of the cue (see "Entering times" below). Be sure that the time you enter is between the FFOA and LFOA of the cue’s reel. Hit Tab to go to the next field. The next field is determined by several preferences: If the
“autofill end time” preference is off and tabbing order #1 is selected (see Data entry preferences) then the end time field is selected. Otherwise the character field is selected. Once you’ve entered a valid reel and start time, the scene that
contains the cue is displayed in the upper right corner of the window.
End time - Enter the end time of the cue (see "Entering times" below), otherwise leave this field blank if you don’t want to specify an end time. Be sure that the time you are entering is between the FFOA and LFOA of the reel. Hit Tab to go to
the next field. If the “round-off end time” preference is on, the end time will be automatically rounded up to the next nearest whole second or foot.
Character - To enter a character, choose it from the popup beside the field or type its name. As you type, ADR Manager will automatically fill in the rest of the field with a character name that matches what you have typed so far. If you type
the name of a character that does not exist in the database and hit tab or return, you will be prompted to create the character (remember you must give it a unique abbreviation as well). You must enter a valid character name in order to save
the cue.
Dialogue - Type in the dialogue for the cue. This is exactly what will appear in the reports, so if you want quotation marks or parentheses around the dialogue in the reports, you must type them in here. Also, if you type a return while in this
box, the return will be entered as part of the dialogue, not as a means to submit the text you’ve entered. There is virtually no limit to the amount of dialogue you can enter for a cue. You can enter times in the dialogue that will be updated if the
cue ever gets conformed or converted to a new time format (see Embedded times in cue fields). To submit the text you’ve entered, hit tab, click on another field, or hit the enter key to save the cue.
Status - Choose an initial status for the cue by clicking on the popup menu. As a default, the cue is set to the lowest level of status: Spotted. You can use the status and omitted fields to monitor the progress of ADR cues while you work on
your project.
Omitted - Check the omitted box if you would like to add this cue to the database, but mark it as omitted. Using the omitted checkbox allows you to keep cues in the database that you don’t want included in reports or line count tables, but still
want them in the database for reference.
Priority - Assign the priority of a cue by choosing a level in the priority popup. You can then search by priority and print this field in your reports. The default priority for a cue is “Medium.”
Public notes - Type in public notes for the cue. They will appear in all reports. This is exactly what will appear in the reports, so if you want quotation marks or parentheses around the notes in the reports, you must type them here. Also, keep
in mind that if you type a return while entering text, the return will be entered as part of the notes, not as a means to submit the text you’ve entered. You can enter as much text into this field as you want. You can type in embedded times in the
public notes that will be converted and conformed with the cues (see Embedded times in cue fields). To submit the text you’ve entered, hit the tab key to move to another field, or click on another field, or hit the enter key to save the cue.
Private notes - Type in any private notes for the cue. They will appear in all cue sheetsexcept the actor cue sheet. The primary use of this field is to allow you to enter text separate from the notes field (i.e. notes about the actor’s
performance), so that you can choose not to have the actor see it. If you want quotation marks or parentheses around the private notes in the reports, you must type them here. Also, keep in mind that if you type a return while entering text, the
return will be entered as part of the notes, not as a means to submit the text you’ve entered. You can enter as much text into this field as you want. You can type in embedded times in the notes that will be converted and conformed with the
cues (see Embedded times in cue fields). To submit the text you’ve entered, hit the tab key to move to another field, or click on another field, or hit the enter key to save the cue.

Entering times
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Entering times

You can enter times in several ways:

You can enter a time manually, complete with colons or plus signs. Or you can use the shorthand method if you are in the start or end time field.
You can use Set start time to current time or Set end time to current time under the Manage menu to grab the current time.
You can select Insert current time from the Manage menu to grab the current time and insert it at the current cursor location. If the cursor is in a text field such as dialogue, public notes, or private notes, and text is already selected in the
field, it will be replaced by the inserted time. If the cursor is not in a time or text field, the command is ignored.
You can use a keyboard shortcut to insert the current time in the start time, end time, or any text field.
You can tell ADR Manager to insert the current time from an applescript. You can also use an applescript to copy and paste the start and end times from Pro Tools Edit window into the start and end time fields in ADR Manager. See Apple
scripts for more information.
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Grabbing start and end times

You can grab times from an external application such as Pro Tools (see External sources preferences for information on how to set this up). You can grab the current time from Pro Tools and stuff it into the start or end times for the cue by using a
keystroke command. Note that start and end times are converted from the MIDI timecode format to the currently displayed time format using the reel context set in the Transport Control window.
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Saving the cue

Once you have entered all the information, you can save the new cue in two ways: by clicking on the OK button, or by clicking on the OK & Next button. If you click on the OK button, the cue is saved and the New Cue Window closes. If you click on
the OK & Next button, or hit the enter key, the cue is saved and the New Cue Window remains open, ready for another cue. Previous values in the start and end times, character, dialogue, cue name, and notes boxes are cleared out, unless their
respective sticky checkboxes are turned on. The ADR Cue List Window will scroll so that the newly saved cue appears in the middle of the window.

If you decide you don't want to save the cue, click on Cancel or type command-period. This will close the New Cue Window without saving the cue.
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“Sticky” padlocks

The padlocks next to the Start Time, End Time, Character, Dialogue, Priority, Public Notes, and Private Notes fields are used to make the values in those fields “stick” from cue to cue. This is useful if you are adding several cues in succession and
they all share a common value in a field, but you don’t want to have to retype that value each time. If you would like certain values to “stick” in their respective boxes when using OK & Next, check the checkbox located to the right or above the field.

This can be useful if you want to enter several cues that have the same start and end times, or several cues that are for the same character:

1. Enter the information for the first cue, then check the boxes whose values you want to use as the default for succeeding cues.
2. Click on OK & Next, and the values you’ve made “sticky” will remain. All other fields will be cleared.
3. When you no longer want a value to stick, uncheck its sticky box.

As an extra time-saver, ADR Manager provides you with a way to avoid having to use the mouse to lock and unlock the sticky padlocks. Here are the command key equivalents to toggle the sticky padlocks, which are also displayed within the
padlock icon:

Start Time sticky padlock Command-1
End Time sticky padlock Command-2
Character sticky padlock Command-3
Dialog sticky padlock Command-4
Priority sticky padlock Command-5
Public Notes sticky
padlock Command-6

Private Notes sticky
padlock Command-7

The reel number is always sticky. The cue name is never sticky.
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Deleting cues

To delete cues, you must have the ADR Cue List Window open and active. Click, shift-click, and/or command-click the cues you would like to delete, then select Delete selected cues from the Manage menu. If you select any locked cues or a cue
that is currently displayed in the Modify Cue Window, they will not be deleted.

Before ADR Manager deletes the cues it warns you that the operation is not undoable. If you proceed, be aware that you won’t be able to “undo” the delete by choosing Undo from the Edit menu or typing command-Z. Click OK to go ahead and
delete the selected, unlocked cues. If you click Cancel, the cue(s) will not be deleted.

If you delete a cue that has both an ancestor and one or more descendants, ADR Manager will repair the cue lineage so that the descendants are directly linked to the ancestor. See Cue lineage for more information.
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Duplicating cues

To duplicate cues, you must have the ADR Cue List Window open and active. Click, shift-click, and/or command-click the cues you would like to duplicate, then select Duplicate selected cues from the Manage menu. For each selected cue, a new
cue will be added to the ADR Cue List with identical information as the selected cue. However, the duplicate cue will not have a cue name, and it will be unlocked. You will probably want to modify the new, duplicated cue(s) by double-clicking on it
(see below).
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Modifying a single cue

You can modify a cue individually, or you can modify multiple cues in one operation. To change multiple cues, see the next section. To modify a single cue, simply double-click on it in the ADR Cue List Window. The Modify Cue Window opens:

Change the cue’s reel, character, cue name , start and end times, dialogue, status, priority, public notes, and/or private notes. For more information about how to enter values into the various fields, see Entering information for a cue.

The duration padlock between the start and end time fields locks the duration of the cue, which is helpful if you need to re-spot the cue. If you change the start or end time, the other time will automatically be recalculated to maintain the cue’s duration.
Click on the padlock to lock and unlock it.

Takes can be added to cues via the Take List window.

If you want to save this cue and close the Modify Cue Window, click on Modify or hit the Enter key. The Modify Cue Window will close and the ADR Cue List Window will scroll so that the newly modified cue appears in the middle of the window. Then
the cue will be highlighted.

To save this cue and modify the next cue in the ADR Cue List without closing the window, click on Modify & Next. The ADR Cue List window will scroll so that the newly modified cue appears in the middle of the window.

If the cue is locked, all fields are dimmed (locked) and the Unlock cue button is present:
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Click on the Unlock cue button to unlock the cue. The Modify and Modify & Next buttons will appear in place of the Unlock cue button.

If you don’t want to save any changes to this cue, but you would like to view the previous cue or next cue in the ADR Cue List Window, click on the Prev or Next button. The new cue will appear in the Modify Cue window and the ADR Cue List Window
will scroll so that the cue to be modified appears in the middle of the window.

Descendant cues of the modified cue will be updated to reflect the changes you make in this window. Ancestor cues may be updated depending on your preference settings. However, in order to preserve embedded times in text fields, ADR Manager
will not update a text field in a descendant or ancestor cue if it contains an embedded time.

Click Cancel if you decide you don’t want to change anything and you want to close the Modify Cue Window.
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Modifying multiple cues

To modify multiple cues in a single operation, select the cues in the ADR Cue List window by clicking, shift-clicking, and/or control-clicking. Then choose Modify selected cues under the Manage menu, or click the Modify button in the List window
toolbar. The following window opens:

If there are any fields in this window that have values, those values are the same among all of the selected cues. For instance in the example above, all of the selected cues are from reel 1, so the “reel” field is filled in with the number “1”. Any fields that
do not have a value, such as the "status" field in the example above, means the selected cues have different values. You may enter values in the blank fields or overwrite the common fields that have values. If you leave a field blank, the field value will
not change in the selected cues. You can either append or replace text in a text field by choosing the appropriate radio button above it.

Descendant cues of the modified cues will be updated to reflect the changes you make in this window. Ancestor cues may be updated depending on your preference settings (see Cue status preferences). However, in order to preserve embedded times
in text fields, ADR Manager will not update a text field in a descendant or ancestor cue if it contains an embedded time.

Note that if you move cues to a new reel, they will retain their lineage ties to ancestor cues in older dupes of their original reel.

For example, if you wanted to move the selected cues to a new character (whether or not they all belong to the same character to begin with), enter the new character name. Another example might be if you’ve just finished recording a set of cues, you
could select them in the ADR Cue List Window, open the Modify Selected Cues Window, and set the status popup to Recorded.

For more information about the fields in the Modify Selected Cues Window, refer to Entering information for a cue.
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Modifying cue lineages

You can add ancestor and descendant cues to a cue (see Cue lineage) by selecting the cue in the ADR Cue List window and choosing Modify selected cue lineage… under the Manage menu. A window appears letting you choose which reel dupes
you would like to add related cues to:

Check the reel dupes in which you want to add related cues. Reel dupes that already contain the original cue, an ancestor cue, or a descendant cue are already checked. You cannot uncheck these checkmarks.

When done, ADR Manager will create duplicate cues in the reel dupes you selected. The cue(s) will have the same start and end times as the original cue and be related to the original cue (either as an ancestor or as a descendant). You should adjust
the start and end times of the newly created cues to account for the differences in where they fall in their respective reel dupes.
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Renaming cues

When a cue is to be recorded, it is imperative that the cue has a unique identifier. ADR Manager will generate unique names for cues that you select in the Cue List window by choosing Manage > Rename selected cues. A dialog confirms that you
want to rename all selected, unlocked cues. Only selected cues that are unlocked will be renamed. Cues are named according the naming convention you have specified in the Cue Naming tab of the Preferences dialog (see Cue naming).

You can name and rename cues at any time, but its usually best to name them before they get recorded, then lock the cues so that they cannot be renamed on purpose or by accident. This ensures that other things associated with recorded cues,
such as takes and sound files, will always match up properly. Once a cue is named, whether it is locked or not, that name cannot be reused by any other cue, unless it is related (see Cue lineages). If you want to reuse a cue's name, clear the name
first by either highlighting it in the Cue List window and choosing Manage > Clear selected cue names, or opening it in the Modify Cue window and clearing the name field. If no other cues are using that name in the database, ADR Manager will
reuse the name.

You can manually name cues in the New or Modify Cue window. If you enter a name that is already in use, a warning appears. If you go ahead and save the cue with the duplicate name, ADR Manager will not guarantee uniqueness - that is left up to
you. You can also have ADR Manager autofill names in the New and Modify Cue windows as soon as you enter a reel number, character, and start time.

It may be easiest and safer, however, to rename many cues at once after you have spotted them by highlighting them in the ADR Cue List Window and selecting Manage > Rename selected cues.
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Locking cues

Cues can be locked to prevent accidental modification. An unlocked cue can easily be modified accidentally if you select it and choose Rename selected cues… from the Manage menu, or you change it in the Modify Cue Window.

You cannot change a locked cue’s fields directly. This includes the reel, character, start and end time, cue name, status, priority, dialogue and notes. However, a locked cue’s start and end times, as well as embedded times in the dialogue and notes
fields, will still be modified by ADR Manager during a conform.

Locking a cue is a good idea, especially if you’ve already recorded it and are adding more cues to ADR Manager. That way, when you want to rename cues for a particular character and reel, you can select all cues for that character/reel (including
the locked ones) and rename them without fear of renaming the cues that are locked. You can have ADR Manager automatically lock cues when they reach a certain status, such as Recorded (see Cue status for more information).

To lock a cue, highlight it in the ADR Cue List Window and select Lock selected cues… under the Manage menu, or type command-L.

To unlock a cue, highlight it in the ADR Cue List Window and select Unlock selected cues… under the Manage menu, or type command-U.

You can lock and unlock several cues at once by shift-clicking or command-clicking on them and choosing the appropriate menu item.

ADR Manager will automatically lock and unlock descendant cues. Ancestor cues will be locked or unlocked according to your update ancestors preference.
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Creating takes

To create a take for the selected cue (or cues), choose Create take for selected cues under the Manage menu, or type shift-command-A. The New Take window will open and a new take will be created for the selected cue(s). If the New Take
window is already open, the cue(s) will be added to it.
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Showing related takes

You can quickly display the takes that are related to specific cues by highlighting the cues in the ADR Cue List window and choosing Show related takes under the Manage menu. The results will be shown in the Take List window.
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Characters
ADR Manager keeps track of all characters in your project. You can enter the character’s name, the character’s abbreviation to be used for numbering ADR lines (see Renaming cues), the actor’s name, and other information pertaining to recording
the character.
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Displaying characters

Displaying characters is done in the Character List Window. See List windows for a description of the buttons at the top of the window.

You can open this window by selecting Characters from the Windows menu, or typing command-K. If the Character List Window is already open, a checkmark will appear beside Characters. If the Character List Window is behind another window or is
inactive, select Characters to make the Character List Window active.

The Character List window can display the following columns. You can customize the window by clicking on the Customize button in the upper right corner.

Abbreviation – The character’s unique abbreviation.
Character name – The character’s unique name.
Actor name – The actor who plays the character.
Picture - A picture of the character
Lines per hour - The average lines per hour this actor can record
Type - The character's type (Principal, Minor, or Loop group)
Description - A description of the character
Recording notes - Notes pertaining to the recording of this character

As a default, the abbreviation, character name, and actor name columns are displayed.

Adding, deleting, duplicating, and modifying information about characters is done by selecting items in the Manage menu when the Character List window is active. When the window is active, the menu will look like this:

Use the menu items in this menu to add, duplicate, modify or delete characters.
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Creating characters

To create characters, you must have the Character List Window open and active. Select Add character from the Manage menu, or type command-N. The following dialog will appear:

Store general information about a character at the top of the window, and in fields in the Description and Recording tabs. The Recording tab looks like this:

You can always change these fields later (see Modifying characters).

Type – Choose what type of character this is: Principal, Minor, or Loop Group. By categorizing your characters, you can sort and group them in reports (see Character List reports for an example).
Character name – This field is limited to 64 characters. It is required, and must be unique (no two characters can have the same name).
Actor name – This field is limited to 64 characters. It is optional, and does not need to be unique (i.e. the same actor can play several different characters).
Character abbreviation – This field is limited to 12 characters. It is required, and must be unique. If character abbreviations are used in cue names (see Cue name fields) and your cue naming convention uses a delimiter after the character
abbreviation, make sure you don’t use the delimiter in any character abbreviation. If you are not using a delimiter, then make sure your abbreviation cannot be confused with the field that follows the character abbreviation in the cue name. For
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abbreviation, make sure you don’t use the delimiter in any character abbreviation. If you are not using a delimiter, then make sure your abbreviation cannot be confused with the field that follows the character abbreviation in the cue name. For
instance, if your cue name convention consists of a character abbreviation followed by a reel number, avoid using the uppercase letter “O”, the lowercase letter “l”, the uppercase letter “I”, or any digits at the end of a character abbreviation. They
could easily be confused with a reel number.
Description – This field is limited to 80 characters. You can enter a description of who this character is (useful for minor characters), or leave this field blank. The field can be included in character reports.
Estimated cues per hour – This field is required, and must be between 1 and 999. Store how many cues per hour, on average, you think the actor can perform. This number is used by line count table reports to estimate how long it will take an
actor to record all of his or her cues.
Recording notes – This field is optional. You can use it to store information about where or when this character will be recorded. In a line count table, you can group characters with the same recording notes together to create subtotals. For
instance, if you entered the recording stage for each character, you could generate a line count table with subtotals for how much time to book for each stage. See the Line Count Table report for an example.
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Duplicating characters

To duplicate characters, you must have the Character List Window open and active. Click, shift-click, and/or command-click the characters you would like to duplicate, then select Duplicate selected characters from the Manage menu. If any of the
characters you have selected contain cues, the following dialog will appear:

You can choose to duplicate the character’s cues in the current reel set only, duplicate cues in all reel dupes, or don’t duplicate any cues. Choose one of the options and click OK. To cancel the operation, click Cancel. If you click OK, a dialog will let you
know what name and abbreviation the new character was given.

For each selected character, a new character will be added to the character list with information identical to the selected character, except that the abbreviation and name will be given slightly different values than the original character. This is done
because characters must have unique names and abbreviations. You will probably want to give the new, duplicated character(s) better names and abbreviations than the randomly generated ones (see Modifying characters).
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Deleting characters

To delete characters, you must have the Character List Window open and active. Click, shift-click, and/or command-click the characters you would like to delete, then choose Delete selected characters from the Manage menu. Before ADR
Manager deletes the characters, however, it warns you that the operation is not undoable. If you proceed, be aware that you won’t be able to “undo” the delete by choosing Undo from the Edit menu or typing command-Z.

If you are deleting a character that has cues, ADR Manager verifies that you want to delete all of the character’s cues as well. A dialog will appear asking you to confirm that you want to delete the cues associated with the character. Click OK to
delete the character and all of its related cues. Click Cancel to abort, leaving the character and its cues untouched. Clicking on Cancel aborts the entire delete process for the character in question as well as other characters you may have selected to
delete.

If the character does not have any cues, ADR Manager will go ahead and delete it without asking you first.

TIP: If you want to keep a character’s cues but delete the character, create a new temporary character and reassign the cues to the new character (see Modifying multiple cues). Then delete the original character.
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Modifying characters

To modify a character, simply double-click on it in the Character List Window. The Modify Character Window appears:

Change the character fields (see Creating characters) then click OK, or click Cancel if you decide you don’t want to change anything.

If you change the abbreviation for a character, and the character has cues that have been named, the following dialog will appear:
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You can choose to erase the cue names, replace the old abbreviation with the new abbreviation, leave the cue names as they are, or abort. This will affect cues in all reel dupes, not just those in the current reel set.
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Reels
ADR Manager keeps track of all reels in your project. Each reel consists of one or more reel dupes. When you create a new reel, you also create a dupe of that reel that has a specific dupe date. A reel dupe is a particular snapshot in time of a reel.
Once you've created a reel (and a dupe), you can create successive dupes, each dupe based on the previous dupe. Each time you create a new dupe, the cues and scenes from the old dupe of the reel are copied into the new dupe. This lets you
modify cues in the new dupe without touching the cues in the old dupe. Switching back and forth between dupes of a reel is done using reel sets (see Reel sets).

The WILD reel is a special reel that contains cues that have no start or end time. The WILD reel has only one dupe, and has a reel number of 0.
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Displaying reel dupes

Displaying reel dupes is done in the Reel List Window. See List windows for a description of the buttons at the top of the window.

You can open this window by selecting Reels from the Windows menu, or typing command-R.

If the Reel List Window is already open, a checkmark will appear beside Reels. If the Reel List Window is behind another window or is inactive, select Reels to make the Reel List Window active. You can close the Reel List Window by clicking on its
close box, or typing command-W or command-period.

The Reel List window displays only the reel dupes in the current reel set. The window consists of the following columns. You can customize the window by clicking on the Customize button in the upper right corner.

Number – The reel dupe’s number.
Version – The reel dupe’s version.
Dupe date – The reel dupe’s dupe date.
FFOA – The First Frame of Action for the reel dupe, in the currently displayed time format
LFOA – The Last Frame of Action for the reel dupe, in the currently displayed time format. This time is inclusive.

Adding, deleting, duplicating, and modifying information about reel dupes and reel sets is done by selecting items in the Manage menu when the Reel List window is active. When the window is active, the menu will look like this:

Use the items in this menu to create reels, create and delete reel dupes, conform reel dupes, or add, delete, and modify reel sets.
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Creating reels

You may create a new reel as long as it does not have the same number as an existing reel in the database. When you add a reel, a new, empty reel dupe is added to the current reel set only. To create a new dupe of an existing reel, you must use the
Create new dupe of sel dupe menu item (see Creating reel dupes).

NOTE: It is important to remember the difference between creating a new dupe and creating a brand new reel. Creating a new dupe will automatically copy all of your previously spotted cues and scenes from the original dupe into the new
dupe, which you can then conform. Making a new reel creates a new, empty dupe with no cues.

To add reels, you must have the Reel List Window open and active. Select Create new reel from the Manage menu, or type command-N. The following dialog will appear:

The Descriptions tab allows you to enter a brief description and full description for the reel. The brief description is limited to 80 characters, while the full description is unlimited.

A description of each field under the Timelines tab is listed below. To change the default value of a field, simply type into it then press the tab key to move to the next field in the window. You can change a value by typing in a new one, or you can modify
any of the values later (see Modifying reel dupes).

Enter a new reel number. The next available reel number is automatically entered for you as the default reel number. You cannot have two reels with the same reel number.
You can enter a version using up to 8 characters, or you can leave this field blank.
The default dupe date is today’s date. Change it to a more appropriate date, if you wish. When entering a date, you must enter a backslash between the month and day, and another between the day and year.
The Reel start, First Frame of Action (FFOA), Last Frame of Action (LFOA), and Reel end all define locations in the reel. Note that the LFOA and Reel End are inclusive, meaning that the specified frame is included in the reel. In other words,
to find the actual running time of the reel, add 1 frame to the LFOA and then subtract the FFOA.

You must enter time values for the Reel Start, FFOA, LFOA, and Reel end in the currently displayed time format. You must also enter a time for the Reel Start in the alternate time format. The FFOA, LFOA, and Reel end in the alternate time format are
automatically calculated.

For instance, if the time format is currently in feet and frames, the Reel start is probably at 0+00, the FFOA is probably at 12+00, the LFOA is somewhere around 2000+00, and the Reel end you could set to 2020+00. On the other hand, if the time format
is in timecode, the Reel start may be at 00:59:50:00 the FFOA might be at 01:00:00:00, the LFOA might be at 01:20:00:00, and the Reel end could be at 01:30:00:00. The Reel start, FFOA, LFOA, and Reel end each must be successively greater than or
equal to the previous time value. Cues cannot start before the FFOA, or start after the LFOA. Also, cues cannot end after the Reel end. Scenes are contained within the FFOA to LFOA range.

Once you have entered all the information, you can save the new reel in two ways: by clicking on the OK button, or by clicking on the OK & Next button. If you click on the OK button, the reel is saved and the New Reel Window closes. If you click on the
OK & Next button, or hit the enter key, the reel is saved and the New Reel Window remains open, with default values for another reel.

If you decide you don’t want to save the reel, click on Cancel or type command-period. This will close the New Reel Window without saving the reel.
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Creating reel dupes

To create a new dupe of an existing reel dupe, you must have the Reel List Window open and active. Select the old dupe you wish to make a new dupe of, then select Create new reel dupe... from the Manage menu, or type shift-command-N. You can
create a new version of only one old dupe at a time, and you can only make a new version of the latest dupe of any particular reel. In other words, you cannot create a new version that lives chronologically between two existing dupes. If a later version
already exists for the currently selected dupe, an error message will appear stating that you can only make a new version of the latest reel dupe.

If there is no conflict, the following dialog will appear:

Enter the version and dupe date for the new reel dupe:

The version can have up to 8 characters or be left blank. If you are distinguishing reel dupes by version (see Cue status preferences), you’ll need to enter a string that is unique among all dupes with that reel number.
The dupe date must be later than the selected reel’s dupe date (remember, you are making the latest version of the reel). Click OK when done.

If you click OK, ADR Manager will do the following:

Copy all of the cues from the old dupe to the new dupe.
Create lineage ties between the cues in the old dupe and the cues in the new dupe (see Cue lineages).
Copy all of the scenes from the old dupe to the new dupe.
Give you the option of replacing the old dupe with the new dupe in the current reel set.

You can now conform the cues and scenes in the new dupe without fear of modifying the cues and scenes in the old dupe (see Conforming).
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Deleting reel dupes

To delete reel dupes, you must have the Reel List Window open and active. Click, shift-click, and/or command-click the reel dupes you would like to delete, then select Delete selected dupes... from the Manage menu. Before ADR Manager deletes
the dupes, however, it warns you that the operation is not undoable. If you proceed, be aware that you won’t be able to “undo” the delete by choosing Undo from the Edit menu or typing command-Z.

If you are deleting a dupe that has cues, ADR Manager verifies that you want to delete all of the cues as well (scenes are automatically deleted without warning). Click OK to delete the reel dupe and all of its related cues and scenes. Click Cancel to
abort, leaving the dupe and its cues and scenes untouched. Clicking on Cancel will not abort the entire delete process if there are more reel dupes to be deleted; it will only skip over the current reel dupe in question.

If the reel dupe does not have any cues, ADR Manager will go ahead and delete it without asking you first.

Deleting a particular dupe of a reel does not delete any other dupes of that reel, so if you want to remove all versions of a reel from your database, you must display each dupe one by one (by switching reel sets) then selecting and deleting each one.
Note that deleting an “intermediary” dupe will not break any lineage ties between cues in the earlier dupe and cues in the later dupe of that reel. For example, if you had three versions of reel 1 (v1, v2, and v3) and you deleted v2, then the cues in v3
would become direct descendants of the cues in v1.

TIP: If you want to keep a reel dupe’s cues but delete the dupe, create a temporary reel dupe and reassign the cues to the temporary dupe (using the Modify Selected Cues window). Then delete the original dupe.

You cannot delete the WILD reel.
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Modifying reel dupes

To modify a reel dupe, simply double-click on it in the Reel List Window. The Modify Reel Window appears:

A description of each field in the Modify Reel Window is listed below.

Change the reel number to a new number, if desired. This will create a new reel, so the number must be brand new. You can only change the reel number for a dupe that has no earlier or later dupes. In other words, you cannot remove a dupe
from a set of related dupes to make a new reel. If you want to move cues out of a reel, create a new reel and use the Modify selected cues feature to move them to the new reel.
Change the version using up to 8 characters, or you can make this field blank.
Change the dupe date is today’s date. Change it to a more appropriate date, if you wish. When entering a date, you must enter a backslash between the month and day, and another between the day and year. The dupe date for the reel must be
later than any previous dupes and earlier than any later dupes.
The Reel start, First Frame of Action (FFOA), Last Frame of Action (LFOA), and Reel end all define locations in the reel. Note that the LFOA and Reel end are inclusive, meaning that the specified frame is included in the reel. In other words,
to find the duration of actual picture in a reel, add 1 frame to the LFOA and then subtract the FFOA.

If the reel has cues and those cues have cue names, the cue names will not be affected, even if the reel number changes.

REMEMBER: If you are conforming a reel, it is usually best to make a new dupe of the reel, rather than modifying the existing reel. That way, you can keep the cues in the older dupe intact for historical purposes. See Creating reel dupes above for more
info.

If you shorten the reel by decreasing its LFOA, then this will affect cues and scenes at the end of the reel dupe, and ADR Manager will treat the change as a Delete time (see Conforming). Similarly, if you make the FFOA later and cues that started at
the beginning of the reel dupe are affected, ADR Manager will delete and/or trim the cues similar to Delete time, except that the deletion will not ripple throughout the dupe. In other words, the cues and scenes will not move earlier in time.

You cannot modify the WILD reel.
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Conforming reel dupes

To conform a reel dupe, highlight it in the Reel List window, and click on the scissors button in the toolbar at the top of the window or select Manage > Conform selected dupe. The Change List window appears:

Please refer to the Conforming section for more information about conforming and using this window.
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Reel sets
You can use reel sets to group related reel dupes together. This is useful if, for example, you have different dupes of reels in your project and you want to keep the “Version 2.0” dupes separate from the “Version 3.0”. You could create one reel set to
group the old dupes together, and another reel set to hold the new dupes. Reel sets also prevent you from seeing two dupes of the same reel at any given time, which could be confusing when searching or creating new cues. The exception to this is the
special “All reel dupes” set (see Default reel sets). A reel set can hold any number of reels in the project - it does not have to have every reel. A reel set could even have 0 reels.

There is no limit to the number of reel sets you can create. You cannot delete the “All reel dupes” set. To change reel sets, click on the popup in either the Search Window or Reel List Window:

When you change the reel set in one window, it changes in the other window. In fact, the change is global throughout the program, since different reels may now be active. The Cue Search and Reel List Windows display the reels belonging to the new
reel set, and the Scene List Window displays the scenes that belong to the reels. If there are cues displayed in the ADR Cue List window that belong to reels in the new reel set, those cues are left in the ADR Cue List window (cues not in the new reel
set are removed from the window).

When importing, make sure you have the correct reel set active so that imported cues and scenes are added in the proper reel dupes. Also be sure to have the correct reel set active when conforming.

Reel sets are added, deleted, and modified by making the Reel List Window active and choosing the items dealing with reel sets under the Manage menu.
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Default reel sets

There are 2 reel sets that are automatically created when you create a new database: the “All reel dupes” set and a “Default set.”

The “All reel dupes” set is a special reel set that cannot be deleted or modified. Every time you create a new reel or reel dupe, it automatically gets added to the “All reel dupes” set. When this reel set is active, you can perform searches for cues
throughout the entire database. This gives you the ability to find a cue, regardless of what reel dupe the cue is in. The disadvantage to making the “All reel dupes” set active is that you cannot add, modify, or import cues and scenes, nor can you
perform any conforming operation. You must switch to a normal reel set to do these operations.

The other reel set that is created automatically is the “Default set.” This is simply a “starter” reel set that you can use to hold the latest dupes of each reel, for example. This reel set can be modified or deleted. When you first create a database, this is
the active reel set.
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Creating reel sets

To create a reel set, you must have the Reel List Window open and active. Select Add reel set from the Manage menu. The following dialog will appear:

This dialog lets you name the reel set and choose which reels belong to it. The reel set name can have up to 32 characters. To add a reel to a reel set, click on it and a checkmark will appear. To remove a reel, click on its checkmark to uncheck it. If you
attempt to put a checkmark on a reel for which another dupe is already checked, the previous dupe will be unchecked. For instance, if Reel 1 v3 were checked and you checked Reel 1 v4, then Reel 1 v3 would automatically be unchecked.
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Deleting reel sets

To delete the currently active reel set, you must have the Reel List Window open and active. Select Delete current reel set from the Manage menu. The currently active reel set will be deleted and another reel set will be selected as the new active
set.

You cannot delete the “All reel dupes” reel set.
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Modifying reel sets

To modify the currently active reel set, you must have the Reel List Window open and active. Select Modify current reel set from the Manage menu. The following dialog will appear:

This dialog lets you rename the reel set and change which reels belong to it. The reel set name can be up to 32 characters. To add a reel to a reel set, click on it and a checkmark will appear. To remove a reel, click on its checkmark to uncheck it. If you
put a checkmark on a reel for which another dupe is already checked, the previous dupe will be unchecked.

You cannot modify the “All reel dupes” set yourself. This set is automatically maintained by ADR Manager.
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Scenes
ADR Manager allows you to maintain a list of scenes, or continuity, for your project. You can enter information about a scene, including what reel it is in, brief and verbose descriptions of it, and what time it starts, using the Scene List Window.
Scenes are helpful when entering or modifying cues, since scene information is displayed in the New Cue, Modify Cue, and ADR Cue List windows based on what reel and at what time the cue starts. Scene information can also be included in
reports created for actors, directors, editors, and mixers, so that they can have an idea where a cue exists in the project.

ADR Manager automatically makes sure that every frame of a reel is in a scene. This means that each scene must end one frame before the starting time of the next scene, or at the reel’s LFOA if it is the last scene in the reel. Scenes cannot start in
one reel and end in another.
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Displaying scenes

Displaying scenes is done in the Scene List Window. See List windows for a description of the buttons at the top of the window.

You can open this window by selecting Scenes from the Windows menu, or typing command-J. If the Scene List Window is already open, a checkmark will appear beside Scenes. If the Scene List Window is behind another window or is inactive, select
Scenes to make the Scene List Window active. You can close the Scene List Window by clicking on its close box, or typing command-W.

The Scene List window displays the following columns. You can customize the window, such as showing more lines of text in each row, by clicking on the Customize button in the upper right corner.

Reel number – The scene’s reel number. If the “All reel dupes” set if currently active, this will also show the reel’s version or dupe date.
Scene name – The scene’s name.
Start time – The scene’s start time in the reel, in the currently displayed time format.
Brief description – The first few lines of the brief description field.
Full description – The first few lines of the full description field.

Adding, deleting, duplicating, and modifying information about scenes is done by selecting items in the Manage menu when the Scene List window is active. When the window is active, the menu will look like this:

You can use these menu items to add, modify, and delete scenes.
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Creating scenes

To create scenes, you must have the Scene List Window open and active. Select Add scene from the Manage menu, or type command-N. The following dialog will appear:

A description of each field in the New Scene Window is listed below. To change the default value of a field, simply type into it then press the tab key to move to the next field in the window. You can change a value by typing in a new one, or you can
modify any of the values later (see Modifying scenes).

Select a reel number from the popup menu. The reel number you enter must be in the current reel set. After entering a number, the version or dupe date of that reel is displayed so you know you are adding this scene to the correct reel dupe.
The scene name can contain up to 10 characters. You must enter something in this field. Scene names do not have to be unique. Default scenes have “--” as the name (but you can modify this).

Under the “Descriptions” tab are fields describing the scene:

The brief description field can hold up to 80 characters. This field is displayed in the New Cue and Modify Cue windows to describe what scene the cue lies in.
You can enter as much text as you like in the full description field. You can embed time values in the full description by doing one of the following:

You can enter a time manually, complete with colons or plus signs.
You can select Insert current time from the Manage menu to grab the current incoming MIDI time (shown in the Transport Control window) and insert it at the current cursor location. If text is already selected, it will be replaced by the
inserted time. If the cursor is not in the full description field, the command is ignored.
You can use a keyboard shortcut to embed the current time.
You can tell ADR Manager to insert the current time from an applescript. See Apple scripts for more information.

Click on the “Timelines” tab to specify where the scene starts:

ADR Manager 5 User Manual 104



Enter a value in the FFOA field. If you have established MIDI communication with a Pro Tools session, then the scene’s reel and FFOA will automatically be set to the current time. Otherwise, the scene FFOA will be set to the default reel’s FFOA.
You can change the FFOA in several different ways:

You can enter a time manually, complete with colons or plus signs, or you can use the shorthand method.
You can use Set start time to current time under the Manage menu to put the current time from the Transport Control window in the FFOA.
You can put the cursor in the FFOA field and select Insert current time from the Manage menu.
You can use a keyboard shortcut to insert the current time.
You can tell ADR Manager to insert the current time from an applescript. See Apple scripts for more information.

No two scenes can share the same FFOA in the same reel – if you try to save a scene with the same FFOA as an existing scene, ADR Manager will give you the option of replacing the old scene or canceling.
The scene’s LFOA will be automatically calculated as one frame before the start time of the following scene. If this is the last scene in the reel, the end time will be set to the reel’s LFOA.

Note that whenever you create a new reel, ADR Manager automatically creates a new scene that starts at the reel’s FFOA and ends at the reel’s LFOA. You cannot delete this scene, only modify or replace it.

Once you have entered all the information, you can save the new scene in two ways: by clicking on the OK button, or by clicking on the OK & Next button. If you click on the OK button, the scene is saved and the New Scene Window closes. If you click
on the OK & Next button, or hit the enter key, the scene is saved and the New Scene Window remains open, with default values for another scene.

If you decide you don’t want to save the scene, click on Cancel or type command-period. This will close the New Scene Window without saving the scene.
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Deleting scenes

To delete scenes, you must have the Scene List Window open and active. Click, shift-click, and/or command-click the scenes you would like to delete, then select Delete selected scenes from the Manage menu. Before ADR Manager deletes the
scenes, however, it warns you that the operation is not undoable. If you proceed, be aware that you won’t be able to “undo” the delete by choosing Undo from the Edit menu or typing command-Z.

Deleting a scene removes it from the scene list and extends the previous scene into the region where the deleted scene existed. You cannot delete the first scene in a reel - you can only replace or modify it.

No cues are deleted when deleting a scene - cues are simply reassigned to whatever scene they fall into after the deletion. Reel LFOAs are also not affected when deleting scenes.

ADR Manager 5 User Manual 106



Modifying scenes

To modify a scene, simply double-click on it in the Scene List Window. The Modify Scene Window appears:

See Creating scenes for a description of the fields in this window.

If you move the scene to a new location by changing its start time and/or reel, cues within the scene are not moved with it, nor are any reel LFOAs affected. Instead, the previous scene is extended into the region where the modified scene used to be,
and cues are modified to reflect which scene they now lie in.
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Spell checking scene fields

You can run a spelling checker on text fields in the New Scene and Modify Scene windows. Choose Spell check under the Manage menu when the window is front most and the cursor is in one of the following fields:

Brief description
Full description

If a spelling error is encountered, a window appears:

You can choose to:

Ignore this occurrence and continue checking the rest of the field
Ignore this occurrence and stop checking the field
Add the word to the dictionary
Change the word to a word found in the dictionary (if any)
Change all occurrences of this word in the field
Do none of the above and quit spell checking

The spelling dictionary is saved with the application, so any additions you make to the dictionary will be used when spell checking other records in this database, as well as when you spell check fields in other databases you open or create from now on.
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Scenes

This section describes the details of importing and exporting scenes. For an explanation of how records are imported in general, see The import process. For a list of scene fields that you can import and export, see Scene fields.
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Takes and sound files
You can keep a list of takes for each spotted cue within ADR Manager. A take is distinct from a cue in that it describes an actual recording, whereas a cue is an intended recording. Some of the fields of a take may be different than the corresponding
field in the spotted cue. For instance, the recording may have different dialogue than the dialogue that was spotted for the cue. A take record also stores information such as whether the recording was any good or not (i.e. “circled” takes and ratings).

A cue can have multiple takes. For example, if the actor performed a cue 10 times, there would be 10 separate takes. However, a take does not necessarily represent only one cue. For example, if an actor decides to record several cues together in
one performance, then the resulting take spans several cues. If auto-naming takes is turned on, ADR Manager generates take names that describe which cue(s) they span, using the take naming preferences.

If you follow the ADR Manager naming convention when recording and creating sound files, and you import the sound files from a folder scan into the Take List window, ADR Manager will automatically create takes based on the filenames and link
them to the appropriate cues.

A take can have a sound attached to it. A sound is defined as one or more sound files that all have the same characteristics such as sample rate, bit depth, timestamp and number of samples. Each sound file contains a separate channel of the
sound. For instance, in the case of a mono sound there is only one sound file; stereo sounds have two sound files, etc. ADR Manager recognizes files with matching Pro Tools channel suffixes (i.e. .L,.C, .R, .Ls, .Rs) and assumes they are one
sound. All of the sound files must live in the same folder.

A take stores the full pathname to the files of a sound. If you move the files or change a folder name in the pathname, you must rescan the folder to update the information stored with the take records.

Storing sounds gives you the ability to audition and put the sound files into a Pro Tools session. A take can only have one sound attached to it, and a sound can belong to only one take. Takes can also have no sound attached to them.

Currently, ADR Manager 5 only supports AIFF, WAV, and Sound Designer II sound files.
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Displaying takes

Displaying, adding, deleting, duplicating, and modifying takes is done by opening the Take List Window. See List windows for a description of the buttons at the top of the window.

You can open this window by selecting Takes from the Windows menu, or typing command-T. If the Take List Window is already open, a checkmark will appear beside Takes. If the Take List Window is behind another window or is inactive, select
Takes to make the Take List Window active. You can close the Take List Window by clicking on its close box, or typing command-W.

The Take List window displays the following columns, as a default. You can customize the window by clicking on the Customize button in the upper right corner.

Audition speaker – If a speaker icon appears in this column, then there is a sound file associated with this take. If the speaker has sound waves emerging from it, then the sound file’s volume is mounted. If the speaker is gray and has no sound
waves, then the take has an associated sound file but the file’s volume is not mounted currently.
Take name – The name of the take. If the take name was generated by ADR Manager, then it will follow the take naming conventions set up under Edit > Preferences > Take Naming.
Take number – The number of the take. If you have checked the “Circled” checkbox in the New Take or Modify Take windows for this take, a circle will appear around the number. Option-clicking on the take number toggles the circle on and off.
Rating – A rating for the take. Ratings, from highest to lowest, are “A”, “B”, “C”, “D”, “F”, and “NG” (stands for No Good).
Notes – General recording notes about the take.
Dialogue – The actual dialogue of the take. This may different than the cue’s dialogue for which this take was recorded.

You can link cues to takes by option-dragging them from the ADR Cue List window on to a take in the Take List window. You can also add cues to a take when in the New Take or Modify Take windows. See Linking to cues for more information.

Adding, deleting, duplicating, and modifying information about takes is done by selecting items in the Manage menu when the Take List window is active. When the window is active, the menu will look like this:
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Use the menu items in this menu to add, duplicate, or delete takes, display related cues, show sound files for the take, and spot the sound files to a Pro Tools session.
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Creating takes

To create a take, make the Take List Window active and select Add take from the Manage menu, or type command-N. You can also create a take by selecting cues in the Cue List window and choosing Create take for selected cues under the
Manage menu. The following dialog will appear:

Store general information about a take in the top half of the window, and in fields in the Audition, Cues, and Reel/Scene tabs. When finished, click on “OK” to save and close the window, or click on “OK & Next” to save the take and keep the window
open for a new take.

If you intend to make another take for the same set of cues (i.e. you are creating takes “on the fly” during a recording session), check the Keep same cue info checkbox. This will:

Create a new take linked to the same cues
Increment the take number
Retain the dialogue text, even if the Auto create dialogue box is unchecked
Create a new take name using the current take naming convenstion
Clear the circled setting, ratings setting, recording notes, and sound file references

The information in the top half of the window is:

Take name – You can enter any string in this field you wish, but keep in mind you should follow the take naming convention setup in the Edit > Preferences > Take Naming window. The maximum length of the take name is 80 characters,
although you may want to limit it to 32 if you plan on spotting the take’s sound file into Pro Tools (see Spotting into Pro Tools) due to limits in Pro Tools. If the “Auto-name” checkbox is checked, you cannot edit this field.
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Auto-name – Check this box if you want ADR Manager to automatically generate a take name whenever you change the take number or change the cues in the take. The take name will be created using the current take naming convention. If this
box is checked, you cannot edit the Take name field.
Take number – Enter the take number . You can enter any number from 1 to 50.
Character – This field is automatically filled in by ADR Manager when you assign one or more cues to a take. If all of the cues are from the same character, the field gets the character name. If the cues are from different characters, the field is set
to “Various.” You cannot edit this field.
Circled take – Click this checkbox or type option-1 to mark this take as circled. You can search on circled takes in the Search window (see Searching for takes). If a take is circled, the take number will appear with a circle around it in the Take List
window. Note that you can quickly circle and uncircle a take in the Take List window (without having to open the Modify Take window) by option-clicking on the number in the number column.
Rating – You can rate each take for performance, quality of recording, etc. by choosing a rating level in the Rating popup. As a default, all cues are given the highest rating: “A”. Possible ratings, from highest to lowest, are: “A”, “B”, “C”, “D”, “F”,
and “NG” (stands for No Good). You can search for takes with particular rating levels in the Search window.
Dialogue – If you add cues to the take, the dialogue will be automatically constructed by concatenating the dialogue of each of the added cues. You can also edit this box manually. Takes may have different dialogue than the spotted cues, to
allow for cases when an actor says something different than what was spotted. In these cases it may be helpful to accurately transcribe the actual recorded dialogue so that you can search for these words during editing.
Auto create dialogue – Check this box if you want ADR Manager to automatically generate dialogue for the take, based on the linked cues. Dialogue for the cues is concatenated in the order the cues appear under the Cues tab. If this box is
checked, you cannot edit the Take dialogue field.
Recording notes – You can enter remarks about the recording in this field. You can later search for takes with certain keywords in the recording notes field using the Search window (see Searching for takes). Recording notes appear in a column
in the Take List window.

Audition a take's sound files under the Audition tab. Add sound files to a take under the Sound Files tab. ADR Manager can only audition one sound file at a time. You can choose which sound file to play by selecting the channel in the Audition Channel
popup. You can then audition the sound file using normal QuickTime controls.

Under the Sound Files tab, you can assign one or more sound files to the take.

Under the Cues tab, you can add and delete the cues that the take is linked to.

Remember, if the Auto-name checkbox is checked, the take name will automatically be regenerated each time you change the cues or take number. If the Auto create dialogue box is checked, the take dialogue will be automatically regenerated each
time you change the cues.
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Attaching sound files to the take

The Sound Files tab shows what sound files are associated with the take:

You can add sound files to the take by clicking on the Add button (+) to the right of the Files list and selecting one or more files. The following attributes of the files must be identical:

File type
Sample rate
Bit depth
Timestamp
Duration

The common attributes are displayed under the list of files. To audition one of the files, go to the Audition tab.

You can also import a text file describing many sound files and what takes they are associated to, or you can scan a folder for sound files. In either case, ADR Manager will automatically create takes for the sound files (if they don’t exist already) and link
them to cues. See Importing takes via a folder scan for more information.

ADR Manager 5 User Manual 115



Auditioning sound files

The Audition tab allows you to audition sound files associated with the take:

 

The Audition channel popup above the QuickTime player strip displays all available channels. Choosing a channel changes what sound file is played in the QuickTime player strip, regardless of what sound file is displayed in the Sound File text box
above it. This channel is stored with the take, so if you change it, be sure to click on the Modify or Modify & Next button to preserve the selection for next time. The audition channel can also be used when spotting to Pro Tools (see Spotting into Pro
Tools).
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Linking a take to cues

The Cues tab shows what cue(s) the take is linked to. A take can encompass more than one cue, provided that all cues are in the same reel.

The list displays what cue(s) this take spans. Cues are always listed in order by start time.

There are several ways to add cues to the list:

You can option-drag them from the ADR Cue List window into the take’s cue list
You can choose Add selected cues under the Manage tab. Any selected cues in the ADR Cue List window will be added.
You can select them in the ADR Cue List window and select Create take for selected cues (shift-command-A) under the Manage menu while the ADR Cue List window is active.

Make sure the active reel set is the one in which the takes were recorded. When a take is linked to a cue, ADR Manager assumes that the cue's dupe is the dupe to which the take was recorded. The dupe is displayed above the cue list.

For each added cue, a link will be created between the take and the cue. The take is also linked to ancestors of the added cue according to the “Modify ancestor cues” preference (see Cue status preferences for more info). If the “Auto-name” checkbox
is checked, ADR Manager will automatically generate a new take name. If the "Auto-generate dialogue" checkbox is checked, the take's dialogue is reconstructed based on the cues' dialogue.

To remove cues from the list, select them and click on the “Clear selected cues” button. This will affect the name and dialogue of the take if the "Auto-name" and "Auto-generate dialogue" boxes are checked, respectively.

ADR Manager 5 User Manual 117



Duplicating takes

You can duplicate takes by selecting them in the Take List window and choosing Duplicate selected takes… under the Manage menu, or typing command-D.

Each selected take will be duplicated, along with the ties to related cues. For each related cue, links will be created between the cue and the duplicated take, as well as descendants of the cue and the duplicated take. Links between ancestors of the
cue and the duplicated take are created according to the “Modify ancestor cues” preference (see Cue status preferences for more info).
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Modifying a single take

You can modify a take individually, or you can modify multiple takes in one operation. To modify multiple takes, see the next section. To modify a single take, simply double-click on it in the Take List Window. The Modify Take Window opens:

Change the take’s name and number, circled status, rating, dialogue, recording notes, linked sound files, audition channel, and linked cues by selecting them and typing in a new value and using tab or shift-tab to move to another field. See Creating
takes for a more detailed description of these fields.

If you want to save this take and close the Modify Take Window, click on Modify or hit the Enter key. The Modify Take Window will close and the Take List Window will scroll so that the newly modified take appear highlighted in the middle of the window.

To save this take and modify the next take that is currently displayed below it in the Take List Window, click on Modify & Next. The Take List Window will scroll so that the newly modified take appears highlighted in the middle of the window.

If you don’t want to save any changes to this take, but you would like to modify an adjacent take in the Take List Window, click on the Next or Previous button. The Take List Window will scroll so that the take to be modified appears highlighted in the
middle of the window.
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Modifying multiple takes

To modify multiple takes in a single operation, select the takes in the Take List window by clicking, shift-clicking, and/or control-clicking. Then choose Modify selected takes under the Manage menu. The following window opens:

Any boxes that already have values represent common information among all of the selected takes. For example, if all of the selected takes have the same dialogue, then the dialogue box will already be filled with the text. All other fields in the window
will be blank. You may enter values in the blank fields and/or overwrite the common fields that have values. Leaving a field blank and choosing Append, or leaving a field with common text and choosing Replace, means that that field value will not
change in the selected takes.

If some of the selected takes are circled and some are not, the Circled checkbox will display a line, as shown above. Click on the checkbox to set all takes to circled or uncircled.

If the selected takes have various ratings, the Rating popup will be blank. Choose a rating to set all selected takes to the same rating.

Under the Audio tab, you can select the audition channel for the selected takes. All selected takes must have sound files attached, and all sound files must be currently online in order to change the audition channel. Otherwise, the audition channel
popup will display "Offline."

Under the Cues tab, you can append or replace which cues are linked to the takes by selecting the appropriate radio button under the Cues tab and adding or deleting cues in the cues area.
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If you add or delete cues to the list and the Auto-name checkbox is turned on in the New or Modify Take window, then the selected takes' names will be regenerated.
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Showing related cues

You can quickly display the cues that are related to certain takes by highlighting the takes in the Take List window and choosing Show related cues under the Manage menu. The results will replace whatever is showing in the ADR Cue List window.
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Displaying the sound file

You can display a take’s sound file(s) in the Finder by selecting the take in the Take List window and choosing Show sound file in Finder under the Manage menu. If more than one take is selected, only the first take’s sound files are shown. If there
are several online copies of the take's sound file, ADR Manager randomly chooses one.
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Spotting into Pro Tools

You can “spot”, or place, a take’s sound file in an open Pro Tools session. The take’s sound file will be placed, in its entirety, at the current cursor location. If the cursor is on more than one track, the sound file will be place on the first selected track. The
region will be named with the take name (not the sound file name, which may be different).

Spot into Pro Tools by selecting one or more takes in the Take List window and choosing Spot takes to Pro Tools under the Manage menu. The following dialog appears:

If the take(s) you are attempting to spot were recorded to a different dupe than the one in the current reel set, a dialog will appear warning you that the take may be placed in the wrong position if you want to place it at the recorded time.

You have two ways to control the sync placement of sound files in a Pro Tools session:

Place at cursor - Places the head of the sound file(s) where the cursor is currently parked in the session.
Place at recorded time - Places the head of the sound file(s) using the sound files' timestamp. If the timestamp is before the session start time, the sound file(s) are put at the beginning of the session. Note that the timestamp is stored in
samples, so if the take's timestamp (as displayed in the Modify Take window) does not match the spotted time in Pro Tools, check to make sure the Pro Tools session setup time formats match the database time formats.

You can choose which sound files to spot into Pro Tools:

Spot audition channel only - Only places the sound file designated in the Audition popup in the New/Modify Take window.
Spot all channels of take - Places all sound files of the take on vertically adjacent tracks. If you are spotting to multichannel tracks (i.e. stereo tracks), check the "to multichannel tracks" box.

You can spot the entire sound file, or just the spotted region:

Spot entire sound file - Places the entire sound file(s) on the track.
Spot only cued region - Trims the sound file(s) to the region that was spotted by the take's associated cue. If the take spans multiple cues, the region spans from the start of the first cue to the end of the last cue. If the spotted region extends
beyond the recorded region, only the portion of the recorded region that overlaps with the spotted region is used. If the spotted region does not overlap the recorded region, the entire sound file is placed on the track.

If you are spotting multiple takes at once, you can arrange them:

On adjacent tracks (vertically) - The regions are stacked vertically. If you choose Place at cursor, the head of each region is aligned at the cursor.
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On the same track (horizontally) - The regions are stacked horizontally. If you choose Place at cursor, the regions are arranged end to end.

Note: Newly spotted regions will overwrite any existing regions.
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Searching
You can control what records are displayed in the ADR Cue List and Take List windows by using the Search Window. The Search Window lets you set up search criteria. Search criteria are the attributes you use to determine what records are to be
displayed. You can search for cues and takes based on character, reel, and other search items.

Searching is always limited to records that are in the current reel set. If you want to search across the entire database, make the “All reel dupes” reel set active.

You can open the Search Window by selecting Search window (command-F) from the Windows menu. The Search Window will appear:

If the Search Window is already open, a checkmark will appear beside Search window. If the Search Window is behind another window or is inactive, select Search window to make the Search Window active. You can close the Search Window by
clicking on its close box, or typing command-W or command-period.

You can hide the additional search criteria to make the Search Window smaller. Click on the “Hide additional options” triangle to shrink the window. Click on it again to grow the window. When shrunk, the window only shows the character and reel lists:
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The “Show additional options” triangle text tells you how many additional options are currently checked, even though they are not displayed. Checked additional options are always included as search criteria, whether or not they are displayed.

The Search Window can search for both cues and takes. The figure above shows what the window looks like when searching for cues. To search for takes, change the popup at the top of the window to “takes.” The list of characters and reels remain
constant in both modes of the Search window. The additional search criteria in the bottom half of the window changes, however. The additional criteria for cues and takes are described in the sections below.

Once you’ve setup your search criteria, click on the Search button or type enter. The results of the search will appear in the ADR Cue List or Take List Window, depending on what type of records you are looking for. If the appropriate window is not
already open, it will be opened. If the window is already open, it will be brought to the front and the results of the search will be displayed.
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Searching by character and reel

You can search for both cues and takes using characters and reels. The left list in the Search Window displays all of the characters in the project. The right list displays all of the reels in the production. The leftmost column in each list is for checkmarks.
A checkmark next to an item means that that item is to be included in the search. For example, if there is a checkmark next to a character named Broom, then all of the cues for Broom will be found in the search. If you have several characters checked,
then all of the cues for all of the checked characters will be found in the search.

To place a checkmark next to an item in the list, click anywhere on the item. A checkmark will appear. To remove a checkmark, click again on the checked item and the checkmark will disappear. To check all items in a list, click on the “Check All” button
below the list. To uncheck all items, click on the “Check None” button. As a shortcut, you can option-click on an unchecked item and all items will become checked. Similarly, to remove all checkmarks from a list, option-click on a checked item and all
items will become unchecked.

Remember, you cannot modify a character or reel by double-clicking on it in the Search Window. You can only modify a character or reel in the Character List Window and Reel List Window, respectively.

Since a list is often longer than what will fit in the list’s window, remember to keep in mind that there may be some checked items that would not appear unless you scroll down. For your convenience, a status message appears below each list, telling you
how many items are currently checked, in case some are hidden at the moment:

To change reel sets, use the reel set popup above the reel list. Cues and takes that are currently displayed in the Cue and Take List windows and are also part of the new reel set will remain in the window. Cues and takes that are not a part of the new
reel set are removed from the display.
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Searching for cues

You can search for cues that belong to certain characters and reels by checking items in the character and reel lists in the top half of the window.

In the bottom half of the window are the additional search criteria for cues (if the “additional options” triangle is pointing down):

The additional options for cues are:

Join searches – This option lets you combine results from more than one search. After performing the first search, check this option and set the popup to one of the following:
Add result to currently displayed cues will add the results of your search to whatever is currently displayed in the ADR Cue List window (i.e. union).
Subtract result from currently displayed cues will subtract the results of your search from whatever is currently displayed in the ADR Cue List window (i.e. difference).
Search within currently displayed cues will perform the search within whatever is currently displayed in the ADR Cue List window (i.e. intersection).

If this option is not checked, the results of the search will replace whatever is currently displayed in the ADR Cue List window.
Cue name – You can search cues name fields by checking this option and choosing “is”, “is not”, “contains”, or “does not contain.” You can also use the wildcard character “@”, which substitutes for one or more characters in a string. Text
searches are case-insensitive.
Dialogue – You can search dialogue fields by checking this option and choosing “is”, “is not”, “contains”, or “does not contain.” You can also use the wildcard character “@”, which substitutes for one or more characters in a string. Text searches
are case-insensitive.
Notes – You can search the public notes and private notes fields by checking this option and choosing “is”, “is not”, “contains”, or “does not contain.” You can also use the wildcard character “@”, which substitutes for one or more characters in a
string. Text searches are case-insensitive.
Status – You can search for cues with certain statuses by checking this option, choosing the comparison operator (“<”, “<=”, “=”, “>=”, “>”. “<>”) and choosing the status level.
Priority – You can search for cues with certain priorities by checking this option, choosing the comparison operator (“<”, “<=”, “=”, “>=”, “>”. “<>”) and choosing the priority level.
Omitted – You can search for cues that are or are not omitted by checking this option and choosing “is” or “is not”.
Locked – You can search for cues that are or are not locked by checking this option and choosing “is” or “is not”.
Creation date – You can search for cues by creation date by checking this option and choosing “exactly”, "before", "after", "today", "yesterday", "this week", "this month", or "this year".
Last modification date – You can search for cues that have been modified since a certain date by checking this option and choosing “exactly”, "before", "after", "today", "yesterday", "this week", "this month", or "this year".

Note that the use of the character "&" in text fields may cause problems when searching.
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Searching for takes

You can search for takes that belong to certain characters and reels by checking items in the character and reel lists in the top half of the window.

In the bottom half of the window are the additional search criteria for takes (if the “additional options” triangle is pointing down):

The additional options for cues are:

Join searches – This option lets you combine results from more than one search. After performing the first search, check this option and set the popup to one of the following:
Add result to currently displayed takes will add the results of your search to whatever is currently displayed in the Take List window (i.e. union).
Subtract result from currently displayed takes will subtract the results of your search from whatever is currently displayed in the Take List window (i.e. difference).
Search within currently displayed takes will perform the search within whatever is currently displayed in the Take List window (i.e. intersection).

If this option is not checked, the results of the search will replace whatever is currently displayed in the Take List window.
Take name – You can search take name fields by checking this option and choosing “is”, “is not”, “contains”, or “does not contain.” You can also use the wildcard character “@”, which substitutes for one or more characters in a string. Text
searches are case-insensitive.
Dialogue – You can search dialogue fields by checking this option and choosing “is”, “is not”, “contains”, or “does not contain.” You can also use the wildcard character “@”, which substitutes for one or more characters in a string. Text searches
are case-insensitive.
Notes – You can search the recording notes fields by checking this option and choosing “is”, “is not”, “contains”, or “does not contain.” You can also use the wildcard character “@”, which substitutes for one or more characters in a string. Text
searches are case-insensitive.
Rating – You can search for takes with certain ratings by checking this option, choosing the comparison operator (“<”, “<=”, “=”, “>=”, “>”. “<>”) and choosing the rating level.
Circled – You can search for takes that are or are not circled by checking this option and choosing “is” or “is not”.
Has a sound file – You can search for takes that do or do not refer to sound files by checking this option and choosing “has a” or “has no”.
Has cues – You can search for takes that are or are not linked to cues by checking this option and choosing “has” or “has no”.
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How ADR Manager performs the search

When performing a search, ADR Manager does the following steps:

1. The search sets for each checked character are “ORed” together. In other words, all the records found for the first checked character are added to all the records found for the second checked character, etc. All of these sets combine to make
a final character set. If no characters are checked, then ADR Manager treats all characters as checked.

2. The search sets for each selected reel are “ORed” together. In other words, all the records found for the first checked reel are added to all the records found for the second checked reel. All the records found for the third checked reel are
added to the other two sets, etc. All of these sets combine to make a final reel set. If no reels are checked, then ADR Manager treats all reels in the current reel set as checked.

3. For each checked option in the Additional Options area, ADR Manager looks for all records that have that value. Specifically, for the cue name, dialogue, and notes boxes, cues are searched that have the entered keyword. For the status and
priority boxes, the program will apply the selected comparison operator when searching. For the omitted and locked options, the program will look for cues with those attributes.

4. Once the above steps are completed, ADR Manager performs a logical AND between the various sets of records. That is, only records that are in the final character set, as well as in the final reel set, as well as in the various search options
sets, are considered to be the result.

After all of the above steps are completed, the results are displayed, added, subtracted, or intersected with the records in the appropriate list window.
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Reports
Reports are used to print cue, take, reel, scene, and character information. For instance, you can print out all of the cues for an actor so the report can be used on an ADR recording stage. Or you can print out a line count table to show how many
cues each character has in each reel. Reports in ADR Manager are extremely flexible. For example, if a cue has a lot of dialogue, ADR Manager is smart enough to “push” any succeeding cues down on the page to make room for the dialogue,
rather than cut it off.

ADR Manager comes with several default reports, as well as the capability to design your own. The default reports have been specially designed for actors, editors, and mixers. You can adjust the minimum number of cues per page to fit your
printer’s settings. Click here for descriptions of the default reports.

When you create a new database, ADR Manager will automatically import default reports. You can also import a report at any time, including after the database has been created (see Importing a report from a record file for more information). In any
case it is important to understand that you can print only the reports that have been imported into your database file, not ones saved on disk.

If this is the first time you are using a particular report with a particular printer, you may need to customize the report to fit the printer’s settings. Default reports that ship with ADR Manager were created to print correctly on Slanecon Digital printers,
but since all printers differ slightly in their margins and page sizes, you will probably need to adjust the report to match your printer’s characteristics.

TIP: If you want to use your customized reports with future databases, create a folder called “My reports”, select the reports in the Report List window and export them as record files into the new folder. The next time you create a new
database, delete the default ones and import the custom reports from the “My reports” folder.
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Using reports

Reports are available for each type of record in an ADR Manager database. They can be for cues, takes, reels, scenes, characters, and keyboard shortcuts. For instance, an “Actor Cuesheet” report is for cues. A “Line Count Table” report is for
characters (think of what records are displayed on each row of the report).

To print a report, open the record list window that is associated with that report. Depending on the report, you may have to a search so that the records you want printed are displayed in the window. Choose Print... or Print Preview... under the File
menu. For instance, to print an “Actor Cuesheet”, make the ADR Cue List window active. For a “Line Count Table” report, make the Character List window active.
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Print previewing a report

To preview a report on the screen before you print it to your printer, bring the appropriate list window to the front. Make sure the records you want to preview are displayed in the window; you may want to perform a search first. Then select Print
Preview… under the File menu. For instance, if the ADR Cue List window is active the following dialog appears:

Choose whether you want to include all records that are currently displayed in the list window, or you just want to include the selected records in the window. Select which report(s) you want to preview by highlighting them in the reports list. Then click
OK.

The print preview window opens:

The first page of the report is created and displayed at a reduced size. Above the report, a toolbar contains buttons to Go To First Page (command-up arrow), Go To Previous Page (command-left arrow), Go To Next Page (command-right arrow), Go To
Last Page (command-down arrow), Print Current Page, and Cancel Previewing. When previewing, ADR Manager will only create one page of the report at a time. Click on the Go To Next Page button to see successive pages of the report.
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If you move the cursor over the report, it changes to a magnifying glass with a plus sign in it. You can zoom in to display the report at full size by clicking anywhere on the report. Use the scrollbars, or hold down the Option and Command keys and drag
the page using the mouse to see all parts of the page. When zoomed to full size, the cursor becomes a magnifying glass with a minus sign in it. Click on the report again to shrink it back to its reduced size.

If you selected more than one type of report to preview, then the next report will appear after you close or cancel the first report.
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Printing a report

To print a report, bring the appropriate list window to the front. Make sure the records you want to print out are displayed in the window; you may want to perform a search first. Then select Print… under the File menu. For example, if the ADR Cue List
window is active the following dialog appears:

Choose whether you want to print all of the records that are currently displayed in the list window, or you just want to print the selected records in the window. Select which report(s) you want to print by highlighting them in the reports list. Then click OK.

The standard Macintosh Print Job dialog will appear. Change any settings as appropriate and click Print.

If the report’s dimensions do not match your printer’s page size, a dialog will appear asking you if you want to adjust the report accordingly. See Adjusting the report margins for information on how to adjust a report to fit your printer’s settings.

ADR Manager will proceed to “spool” the report to disk, then send the print job to your printer.
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Displaying reports

Reports are displayed in the Report List window. Adding, duplicating, deleting, and modifying reports can be done only when the Report List Window is active. See List windows for a description of the buttons at the top of the window.

You can open this window by selecting Reports (command-M ) from the Windows menu. If the Report List Window is already open, a checkmark will appear beside Reports. If the Report List Window is behind another window or is inactive, select
Reports to make the Report List Window active. You can close the Report List Window by clicking on its close box, or typing command-W.

The Report List window displays the following columns. You can customize the window by clicking on the Customize button in the upper right corner.

Name – The name of the report. Reports do not have to have unique names.
Description – The first few lines of the report’s description.

Adding, deleting, duplicating, and modifying information about reports is done by selecting items in the Manage menu when the Report List window is active. When the window is active, the menu will look like this:

Use the menu items in this menu to add, duplicate, or delete reports.

Use the Import… and Export… menu items under the File menu to read and write the reports to disk as record files. This allows you to reuse reports for other productions in other database files (see Importing a report from a record file and Exporting a
report to a record file for more information).
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Creating reports

NOTE: Creating new reports from scratch requires some knowledge of 4th Dimension™ and Super Report Pro™. If you would like to create a custom report, it is better to duplicate a default report, then modify it to your liking (see Modifying
reports).

To create new reports, you must have the Report List Window open and active. Select Add report from the Manage menu, or type command-N. The following dialog will appear:

The types of records you can display in ADR Manager are cues, takes, characters, reels, or scenes. For instance, if you want to create a cue sheet report - that is, a report that displays the body section once for each cue selected - choose Cues, then
click OK. The Edit Report Window will appear with a blank report:

Please refer to Modifying reports for information on how to use this window.
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Deleting reports

To delete reports, you must have the Report List Window open and active. Click, shift-click, and/or command-click the reports you would like to delete. Select Delete selected reports from the Manage menu. Before ADR Manager deletes the
reports, however, it warns you that the operation is not undoable. If you proceed, be aware that you won’t be able to “undo” the deletion by choosing Undo from the Edit menu or typing command-Z.
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Duplicating reports

To duplicate reports, you must have the Report List Window open and active. Click, shift-click, and/or command-click the reports you would like to duplicate, then select Duplicate selected reports from the Manage menu.

For each duplicated report, a new report with the word “copy” appended to its name will be added to the report list. The new report will be an exact duplicate of the selected report.
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Modifying reports

You can modify existing reports by using the Modify Report Window. To open the Modify Report Window, double-click on a report in the Report List Window. The Modify Report Window appears:

You can change the report’s name or description by typing in the respective boxes.

You can change the way the report sorts its records by selecting an item in the sort method popup. Depending on what kind of record the report displays, you can choose from different sorting methods, as follows:
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Sorting records

For cues, you can sort the records by:

Reel, scene, start time, character
Reel, scene, start time, cue name
Character, reel, scene, start time
Reel, character, scene, start time

For takes, you can sort the records by:

Reel, take name, take number
Character, reel, cue start time, take number

For reels, you can sort the records by:

Reel number, dupe date
Version, reel number
LFOA, reel number
Dupe date, reel number

For scenes, you can sort the records by:

Reel number, start time
Continuity index

For characters, you can sort the records by:

Abbreviation
Character name
Actor name, character name
Recording info, character name
Type, character name
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Printing total number of pages in footer

If you wish to print the total number of pages in the report on each page, check the “Show total number of pages in footer” checkbox. When you select this option and print or print preview, ADR Manager will first generate the report offscreen in order
to calculate the total number of pages. This may take awhile, depending on the size of the report. The report will then print normally, with the total pages text printed at the bottom left corner of each page.
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Adjusting the report margins

Since every printer has slightly different margin settings, it is important that you click on Page Setup at least once before using a report. This will adjust the margins saved with the report. It may also give you the option of moving and/or resizing objects
in the report so that they are positioned appropriately, relative to the new margins (this feature is provided courtesy of SuperReport Pro™, which is the report generation tool used in ADR Manager).

To adjust the report, click on the Page Setup button. The page setup dialog for your printer will appear. Verify the settings in the page setup dialog and click OK. The red margin lines in the SuperReport Pro area will move to reflect the new printer
settings.

If the printer’s margins are different than the margins saved with the report, a dialog will appear:

This dialog gives you the option of adjusting object positions (such as fields and text), adjusting sections (such as Header and Body), and adjusting guides (such as the grid lines). Leave all 3 checkboxes checked. Based on the new red margin lines,
decide if you think it necessary to move the report objects. If the red margin lines have moved outward toward the edges of the page, you might decide not to adjust the object positions by clicking on the Don’t Adjust button. If, on the other hand, the red
margin lines have moved inward and some objects now appear to extend beyond the printable area of the page, you should probably click on the Adjust button.

In any case, check the position of all objects in the report after performing the Page Setup command. Make sure all objects are completely within the printable area. For those that aren’t, move or resize them as necessary.
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Adjusting the number of records per page

To adjust a report to fit your printer, follow these steps:

1. Create enough test records in the database to fill an entire page of the report. For example, if you are trying to adjust a Master Cuesheet report and you want to set the maximum to 15 cues per page, create at least 15 cues from the same reel.
Make sure they are showing in the ADR Cue List window. Be sure the test cues’ dialogue and notes fields contain little, if any, text. This guarantees that the dialogue and/or notes fields won’t make the body section of the report grow more than
the minimum, which would produce an inaccurate test case.

2. Open the report in the Modify Report window and click on the Page Setup button to adjust the margins of the report to fit your printer.
3. Print preview the test records using the report.
4. Count the number of test records that were actually printed on the page.
5. Open the report again in the Modify Report window. If the “Records per page” number does not match the actual number of records printed, click on the Change… button.

The following dialog will appear:

6. Enter the actual number of records printed in your test printout in the top field. Click on the Change button.
7. If an adjustment is needed, ADR Manager will automatically resize the Body section of the report, and move and/or resize objects within the Body section, to accommodate the new settings.
8. Save the newly adjusted report by clicking on the OK button in the Modify Report window.
9. You may want to export this report to disk so that you can use it next time without having to repeat these steps.
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Controlling spacing

You can control the spacing in a report by specifying the maximum number of records per page. This tells ADR Manager not to cram too many records on a page. In previous versions of ADR Manager, the only way to control spacing was to choose a
report with a preset maximum. Starting with ADR Manager 4, you can specify the number of records per page you wish by clicking on the Change… button under the Description field.

The number beside the Change… button shows how many records per page will print using the Slanecon Digital printer. However, this number may not be accurate because every printer has its own margin sizes and settings. Therefore, it is important
you check this setting with your own printer before actually using the report.
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The design area

The design area in the lower part of the Modify Report Window is called a SuperReport Pro™ area. This section briefly describes the main features you will use to modify your own reports. See the manual Designing Reports for ADR Manager for a
more complete description on all SuperReport Pro features (available from Slanecon Digital).

In all of the following sections, you must first click on an object to modify. Four small boxes will appear on each corner of the object. To affect multiple objects at once, shift-click on them or draw a rectangle around them by dragging the mouse
diagonally across the objects (starting in a blank area).
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Changing the look of text objects

To change the font of an object, select the object and choose from the font and size popups:

To change the font style of an object, click on a font style button:

To change the justification of an object, click on one of the justification buttons:
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Moving and resizing objects

To move the object, click in the middle of the object and drag it, or use the arrow keys to move it 1 pixel at a time. To move an object 10 pixels at a time, hold down the control key while using the arrow keys.

To resize the object, drag one of the four corners to change the object’s size, or you can use the arrow keys. Holding down the control and command keys and using the right and left arrows will move the right border of the object. Holding down the
command key and using the up and down arrows will move the bottom border. To resize an object by 10 pixels at a time, hold down the shift, control and command keys while using the arrow keys.

The keyboard shortcuts are listed below:

Move object 1 pixel right Right arrow
Move object 1 pixel left Left arrow
Move object 1 pixel up Up arrow
Move object 1 pixel down Down arrow
Move object 10 pixels right Shift-right arrow
Move object 10 pixels left Shift-left arrow
Move object 10 pixels up Shift-up arrow
Move object 10 pixels down Shift-down arrow
Grow width of object by 1 pixel Shift-command-right arrow
Shrink width of object by 1 pixel Shift-command-left arrow
Grow height of object by 1 pixel Command-down arrow
Shrink height of object by 1 pixel Command-up arrow
Grow width of object by 10 pixels Shift-control-right arrow
Shrink width of object by 10 pixels Shift-control-left arrow
Grow height of object by 10 pixels Shift-control-down arrow
Shrink height of object by 10 pixels Shift-control-up arrow

You can also set the exact position and size of an object by selecting the object then choosing Position object (shift-command-P) under the small Edit menu inside the report layout area.
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Changing an object’s appearance at print time

You can change the appearance of any object on a report at the time of printing. This can be useful, for instance, if you wanted some text to appear in bold if a certain condition existed. For example, you might want a cue’s “priority” field in a master
cuesheet to appear in red if the priority is above “Medium.” To do this, you’ll need to be familiar with editing an object’s script (see the Designing Reports for ADR Manager available from Slanecon Digital) as well as some understanding of the 4D
language.

The routines RPT_SCRIPT_SET_OBJ_FORMAT() and RPT_SCRIPT_CHOOSE_OBJ_FMT() are used to set the format of an object based on one or more conditions. They should be called from within an object’s script. For more information,
please contact Slanecon Digital. If you’re curious and adventurous, check out the script for the vtPriority object in the Body section of the “Master cuesheet w/status” report for an example of how to use this routine.

ADR Manager 5 User Manual 150



The default reports

Default reports are stored in the "ADR Manager/Default Reports/" folder and automatically imported into new databases, but you can import other reports at any time. Reports must be imported into your database in order to use them. To import a
report, use the Import command under the File menu when the Reports List window is active.

Reports can be used to print out any kind of record in the database. One of the default reports is called “Character List”, and it is used to print out the list of characters in your project. There are also reports for reels, which are used to print out the list
of reels in your project. Another set of reports have names that start with the words “Line Count Table”, and they print a line count table for various character/reel combinations. However, most of the default reports deal with cues, and are called cue
sheets. There are several types of cue sheets that come as defaults with ADR Manager: Actor, Director, Editor, Master, and Mixer.

The following sections contain a sample screen shot and brief description for each type of default report.
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Master Cue Sheet

The Master Cue Sheet is designed to be used before, during, and after recording the ADR. It displays all of the information about the cues in as condensed a format as possible. You can customize this report to add, delete, or modify various elements. A
sample Master Cue Sheet looks like this:

Scene headers stretch across the page to show where scenes begin.

A page break is inserted between each reel, and page numbering starts over after each break.
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Editor Cue Sheet

The Editor’s Cue Sheet is designed to be used by the ADR editor while on the recording stage. There is ample space provided for each cue so the editor can write handwritten notes about each take. You can customize this report to add more space for
handwritten notes or add, delete, or modify other elements. A sample Editor Cue Sheet looks like this:

Scene headers stretch across the page to show where scenes begin.

A page break is inserted between each reel/character combination, and page numbering starts over after each break.

The "Editor cuesheet takes" report lists all the takes for each cue.

ADR Manager 5 User Manual 153



Mixer Cue Sheet

The Mixer’s Cue Sheet is designed to be used by the recording engineer or mixer, and the recording engineer’s assistant. It features a 6 box grid for each cue. The boxes can be used by the mixer/assistant to note which track (i.e. on a multitrack
recorder) each take went on. You can customize this report to remove the grid box or add, delete, or modify other elements. A sample Mixer Cue Sheet looks like this:

Scene headers stretch across the page to show where scenes begin.

A page break is inserted between each reel/character combination, and page numbering starts over after each break.
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Actor Cue Sheet

The Actor’s Cue Sheet is designed to be used by the actor on the ADR recording stage. The text for the dialogue is in a bigger font, and the text that you entered in the Private Notes box in the New Cue Window or Modify Cue Window is not included.
This ensures that whatever you typed in the Private Notes box won’t be seen by the actor, such as a comment on the actor’s performance. You can customize this report to make the font for the dialogue bigger or add, delete, or modify other elements. A
sample Actor Cue Sheet looks like this:

Scene headers stretch across the page to show where scenes begin.

A page break is inserted between each reel/character combination, and page numbering starts over after each break.
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Character List

The Character List report displays the character names, their abbreviations, and the actor names. You can customize this report to change the spacing or add, delete, or modify other elements. A sample Character List looks like this:
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Reel List

The Reel List report displays information about the reels in the current reel set only. The report includes reel numbers, versions, dupe dates, start timecodes, LFOAs. and running times. To print preview or print the Reel List, make sure the Reel List
Window is active, then select Print preview or Print under the File menu. A sample Reel List looks like this:
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Reel History Table

The Reel History Table report displays all reel numbers, versions, dupe dates, and LFOAs in the database. To print preview or print the Reel History Table, make sure the Reel List Window is active, then select Print preview or Print under the File
menu. The “Print/Preview currently displayed/selected reels” radio buttons have no affect on this report. A sample Reel History Table looks like this:
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Line Count Table

The Line Count Table report displays a table. The column headings that run across the top of the table list the reel numbers in the current reel set, while the row headings that run down the left side of the table list the character names. In each cell in
the table, the number of cues for that character and reel is displayed. Total cues and estimated time to record each character’s lines run down the right side of the table, reel totals run across the bottom of the table, and a grand total of cues and
estimated time to record is displayed in the lower right corner of the table.

To print preview or print the Line Count Table, make sure the Character List Window is active, then select Print preview or Print under the File menu. The report will automatically adjust the number of columns according to the number of reels in the
current reel set. A sample Line Count Table looks like this:
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Keyboard shortcuts

The Keyboard Shortcuts report displays all of the shortcuts defined in the database. Use this report to print out your shortcuts so that you can refer to them easily while using ADR Manager.
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Conforming
ADR Manager will help you conform your reels if you have picture changes to incorporate. You can insert time, delete time, or remove a region and insert it elsewhere (in the same reel or a different reel, such as a rebalance).

Before conforming, check the current reel set to make sure you are conforming the proper dupe of the reel (the “All reel dupes” reel set cannot be the active set). If the dupe is the wrong one, modify the current reel set to include the proper one, or if
the dupe does not exist yet, create it (see Creating reel dupes for more information).

IMPORTANT NOTE: Changes made by conforming are NOT undoable. Therefore, it is a good idea to backup your database file before starting the conform process, and periodically while conforming.

Before conforming a reel, make sure all Modify windows are closed. Select the dupe you want to conform in the Reel List window and choose Conform selected dupe... under the Manage menu. The Conform window appears.
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Displaying a change list

To open the Change List for a particular reel dupe, highlight the desired reel in the Reel List window and select Conforming selected dupe... from the Manage menu, or click on the scissors button at the top of the Reel List window. The Change List
window appears:

The top of the Change List Window displays information about the previous reel dupe, if any, and the current reel dupe.

From row - The previous reel dupe's version, dupe date, and LFOA
To row - The current reel dupe's version, dupe date, and current LFOA
LFOA change - The difference between the previous dupe's LFOA and the current dupe's LFOA (the current dupe's LFOA will change as you perform each event in the list).
Conformed LFOA - What the current reel dupe's LFOA should be once all events in the list have been performed. When you have performed (or skipped) all events in the list, this value should match the LFOA change value.
Selected net change - The sum total of the highlighted events in the list. This is an easy way to do quick math on a block of events before you perform them. Unlike performing or skipping events, you can highlight non-consecutive events.

At the bottom of the Change List Window you can see how many change events are currently displayed in the window and how many are selected.

The Change List window displays the following columns as a default. You can customize the window by clicking on the Customize List button in the upper right corner.

Status – If the event has been performed, a checkmark appears. If the event has been skipped, an X appears, If the event has not been performed or skipped, this column is blank.
Event number – The event number.
Start and end time – The start and end time of the event
Duration – The duration of the event
Action – What type of event it is, such as "Insert shot" or "Move shots"
Note – User-entered note about the event

When the Change List Window is active, the Manage menu will change:
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Use these menu items to add, delete, or modify change events. You can also perform or skip change events.

Use the Customize List button to change the way events are sorted in the window.
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Creating change events

You can manually create change events, or import them from an Avid change note. To find out more about importing, see Importing and exporting. This section describes how to add change events manually.

To add a change event, you must have the Change List Window open and active. Select Add change event from the Manage menu, or type command-N. The following dialog will appear:

Enter the event type, start time, duration, end time, and note (optional). If you enter a duration after entering a start time, the end time is automatically calculated. If you enter an end time after entering a start time, the duration is automatically calculated.

You must always add an event to the end of the list. The default start time for new events is the time of the last event in the list.

Possible event types are:

Insert shots - You can specify how many shots you are inserting. This is for informational purposes only.
Insert shots from hold - You can specify how many shots you are inserting. This is for informational purposes only. You must choose which hold region will be inserted. The hold region must have been defined by a Delete shots and hold event
elsewhere, before you can create this event. You cannot change the Duration or End time fields, only the Start time field, since the hold region determines the event duration.
Insert leader
Lengthen head
Lengthen tail
Delete shots - You can specify how many shots you are deleting. This is for informational purposes only.
Delete shots and hold - You can specify how many shots you are deleting. This is for informational purposes only. You must also give the hold region a name so that it can be referred to by a corresponding "insert shots from hold" event later.
Trim head
Trim middle
Trim tail
Trim leader
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Modifying a change event

You can modify a change event by double-clicking on it in the Change List Window. Only change events that have not been done or skipped can be modified. The Modify Change Event Window opens:

Change the event’s type, start time, end time, duration, and note. If the event is an Insert shots or Delete shots event, you can change the number of shots (this field is for informational purposes only). If the event is an Insert shots from hold event,
you can choose a different hold region. If the event is a Delete shots and hold event, and an Insert shots from hold event is using the same hold region, then if you change the hold region name it will change in the corresponding Insert shots from
hold event.

Note: You cannot change the start time of an event so that it occurs before the previous event or after the next event in the change list.

If you want to save this change event and close the Modify Cue Window, click on OK. The Modify Change Event Window will close and the Change List Window will scroll so that the newly modified event appears in the middle of the window. Then the
event will be highlighted.

To save this event and modify the next event in the Change List without closing the window, click on OK & Next. The Change List window will scroll so that the newly modified event appears in the middle of the window.
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Deleting change events

To delete change events, highlight the events you would like to delete in the Change List window, then select Delete selected events from the Manage menu.

Before ADR Manager deletes the events it warns you that the operation is not undoable. If you proceed, be aware that you won’t be able to “undo” the delete by choosing Undo from the Edit menu or typing command-Z. Click OK to go ahead and
delete the selected events. If you click Cancel, the event(s) will not be deleted.

Note: You must delete change events from the end of a change list. You cannot delete events from the middle or beginning of the list.
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Performing change events

Once you've defined change events in a list, you can apply one or more of them to your cues, scenes, and reel, or skip them if they are deemed unnecessary.

To perform individual events, highlight them in the Change List window and choose Perform selected events under the Manage menu or click on the Perform button at the top of the Change List window.

Note: You must perform events in order from the beginning of the list to the end. You cannot ignore events or do them out of order. You must either perform them or skip them using the menu items or toolbar buttons.

As you perform each change event, the following things happen:

Cue times (start, end, and embedded times) will be modified
Scene times (start, end, and embedded times) will be modified
The reel LFOA will be adjusted. You can see what the current LFOA by looking at the LFOA Change field at the top of the Change List window.

You can also perform a net change, which allows you to lump together a block of successive change events and perform them as if they were one event. In this case, highlight the events by shift-clicking on them in the Change List window and
choose Perform net change under the Manage menu or click on the Perform net change button at the top of the Change List window.

If you decide an event should not be performed, you can skip the event by highlighting it and choosing Skip selected events under the Manage menu or click on the Skip button at the top of the Change List window. Remember, you cannot skip or
perform events out of order.
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Conforming scenarios

When ADR Manager performs a change event, it examines the cues that will be affected by the change. If the change occurs within a cue, the software will pose questions to you about how you want to modify the cue. This section describes the
possible scenarios.

NOTE: Both locked and unlocked cues are affected by a conform action.

If you are inserting time (either by entering a value or inserting a held region), then ADR Manager will do the following:

If the insertion point is before the cue, the cue is moved later in the reel with any embedded times updated automatically.
If the insertion point lies within the cue, the program will let you choose what to do.
If the insertion point is after the cue, the cue will not be affected.

If you are deleting time (and optionally holding the deleted region), then ADR Manager will do the following:

If the deletion end point is before the cue, the cue is moved earlier in the reel with any embedded times updated automatically.
If the deletion region overlaps the cue, the program will let you choose what to do, depending on whether the head of the cue overlaps the deletion region, the tail of the cue overlaps the deletion region, the deletion region is wholly within the
cue, or the cue is wholly within the deletion region.
If the deletion start point is after the cue, the cue will not be affected.
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If the insertion point is within the cue

If the insertion point lies within the cue, a dialog will come up describing the problem and giving you several options to choose from:

Information about the insertion region and the cue in question is on the left side of the window. If the cue is locked, a padlock icon will appear next to the cue.

On the right side of the window is a list of actions you can perform. Each action has a description as well as a graphical representation of what the action will do. Choose the appropriate action by clicking on its radio button, then click OK. The cue will be
affected by the action you choose, whether or not it is locked.

If you wish to abort the entire conforming process while in this dialog, click on the Stop conforming button. A warning alert will tell you how many cues are left that have not been conformed yet. If you proceed, all changes made to the reel for this Insert
Time will be discarded.

Note that if you choose to split a cue, the pieces may or may not remain in the "family tree" depending on whether the cue is recorded or not (see Cue Lineages). If the cue has not been recorded yet, the first piece remains in the family tree and the
other pieces start new trees; that is, they are no longer linked to the original ancestor and their cue names are erased. If the cue has been recorded, all pieces remain in the family tree. In this case, be aware that if you modify a descendant piece and
propagate the changes to the ancestor, the descendant's siblings will not get the change.
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If the head of the cue overlaps the delete region

If the head of the cue overlaps the delete region, the following dialog appears, describing the problem and giving you several options to choose from:

Information about the deletion region and the cue in question is on the left side of the window. If the cue is locked, a padlock icon will appear next to the cue.

On the right side of the window is a list of actions you can perform. Each action has a description as well as a graphical representation of what the action will do. Choose the appropriate action by clicking on its radio button, then click OK. The cue will be
affected by the action you choose, whether or not it is locked.

If you wish to abort the process while in this dialog, click on the Stop conforming button. A warning alert will tell you how many cues are left that have not been conformed yet. If you proceed, all changes made to the reel for this Insert Time will be
discarded.
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If the tail of the cue overlaps the delete region

If the tail end of the cue overlaps the delete region, the following dialog appears, describing the problem and giving you several options to choose from:

Information about the deletion region and the cue in question is on the left side of the window. If the cue is locked, a padlock icon will appear next to the cue.

On the right side of the window is a list of actions you can perform. Each action has a description as well as a graphical representation of what the action will do. Choose the appropriate action by clicking on its radio button, then click OK. The cue will be
affected by the action you choose, whether or not it is locked.

If you wish to abort the process while in this dialog, click on the Stop conforming button. A warning alert will tell you how many cues are left that have not been conformed yet. If you proceed, all changes made to the reel for this Insert Time will be
discarded.
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If the delete region is within the cue

If the delete region is contained completely within the cue, the following dialog appears, describing the problem and giving you several options to choose from:

Information about the deletion region and the cue in question is on the left side of the window. If the cue is locked, a padlock icon will appear next to the cue.

On the right side of the window is a list of actions you can perform. Each action has a description as well as a graphical representation of what the action will do. Choose the appropriate action by clicking on its radio button, then click OK. The cue will be
affected by the action you choose, whether or not it is locked.

If you wish to abort the process while in this dialog, click on the Stop conforming button. A warning alert will tell you how many cues are left that have not been conformed yet. If you proceed, all changes made to the reel for this Insert Time will be
discarded.

Note that if you choose to split a cue, the pieces may or may not remain in the "family tree" depending on whether the cue is recorded or not (see Cue Lineages). If the cue has not been recorded yet, the first piece remains in the family tree and the
other pieces start new trees; that is, they are no longer linked to the original ancestor and their cue names are erased. If the cue has been recorded, all pieces remain in the family tree. In this case, be aware that if you modify a descendant piece and
propagate the changes to the ancestor, the descendant's siblings will not get the change.
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If the cue is within the delete region

Cues that are completely within the deleted region will be deleted automatically, unless you checked the Ask before deleting cues checkbox in the Conform window. If you did check the checkbox, then the following dialog will appear for each cue to be
deleted:

Information about the deletion region and the cue in question is on the left side of the window. If the cue is locked, a padlock icon will appear next to the cue.

On the right side of the window is a list of actions you can perform. Each action has a description as well as a graphical representation of what the action will do. Choose the appropriate action by clicking on its radio button, then click OK. The cue will be
affected by the action you choose, whether or not it is locked.

If you wish to abort the process while in this dialog, click on the Stop conforming button. A warning alert will tell you how many cues are left that have not been conformed yet. If you proceed, all changes made to the reel for this Insert Time will be
discarded.
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Preferences
There are many preferences that control the behavior of the ADR Manager program. Preferences fall into two categories: global, which are saved in the database itself, and user preferences, which are saved in ~/Library/Preferences/ADR Manager
preferences. Global preferences control cue naming, take naming and reel versioning. User preferences include the last used search criteria, data entry settings, and external source (MIDI) settings.

Preferences are automatically saved when you do any one of the following:

make changes in the Preferences dialog
perform a search in the Search Window
customize a List Window
quit ADR Manager

There are some preferences that are saved automatically when you perform certain actions, and some that you can set explicitly. The preferences that are set automatically include:

The current reel set
List window customization
The last used search criteria in the Search Window

Preferences that you can set explicitly are accessed by choosing Preferences… under the Apple menu. The Preferences dialog appears with several tabs to choose from. The following sections describe the tabs.
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External sources preferences

There are several ways ADR Manager can communicate with external applications such as Pro Tools.

You can use apple scripts to grab the start and end times of a selected region.
You can use MIDI Machine Control (MMC) and MIDI Timecode (MTC). These protocols give you the ability to read the current time in Pro Tools and to control Pro Tools by sending play, stop, locate, and other commands. To setup MIDI
communication, you will need to change settings in Mac OS X, ADR Manager, and Pro Tools. The following sections describe how to setup MIDI communication for ADR Manager v4.5 and Pro Tools LE v.8.0.4 running on Mac OS X 10.6.
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Enabling MIDI in Mac OS X

Mac OS X has a built-in feature that allows programs to talk to one another using MIDI, but you have to specifically enable this feature using a utility that ships with the operating system.

1. Open the Audio MIDI Setup utility. The utility can be found in the /Application/Utilities folder.

Audio MIDI Setup utility in Mac OS X 10.6

2. Make sure the MIDI Studio window is showing by selecting Windows > Show MIDI Window. Double-click on IAC Driver and turn it online by checking the Device is online checkbox. Make sure at least one port is defined (the default is "IAC
Bus 1"), then click Apply.

After enabling MIDI communication on your computer, you must set up ADR Manager and the external MIDI application you wish to communicate with.
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Set up MIDI communication with Pro Tools

To set up MIDI communication between ADR Manager v5 and Pro Tools LE v10, follow these steps.

1. Enable MIDI inter-application communication using the Audio MIDI Setup utility (see Enabling MIDI in Mac OS X).
2. In ADR Manager, open the Edit > Preferences window. Turn on MIDI control by checking the Receive MTC and MMC from and Send MMC checkboxes. Select the port you defined in the Audio MIDI Setup utility (IAC Driver, IAC Bus 1) in both

popups.

Set the Receive Device ID to 1. Set the Send Device ID to 2.

3. In Pro Tools, open the Setup > Peripherals window and select the Synchronization tab. Set the MTC Reader Port and Generator Port to the ones you specified in the previous step (IAC Driver, IAC Bus 1).

4. Still in the Pro Tools Peripherals window, select the Machine Control tab.
Check Enable under the heading MIDI Machine Control (Master), and choose the port you defined in the Audio MIDI Setup Utility (IAC Driver, IAC Bus 1). This tells Pro Tools to send location information to ADR Manager. Enter 1 for the
ID. This number must match the Receive Device ID in step 2.
Check Enable under the heading MIDI Machine Control Remote (Slave). This tells Pro Tools to receive location information from ADR Manager. Enter 2 for the ID. This number must match the Send Device ID in step 2.
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Close the Peripherals window.

5. In Pro Tools, open the Setup > Preferences window and select the Synchronization tab. Check Machine Follows Edit Insertion/Scrub to send current location messages to ADR Manager when you move the cursor by clicking or scrubbing.
Check Machine Chases Memory Location if you also want to send messages when you locate using a memory location.

6. In Pro Tools, open the Transport window by choosing Windows > Transport. If the Synchronization area is not showing, display it by clicking on the menu in the upper right corner of the window and choosing Synchronization.

Turn on the Gen MTC button. This will send MIDI timecode continuously to ADR Manager while Pro Tools is playing. Otherwise timecode is only sent to ADR Manager when Pro Tools is stopped or when you move the Pro Tools cursor to a new
location.

7. Finally, you need to tell ADR Manager what type of MIDI timecode you will be sending and receiving from Pro Tools.This assures that ADR Manager will convert MIDI timecode to your database's timecode or feet and frames format properly. In
ADR Manager open the Preferences window and choose the External sources tab. In Pro Tools open the Session Setup window. Change the MIDI timecode format and rate popups in ADR Manager to match those in Pro Tools. For example,
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ADR Manager open the Preferences window and choose the External sources tab. In Pro Tools open the Session Setup window. Change the MIDI timecode format and rate popups in ADR Manager to match those in Pro Tools. For example,
if the Time Code Rate in Pro Tools is set to 23.976 fps, then set the popups in ADR Manager to be 24 frame timecode running at 23.976 fps.

 

 

Here is a summary diagram of the MIDI settings:
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Setting up your Pro Tools session

In addition to setting up the MIDI protocol as described above, you will also need to make sure your timecode and timeline settings in each of your Pro Tools sessions match the settings in ADR Manager.

A common workflow is to create a Pro Tools session for each reel in your film. Each session starts at a different timecode number, typically every hour on the hour, where the hour equals the reel number. Using this technique lets ADR Manager
differentiate between reels based on incoming timecode. The following steps explain how to set this up.

Make sure the session’s Timecode Rate and Feet+Frames Rate match the timecode and feet and frames settings in ADR Manager. For instance, if you set the Pro Tools timecode rate to 29.97 fps, be sure your MIDI timecode format in ADR
manager is set to Non drop timecode running at 29.97 fps as well. The format you choose for Time Code Rate in the Pro Tools Session Setup window is what gets sent to ADR Manager. Note that you can set ADR Manager’s incoming MIDI
timecode to be different than ADR Manager’s displayed timecode format.

Make sure the “Session Start” timecode matches the corresponding reel’s “Reel start” timecode number in ADR Manager. The “Reel start” timecode field is denoted with a special asterisk in the New Reel and Modify Reel windows (note that the
reel start is not the same as the reel FFOA).

Check the alignment of the Timecode and Feet+Frames timelines in your Pro Tools session by locating the cursor to the FFOA of the reel and displaying timecode and feet+frames in the “Main” and “Sub” location indicators at the top of the Edit
window, as shown:
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Compare these values in Pro Tools with the timecode and footage values for the reel’s FFOA in the New/Modify Reel window in ADR Manager. Adjust the values in ADR Manager to match your Pro Tools times. Or you can change the timelines in
Pro Tools by using the Redefine Current Timecode Position… and Redefine Current Feet+Frames Position… items under the Setup menu (refer to Pro Tools documentation for more info).

If you are having trouble getting the footages in ADR Manager to match the footages displayed in Pro Tools, try this:

First, double check to make sure you have followed the instructions in this chapter carefully.
Next, try changing your timecode rate in Pro Tools and ADR Manager to be 24 frame timecode running at 24 fps (if your feet and frames rate in Pro Tools and ADR Manager is 24 fps) or 24 frame timecode running at 23.976 fps (if your feet and
frames rate in Pro Tools and ADR Manager is 23.976 fps). This means that there will be a one-to-one correspondence between a frame of video and a frame of film. Then, even if the timecode burn-in on your digital video may not match Pro
Tools or ADR Manager (because it is non drop frame timecode, for instance), at least the footage burn-in should match.
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Data entry preferences

To setup preferences for the New Cue and Modify Cue windows, choose the Data entry tab:

If you want cue names to be automatically generated as you enter new cues in the New Cue Window, check the Autofill cue name checkbox. Once you enter a valid reel number, start time, and character name into the New Cue Window, ADR
Manager will automatically generate a cue name based on the renaming method you chose (see below). Remember, you can always rename cues later by using the rename feature.

You can have ADR Manager automatically fill in the end time for a cue in the New Cue Window when you enter a start time. This is useful if you don’t want to spot the end time of a cue every time. To turn this feature on, check the Autofill end time
checkbox. Then enter the duration you would like each new cue to have.

You can also have ADR Manager automatically round up the end time of a cue in the New Cue Window. The end time is rounded up to the next nearest whole second or foot, depending on your time format. To turn this feature on, check the Round up
end time checkbox.

If you type an invalid value in a time field, ADR Manager will display an error and disallow the value. If you’d rather have the application attempt to correct the value by recalculating subfields, check the Normalize time values preference. For example, if
you are spotting in non drop timecode and you enter 01:00:00:45, ADR Manager would display an error. If this preference were turned on, the value would be replaced with 01:00:01:15 and no error would be posted.
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Cue naming preferences

You can customize how ADR Manager generates unique cue names. Click on the Cue naming tab:

Add fields to your cue naming convention by putting checkmarks next to the ones you want to include. Highlight a field to set its options. You can also specify how the counter is generated. See the following sections for explanations of the options in this
pane.

IMPORTANT NOTE
Cue name settings are applied only to cue names created in the future. ADR Manager will not go back and automatically change existing cue names in your database (but you can manually rename them yourself; see Renaming cues).
Therefore, it is usually a good idea to spend some time before you start naming cues and think about the requirements of your project, then set the preferences carefully.

ALSO NOTE
ADR Manager will use the cue naming convention when importing cues from a file. Imported cue names are parsed according to the convention you have set up here.

ADR Manager 5 User Manual 184



Cue name fields

Click to the left of the field name to include it as part of a cue name. A checkmark appears next to the field name. The fields that you can include in a cue name are:

Character abbreviation
Reel number
Scene name
Counter – This field is required in all cue names

Currently, you cannot change the order in which fields appear in a cue name.
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Cue name field options

If you highlight a field name in the list on the left side of the Cue Naming tab, the options in the right side of the window display the field's options.

Field options are:

Field length - You can choose to make certain fields a dynamic length or a fixed length. If a field is fixed length, then zeros will be added to the beginning of a field’s value if the value is too short to fill the field. For instance, if you choose to make the
reel number a fixed length field of 3 digits, and a cue’s reel number is “6”, then the reel number component of the cue’s name will be “006.” If you don’t impose a fixed length to a field, then the field will have a dynamic length.

Click on the radio buttons next to “Fixed length field” or “Dynamic length field” to choose what field length you want. If you choose “Fixed length field”, enter the number of digits you want displayed.

Delimiter - Each field can have a trailing delimiter. This can be useful to differentiate where one field ends and the next one starts. For instance, you could have an underscore “_” between the character abbreviation and reel number so that you know
where a character abbreviation ends and the reel number begins. This could be particularly helpful if a character abbreviation ends with a number.

To add a delimiter to a field, put a checkmark in the “Use delimiter after field” checkbox and enter the delimiter in the box beside it. You can enter as much text as you like, but be careful not to use text that may be a part of another field, such as a
character abbreviation. It is usually best to use delimiters that consist of a single punctuation character, such as an underscore.
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Counter options

The “Counter” field is required in all cue names and is simply a number (and possibly a letter, if you want ordered counters - see below). This number helps to create a unique name for each cue. ADR Manager manages this counter internally, but you
can control how the counter increments using the options in the Cue Naming tab:

These options let you specify the naming "domain." When creating a new cue name, ADR Manager gathers named cues with matching subcomponents, such as character abbreviation, and creates a naming domain. Then within that domain, ADR
Manager looks at the counter numbers in use and chooses a new counter number. In other words, the counter number distinguishes cues with the same subcomponents. The checkboxes in this section let you designate which subcomponents should be
considered.

Counter resets for each character - If you want to have a separate counter for each character, check the “Counter resets for each character” checkbox. This means that when ADR Manager is renaming a cue, it examines what character it belongs to.
It then looks at all named cues for that character, determines the highest counter number among them, and increments the number by 1.

Counter resets for each reel/scene - If you want to have a separate counter for each reel or scene, check the “Counter resets for each reel/scene” checkbox. If the reel number is included in the cue name but not the scene name, then the reel is used.
If the scene name is included in the cue name but not the reel number, then the scene is used. If both the reel number and scene name are included in the cue name, then the scene is used. This means that when ADR Manager renames a cue, it
examines what reel or scene it belongs to. It then looks at all named cues for that reel/scene, determines the highest counter number among them, and increments the number by 1.

If you want a separate counter for each character and reel/scene combination, check both boxes. This means that when ADR Manager renames a cue, it examines what reel/scene and character it belongs to. It then looks at all named cues for that
reel/scene and character, and determines a new unique counter among them.

Ordered counter numbers - You can also ask ADR Manager to try to keep counter numbers ordered according to cue start time by using letter suffixes. In this case, ADR Manager does not find the highest counter within the naming "domain." Instead,
it attempts to number cues based on their chronological order in the reel or scene. Letter suffixes can be used to differentiate two cues that would otherwise have the same counter number. For example, if you have two cues called BB101 and BB102
and add a new cue whose start time is between them, then it will be impossible to generate a new cue name whose counter is between them (ADR Manager uses only whole integers for counter numbers). By adding the letter “A” to the new cue’s name,
this solves the problem and the new cue is given the name BB101A.
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Counter options example

To demonstrate what affect the counter options have on cue names, suppose we want to name the following cues for characters Bob and Jim:

Assume we have included the character abbreviation, reel number and counter in our cue naming convention. The following examples illustrate what cue names would be generated, depending on the counter options selected.
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Resetting by character only

Note that the counter did not care what reel a cue was in, only which character it was in. Numbering started over for each character, but continued incrementing across reel boundaries.
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Resetting by reel/scene only

Note that the counter did not care what character a cue was in, only which reel it was in. Numbering started over for each reel and continued incrementing, regardless of which character each cue was in.
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Resetting by both character and reel/scene

Numbering started over for each character within in each reel. This is the most commonly used naming convention, because it shows at a glance that a cue is the Nth spotted cue for a particular character in a particular reel.
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Cue status preferences

To control features dealing with reel versioning and cue statuses, click on the Cue status tab:

Reel dupes can be distinguished by version or dupe date. In several places throughout ADR Manager, such as the Modify Cue window, you can select from a list of all the dupes for a reel. This preference designates how multiple dupes of the same
reel are differentiated.

If you choose to differentiate reels by version, then each time you create a new dupe of a reel you will be forced to give it a unique version number. Note that a blank string is considered a version number, so there can only be one dupe with a blank or
empty version. If there are already two or more dupes of a reel with the same version, an error message will appear if you try to set this preference. If you choose dupe date, reel dupes are distinguished by date (ADR Manager always requires you to
give a unique date for each new dupe anyway).

You can have ADR Manager automatically lock cues when certain attributes are set by checking the appropriate checkboxes under “Auto-lock cues” message. You cannot manually change any fields in the Modify Cue window for a locked cue (see
Locking cues for more information). Choose which attributes you want to use as the “threshold” for locking. For example, if you want to lock cues once they’ve been recorded, set the popup to “Recorded” and check the box. The next time you set the
status of a cue to recorded, ADR Manager will automatically lock it.

When you create a new dupe of a reel, ADR Manager keeps copies of each cue in the reel in both the old and new reel dupes (see Cue lineage). When you make a change to a cue, the changes are automatically propagated to the cue’s copies in
later reel dupes (except for changes to text fields with embedded times). However, ADR Manager gives you the choice whether you want to propagate the changes to copies in earlier dupes. You can choose to always update ancestor cues, never
update them, or ask each time. For example, you may not want to modify a cue in an earlier dupe if you want to keep a sort of “paper trail” of the cue . In this case, you would choose "never." The fields that may or may not be propagated to ancestors
are:

Character
Dialogue
Public notes
Private notes
Omitted status
Cue status
Priority
Locked status

Note that cue name changes are always propagated, regardless of this setting.
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Take naming preferences

Takes can span multiple cues. For this reason, take names contain information about all the cues they span. Take naming conventions are rules that are added to cue naming conventions to create names for takes. You can set the take naming
convensions in the Take Naming tab of the Preferences window:

Take names are similar to cue names, except that they allow for ranges of counter numbers as well. A take name begins with the full name of the first cue it includes (ordered by start time). For any other cues that the take spans, only the counter
number is used. Note that all cues for a given take must be from the same character and reel.

IMPORTANT NOTE
It is usually a good idea to make sure that your take naming convention does not conflict with your cue naming convention. For instance, you should not use the same delimiters for take naming as you do for cue naming fields.

You can specify what delimiters you want to use between consecutive and non-consecutive cue name counters. It is usually best to use delimiters that consist of a single punctuation character, such as an underscore or comma.

Consecutive cue name delimiter– This is the delimiter inserted between consecutive cue name counter numbers. If it is more than one character, it cannot start with an alphanumeric character.
Non-consecutive cue name delimiter – This is the delimiter inserted between non-consecutive cue name counter numbers. If it is more than one character, it cannot start with an alphanumeric character.
Take number – This is the delimiter that is inserted before the take number.
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Updating and backup preferences

The General tab lets you set backup and auto-update preferences. The following sections describe these features in more detail.
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Backup preferences

ADR Manager provides a full featured backup system via 4th Dimension, the database engine that ADR Manager is based on. This section briefly describes the backup preferences you should use.

NOTE
See Chapter 22 for a more complete discussion of 4th Dimension’s backup and restore mechanism.

To access the backup preferences, click on the General tab of the Preferences window:

There are 4 groups of backup settings to choose from. Click on a button to open a window for that group. A 4th Dimension panel opens within the window, displaying the settings for that group.

WARNING
It is possible to change settings in other panels in this window, but do not do so unless you are familiar with the 4th Dimension system! Please limit your changes to only those panels that are accessible from the buttons in the ADR
Manager Preferences window.
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Configuration panel

The Configuration panel is used to specify what you want backed up. You can backup the data in your datafile, other documents, and a log file - all in one file that can be restored later.

Here are the recommended settings for each area in the panel:

Content - Check Data File to backup your datafile. Uncheck Structure File and User Structure File. Those refer to the application itself, which you don’t need to back up.
Backup File Destination Folder - This area lets you define the location where backup files are stored.
Log Management - You can choose to use a “Log File” when backing up. A log file stores every action done in a database, such as a record add, record delete and record modification. The log file’s pathname is stored in the database, so if you
move the database to another computer, the pathname will become invalid. In this case, you will need to find the log file again or create a new one when you open the database on the new computer. Click here for more details.
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Scheduling panel

The Scheduling panel is used to schedule automatic backups.

You can have ADR Manager backup automatically at specified times using these settings.
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Backup panel

The Backup panel is used to control how a backup is performed.

Here are the recommended settings for each area in the panel:

General Settings – This section lets you control what happens when the backup starts:
To recycle backup archives, check the Keep only the last N backup files and enter the number of archives you want to keep. The first archive will deleted when you backup on the N + 1 time, the second archive will be delete on the N + 2
backup time, etc.
Checking or unchecking Backup only if the data file has been modified will make no difference - the datafile is changed every time you open it anyway.
You can choose to delete the oldest backup file before or after the backup operation by changing the popup.
The If backup fails radio buttons refer to whether or not a long operation is currently running (such as changing the time format of a large database) at the time of backup. In this case, you can choose whether you want the backup to wait
or retry.

Archive
If you want to break up your data file into segments so they will fit on a CD, DVD, etc., you can a specify segment size. During the restore process, the segments will be fused together automatically.
By default, the archive will be compressed. You can specify what type of compression algorithm is used.
The interlacing rate consists of storing data in non-adjacent sectors in order to speed up their read time. However, the storage phase is slower.
Redundancy allows securing data present in a file by repeating the same information several times. The higher the redundancy rate, the better the file security; however, storage is slow and the file size is large.

Automatic restore - Data can be lost or corrupted because of an unplanned stoppage such as a power outage, or defective sectors on the disk such as a virus. The program will automatically perform a self-check when you relaunch it, without
any intervention required from the user. You can control how the database is restored if a problem is found.

If you have done backups before, you can have last backup restored
If you have saved a log file with your backups, you can recover any actions that may have been lost before they were saved to disk.
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Updating preferences

You can use ADR Manager to check for updates to the application itself.

To automatically check each time ADR Manager is launched, check the Automatically check for software updates box. You can manually check to see if there are any updates by clicking the Check now button. If there is no network connection when
ADR Manager attempts to check for updates, the check is skipped.

If an update is found, a window is displayed showing what version is available and what new features or bug fixes it contains. You can then click on the Go to website… button to launch your web browser, go to the Slanecon Digital support page, and
download the installer. You should quit ADR Manager before installing the new version.
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Keyboard shortcuts
ADR Manager gives you the ability to perform actions based on keyboard shortcuts you define. You can add and delete text from fields, send transport control commands, and change field values using shortcuts. Default shortcuts are created
automatically when you make a new database, but you can add, delete, or modify them at any time. Shortcuts are saved in the database, so if you move the database to another computer with a different keyboard layout, you may need to modify the
keys to press for the shortcut. You can print out a list of shortcuts to use as a reference while using ADR Manager (see The default reports).

TIP
If you want to use your customized shortcuts with databases you create in the future, select them all in the Keyboard Shortcut List window and export them to a XML file. The next time you create a new database, delete the default ones
and import the custom ones from the XML file.
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Displaying shortcuts

Displaying shortcuts is done in the Keyboard Shortcut List Window:

You can open this window by selecting Keyboard shortcuts from the Windows menu. If the Keyboard Shortcut List Window is already open, a checkmark will appear beside Keyboard shortcuts. If the Keyboard Shortcut List Window is behind
another window or is inactive, select Keyboard shortcuts to make the Keyboard Shortcut List Window active. You can close the Keyboard Shortcut List Window by clicking on its close box, or typing command-W.

The Keyboard Shortcut List window displays the following columns, as a default. You can customize the window by clicking on the Customize button in the upper right corner.

When pressed in (Context) – This column shows what window needs to be open and frontmost in order for the shortcut to work.
Keystroke – The key(s) that need to be pressed in order to invoke the shortcut.
Description – A description of the action that will be performed.

Adding, deleting, and modifying shortcuts is via the Manage menu when the Keyboard Shortcut List window is active, or using the toolbar buttons at the top of the Keyboard Shortcut List window. When the List window is active, the Manage menu looks
like this:

Use these menu items to add, duplicate, modify, and delete shortcuts.
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Creating shortcuts

To create shortcuts, you must have the Keyboard Shortcut List Window open and active. Select Add shortcut from the Manage menu, click on the toolbar button, or type command-N. The following dialog will appear:

You can always change these fields later.

Description – A description of the shortcut. This is automatically filled in when you change any of the other fields in the window, but you can re-enter your own description if you like.
Enabled – Controls whether the shortcut is active or not.
Context – The context field (labeled “When in”) lets you choose in which context the shortcut is available. The context is the window in which you can invoke the shortcut. If the window is not open or in the background, then pressing the shortcut
has no effect.
Keystroke – You can set what keystroke to use by pressing the “Set…” button next to the keystroke area. You must assign a keystroke in order to save the shortcut. Be aware that certain key combinations may also trigger other actions in
addition to the shortcut you’ve defined. For instance, in the default Mac OS X 10.5 installation, pressing command-space in any application opens Spotlight. If you define an ADR Manager shortcut with command-space, then anytime you invoke
the shortcut, Spotlight will also appear. It is up to the user to find a key combination that doesn’t conflict with other system or application shortcuts.
Action – Once you choose the context, the action popup changes to show what kinds of actions your shortcut can take. For contexts within ADR Manager, you can choose to:

Insert text into field – Inserts text into the field selected under the “Field” popup. You can direct the text into a specific field, or choose “current field.” You specify what text to enter in the “Text to enter” field. If you choose a specific field,
the shortcut will append the text into the field without moving the cursor, if the cursor is in another field in the window. If you choose “current field”, the text is entered at the current cursor location (replacing the currently highlighted text, if
any). For instance, say you’ve defined a shortcut that inserts the word “Offscreen” into the Notes field in the New or Modify Cue window. If the cursor is in the Reel Number field when you invoke the shortcut, the word “Offscreen” is
appended to the Notes field and the cursor remains in the Reel Number field.
Delete text from field – Finds the first occurrence of the text specified in “Text to delete” and removes it from the field specified in the “from” popup. If the cursor is not in the target field, it remains in its current location.
Increment field – Increments a popup or toggles a checkbox. Note that some fields increment in the opposite direction to what you might expect – you should experiment to make sure the field changes the way you want.
Decrement field – Decrements a popup or toggles a checkbox. Note that some fields decrement in the opposite direction to what you might expect – you should experiment to make sure the field changes the way you want.
Put current transport time – This will grab the current time displayed in the Transport Control window (although the window need not be open) and stuff it into the specified field. If the window you are stuffing the value into also displays a
reel number, the reel number will change to match the context displayed in the Transport Control window.
Tell transport to play/stop/locate/fast forward/fast rewind – Effectively pushes a button on the Transport Control window to send the specified MIDI message. You must have setup the proper external communication preferences (see
Controlling Pro Tools from ADR Manager) for this to work. For the “locate” message, you can choose which target field you want to use as the location value, or you can choose “current selection” for cases when you’ve highlighted text in a
field and you want the Transport Control to locate to that position. If no text is highlighted, then whatever value is in the “Locate” field in the Transport Control window is used.
Go to next / previous tab – This command is used in windows that contain multiple tabbed pages. Normally you would have to click on the tab to go to another page. This command lets you traverse the tabbed pages without having to
click on them.

Target – The “recipient” of the shortcut action. The list of targets consists of popup of fields that can be found in the shortcut’s context window.
Text to enter - The text to enter, in the case of an "Insert text into field" action.
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Deleting shortcuts

To delete shortcuts, you must have the Keyboard Shortcut List Window open and active. Click, shift-click, and/or command-click the shortcuts you would like to delete, then choose Delete selected shortcuts from the Manage menu. Before ADR
Manager deletes the shortcuts, however, it warns you that the operation is not undoable. If you proceed, be aware that you won’t be able to “undo” the delete by choosing Undo from the Edit menu or typing command-Z.

ADR Manager 5 User Manual 204



Modifying shortcuts

To modify a shortcut, simply double-click on it in the Keyboard Shortcut List Window. The Modify Shortcut Window appears:

Change the shortcut fields then click OK, or click Cancel if you decide you don’t want to change anything.

See Creating shortcuts for an explanation of the fields in this window.
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Transport Control
The Transport Control window lets you send and receive information from external applications such as Pro Tools. It displays the current time that can be used in various windows throughout ADR Manager. You must make sure ADR Manager and Pro
Tools are setup to communicate with one another to enable the features in the Transport Control window.

NOTE
Throughout this manual, we refer to Pro Tools when talking about an external application, but any application that supports the MIDI protocol should work as well.

The current time for ADR Manager is displayed in green numbers in the main counter window. This time is available throughout the ADR Manager application to enter into time or text fields, whether or not the Transport Control window is open. You can
enter it using menu commands, keyboard shortcuts, or applescripts. See Entering information for a cue for an example.

To open the Transport Control window, select Transport control under the Windows menu, or type command-1. The Transport Control window opens:

ADR Manager understands where Pro Tools’ current time position is by listening to MIDI timecode. If you are spotting in feet and frames, however, the timecode can only be converted correctly if ADR Manager knows what context the timecode is in. A
time value’s context is the reel that the time value is within. The reel’s start timecode must be subtracted out of the incoming timecode value before it is converted to the correct footage. For this reason, it is important that you set the reel start field for
each reel correctly (see Creating reels).

The Transport Control window displays the following:

You can choose the current context by selecting a reel in the current reel set in the Context popup.
If each reel in the current reel set has a unique start timecode you can have ADR Manager automatically determine the context by checking the Auto-select checkbox. The reel number field in the New Cue and New Scene windows will be filled
with this reel number when you grab a start time (see Grabbing start and end times).
To confirm what timecode ADR Manager is currently receiving, the incoming MIDI timecode is displayed in the upper right corner of the window.
The converted current time of the Pro Tools “playhead” (in the current ADR Manager time format) is displayed in a large green counter on a black background.
Transport controls at the bottom of the window are used to control the motion of the Pro Tools session. They are, from left to right: fast rewind, stop, play, and fast forward.
The current incoming MIDI Timecode (MTC) is displayed for reference only. This is displayed in the MIDI timecode format you selected in the Preferences > External Sources tab, whether or not you are currently displaying timecode.
A Locate button and time field. Enter the time value that you wish Pro Tools to locate to, then press the Locate button. If you select a cue in the ADR Cue List window or a scene in the Scene List window, the start time of the cue or scene will
automatically be stuffed into the Locate time field for convenience.
The Preroll checkbox and time field lets you set a preroll when locating.

Note that several functions in the Transport Control window can be accessed using keyboard shortcuts, even when the window is closed. See Creating shortcuts for more information.
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Working with other applications
ADR Manager has been designed to work with other applications, such as Avid’s Pro Tools, to make spotting and editing ADR smoother and faster.

There are several ways to interact with other applications:

Grab times using MIDI from another program such as Pro Tools
Grab times using AppleScript
Control another program's transport using MIDI, such as Pro Tools
Build a library of ADR and production sound files
Display sound files in the Finder
Place individual takes in a Pro Tools session
Import regions from a Pro Tools session as cues or scenes
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Grabbing time values using MIDI

You can grab time values from another MIDI-compatible application such as Pro Tools. ADR Manager can grab times, convert them into the proper time format, and insert them into time fields for cues and scenes. To allow ADR Manager to
communicate with Pro Tools, you must first setup the proper MIDI connections by following the instructions in External sources.

You can also grab time values using Applescripts.
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Grabbing time values using AppleScripts

The standard installation of ADR Manager provides special AppleScripts that can be used to grab the start and end times of a selection in Pro Tools. They will copy those values to the clipboard and then paste them into the start and end time fields
of the currently active ADR Manager edit window. One useful AppleScript is called “Set start end times” and can be found in /Applications/ADR Manager/Scripts/. The values are copied into the start and end time fields of ADR Manager’s New Cue
window, Modify Cue window, New Scene window, or Modify Scene window, in order of priority. If none of these windows are open, the New Cue window is opened and the cue’s time fields are filled.

You can trigger scripts from within Pro Tools using a shortcut utility for the Macintosh, such as QuicKeys or iKey.

You can also grab times using MIDI.
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Controlling another application

You can control the transport of another MIDI-compatible application such as Pro Tools. To allow ADR Manager to communicate with Pro Tools, you must first setup the proper MIDI connections by following the instructions in External sources
preferences. You can then use the Transport Control window to send play, stop, and locate commands to Pro Tools.
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Building a library of takes

You can build a library of takes by importing Pro Tools sessions that represent bins on an Avid. You can include ADR takes as well as production dialogue and other sound files. See Creating a library from Avid media for more information and
instructions on how to deal with media generated from an Avid.

You can also scan folders on disk to build the take library. See Importing takes via a folder scan for more information.
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Displaying sounds in the Finder

Once you’ve linked sound file(s) to a take, you can display the sound files in the Finder by selecting the take in the Take List window and choosing Show in Finder under the Manage menu.
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Placing takes in Pro Tools

ADR Manager gives you the ability to drop selected takes into a Pro Tools session. You must have the session open and the cursor positioned at the time and track where you want the take(s) placed. See Spotting into Pro Tools for more
information.
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Import Pro Tools session text file

You can import a text file that has been exported from Pro Tools. You can then choose which tracks you want to import, and decide how to take text in the track and region names and put it in cue or scene fields in the database. See Importing cues
from a Pro Tools session text file and Importing scenes from a Pro Tools session text file for more info.
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Importing and exporting
ADR Manager can import and export data in a variety of formats, with a tremendous amount of flexibility. For instance, you can import from a tab-delimited text file whose columns are in an arbitrary order. Or you can import incomplete data and
merge it into existing records. You can also move data from one database to another, keeping the “links” between records intact.

See the table of file formats you can import and export to. You can also learn about importing and exporting in this chapter.

Note: After importing, some records may be incomplete or cause inconsistencies with other records. You can check for these issues by running diagnostics on the database.
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File formats

The following table shows you which records you can import and export and in what file formats:

Table Import file format Export file format
Projects (multiple tables) Text file (XML) Text file (XML)
Cues Text file (tab/return delimited)

Text file (XML)
Text file (Pro Tools session)

Text file (tab/return delimited)
Text file (XML)
Text file (ADRStudio v3 format)
Text file (CMX format)
Text file (Soundmaster format)

Characters Text file (tab/return delimited)
Text file (XML)

Text file (tab/return delimited)
Text file (XML)

Reels Text file (tab/return delimited)
Text file (XML)

Text file (tab/return delimited)
Text file (XML)

Report Record file Record file
Scenes Text file (tab/return delimited)

Text file (XML)
Text file (Pro Tools session)

Text file (tab/return delimited)
Text file (XML)

Takes Text file (tab/return delimited)
Text file (XML)
Text file (Pro Tools session)
Folder scan

Text file (tab/return delimited)
Text file (XML)

Keyboard shortcuts Text file (XML) Text file (XML)

A text file is a file that can be opened and modified using a word processor, such as TextEdit or Microsoft Word. An XML file is a text file that is formatted to make the transfer of information between computer programs more accurate. It is the
preferred method of transferring data between ADR Manager and other generic database applications. The tab/return delimited format outputs individual fields of a record separated by tabs, and individual records are separated by carriage returns.
If you intend to modify the text file and then import it into another program, such as Microsoft Excel™ or Filemaker Pro™, be sure you don’t add or delete any tabs or carriage returns in the file. Other text file formats include the Pro Tools 5.1
session format, which can be exported from within Pro Tools by choosing “Export session as text…” under the “File” menu.

A record file is a special format known only to the ADR Manager program. You cannot open up and modify a record file using a word processor, like you could with a text file.

You can create a specially formatted text file for use with ADRStudio™. You can look at the ADRStudio file with a word processor or property list editor, but we recommend you don’t modify anything.

A CMX text file can be exported and used to place ADR cues recorded to an old dupe date but placed in a later dupe date.

A Soundmaster™ text file is used by compatible machines on recording stages to import cue information for a recording session. A Soundmaster file is a text file with a special format. After exporting, you can look at the Soundmaster file with a word
processor, but we recommend you don’t modify anything. Certain information can get truncated when exporting to a Soundmaster file, such as long cue names and long notes.
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Preparing to import

To import records, make sure the window you want to import into is active. For instance, to import cues make sure the ADR Cue List Window is active. To import reports, make sure the Report List Window is active. Or to import characters, make sure
the Character List Window is active. Then choose the Import under the File menu.

A dialog will appear asking you to choose an import format:

Choose the format and click OK. An Open File dialog will appear. Select the file that you wish to import and click on Open.

TIP: When importing cues, takes and scenes, make sure you have the correct reel set active before you start the import so that imported records are brought into the proper reel dupes.

If the import file has more than one table (i.e. an XML file containing an entire database), the Choose Import Tables window will appear, asking you to confirm which tables you want to import. If you are importing only one table, such as importing cues
into the ADR Cue List window, then the Import Options dialog will appear. See Importing tab delimited files, Importing XML files, or Importing a Pro Tools session text file for more information about importing different types of files.
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Importing tab-delimited files

If you are importing from a tab delimited text file, the following dialog appears:

You can save the import settings to a disk file by clicking on the Save... button, and reload them at a later date by clicking on the Load... button.

The Fields tab lets you specify which fields are to be imported.

The popup at the top of the tab area shows what table you will be importing into.

Choose fields to import by checking them. Drag the order of fields to change the order they appear in the import file.

If ADR Manager recognizes a row of column headers in the import file, it will automatically assign columns to each field. Otherwise, you will need to select which column will be imported into which field by clicking on the popup menu in each row of the
Import from column.

WARNING: Be careful when importing and exporting ID fields (such as "ID", "Reel ID", "Scene ID", etc). Every record in the database is given a unique ID which you can import and export. This allows you to unambiguously match data in
an import file to records in the database, rather than relying on other fields in the import file such as the name of the record. In general you should only import or export an ID field to and from the same database, never between different
databases. The only time you should import IDs from another database is if you are importing an XML file that contains multiple tables, such as importing a file when creating a project. In this case, records within the import file rely on IDs to
link to one another.

As you build the Fields to import list, you can go to the Preview tab to see if the fields line up correctly with the columns in the import file.

The Options tab lets you set the following options:
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Skip the first N rows – If there is text at the beginning of the file that you would like to skip, specify how many rows you want to skip. For instance, if the text file contains column headers, skip the first "1" rows.
Carriage return substitution - When importing fields that contain carriage returns, such as a cue’s dialogue field, it is important to replace the carriage return with some other character. Here is where you designate the character you want as a
substitute for carriage returns.
List items delimiter - Certain fields may contain lists of items, such as the names of the takes for a cue. Those items must be delimited by a character. You can specify what that delimiter is here.
Remove surrounding double quotes - Choose how you want ADR Manager to deal with double quotes that surround a text field. Double quotes are sometimes added by programs such as Microsoft Excel when saving to a tab-delimited text file
if commas or other punctuation are in the field. Choices are "Always", "Ask whether to" and "Never".
Replace consecutive double quotes - Choose how you want ADR Manager to deal with double quotes that appear consecutively. Consecutive double quotes are sometimes added by programs such as Microsoft Excel when saving to a tab-
delimited text file if a double quote is typed into a field by the user. Choices are "Always", "Ask whether to" and "Never".

The Preview tab shows the columns that you will be importing. Skipped rows are in italics. Skipped columns are greyed out.

Imported time fields must be in the same format as the currently displayed database time format.
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Importing XML files

XML files are text files that describe data in a way that allows for better flexibility than tab-delimited text files. Fields can be listed in any order, and you can have a different number of fields for each record.

If the XML file you are importing contains more than one table, you can choose which tables you want to import before selecting the fields for each table. Once you've selected the tables, or if there is only one table in the XML file, the following dialog
appears:

Choose fields to import by checking them.

WARNING: Be careful when importing and exporting ID fields (such as "ID", "Reel ID", "Scene ID", etc). Every record in the database is given a unique ID which you can import and export. This allows you to unambiguously match data
in an import file to records in the database, rather than relying on other fields in the import file such as the name of the record. In general you should only import or export an ID field to and from the same database, never between
different databases. The only time you should import IDs from another database is if you are importing an XML file that contains multiple tables, such as importing a file when creating a project. In this case, records within the import file
rely on IDs to link to one another.

The Options tab lets you change certain settings:

Under the Options tab, you can set:
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Under the Options tab, you can set:

List items delimiter - Certain fields within a record may contain lists of items, such as the names of the takes for a cue. Those items must be delimited by a character. You can specify what that delimiter is here.

The Preview tab shows the XML file you are going to import.

You can save the import settings to a disk file by clicking on the Save... button, and reload them at a later date by clicking on the Load... button.

Imported time fields must be in the same format as the currently displayed database time format.

If you are importing an XML file into a brand new database by clicking on the Import XML File... button in the New Project window, the application will import default reports and keyboard shortcuts once the import is complete, then quit. You can then
relaunch ADR Manager to use the new database.
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Importing a Pro Tools session text file

If you are importing from a Pro Tools session text file, you must make sure you’ve entered the track and region names in a way that ADR Manager will understand. See Importing cues from a Pro Tools session text file and Importing scenes from a Pro
Tools session text file for details on how to prepare a Pro Tools session for exporting.

Once you’ve prepared your Pro Tools session, go to the File menu in the Pro Tools menu bar and choose Export > Session Info as Text. Make sure the following options are set:

It doesn’t matter whether “Include File List”, “Include Clip List”, "Include Markers", or "Include Plug-In List" are checked or not
“Include Track EDL’s” must be checked
“Show Subframes” must not be checked
It doesn’t matter whether “Include User Timestamps” is checked or not
Fade Handling should be set to “Show Crossfades”. ADR Manager will merge fade ins and outs with regions and count them as part of the region’s start and end time inclusively. Crossfades will be split into two equal halves, with the first half
added to the end of the previous region and the second half added to the start of the next region.
Time format must match the currently displayed time format in ADR Manager
The text file format must be “TextEdit ‘TEXT’”

Once you’ve exported the session file to text, go to ADR Manager and make the appropriate List window active. Choose Import under the File menu. The following dialog appears (for ADR cues, in this example):
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You can save the import settings to a disk file by clicking on the Save... button, and reload them at a later date by clicking on the Load... button.

The Fields tab lets you specify what tracks to import and how to parse the track and region names so that the proper data goes in the ADR cue fields:

Import into reel - Choose which reel you want to import the records into. Only the reels in your current reel set are available.
Tracks to import - Check which tracks you want to import.
Fields to fill - These are the fields that will be filled by parsing text in your track or region names (see below).

Each track and region name is examined for special delimiters that designate text to go in fields. ADR Manager will look for those delimiters in your track or region name, extract the text between the delimiters, and put the extracted text in the field. The
fields are listed in the order they are searched. For example, in the screenshot above, ADR Manager will look for a pair of double quotes first, and if found, remove the chunk of text from the region name and put it into the dialogue field. Then it will look
for a pair of curly braces in the remaining text and put that chunk of text into the notes field. Note that you cannot nest fields within one another - if you put curly braces within the dialogue, the curly braces text will be considered part of the dialogue, not
the notes.

Fields found in track names are applied to all regions on that track. For instance, you can put the character abbreviation in a track name as a way to specify that all regions on that track belong to that character. If you want spread out a character's cues
across multiple tracks, add a suffix outside the character abbreviation in each track name (since Pro Tools requires that each track name is unique). ADR Manager will ignore any text outside of delimited text. If a field is found in both a region name and
the region's track name, the text in the region name is used.

You can change a field's delimiters by selecting one from the Delimiters popup. You can change the order that ADR Manager parses fields by dragging the rows in the list.

For more information, check out an example.

The Options tab lets you change certain settings:

Carriage return substitution - You can replace a specific character in your track or region names with a carriage return during import.
Ignore regions beyond reel - You can choose to ignore regions, such as head or tail pops, that occur before the reel's FFOA or after the reel's LFOA
Merge adjacent regions - If two regions touch or overlap on a Pro Tools track, you can append the second region to the first region.
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Strip off number suffixes - Removes any trailing number suffix in the region name, such as "-01". This is the suffix that Pro Tools adds when you create a new region on a track, such as making a cut.

The Preview tab shows the file you are going to import.

Imported time fields must be in the same format as the currently displayed database time format.
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Merging adjacent Pro Tools regions during import

The Merge adjacent regions option in the Import Pro Tools session text file dialog lets you combine contiguous regions on a Pro Tools track to form one cue.

When merging adjacent regions, ADR Manager extends the end of the first region to the end of the second region, and appends the text in the second region to the first region as follows:

Adds a carriage return character (i.e. "^")
Adds the start time of the second region
Adds the second region's text

For example, suppose you create adjacent regions in a Pro Tools session like this:

Then you import the session text file with the Merge adjacent regions option checked. A cue will be imported similar to this.

Note how the start time of the second region is embedded within the dialogue of the cue, followed by the second region's text.
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Choosing tables to import

If you are importing into the Project Info window, you can import into multiple tables at once. This feature lets you maintain links between different tables, such as the links between reels and scenes. You can choose which tables you want to import from
all of the available tables in the import file.

TIP: It is better to import into multiple tables at once, rather than in separate passes, since you can retain links between records in different tables if you import them together.

After ADR Manager has examined the file, it will present what tables were found in the import file:

Choose which tables you want to import by checking them then clicking OK. You can then choose which fields you want to import for each table.

TIP: To ensure that the links between different tables are maintained, include the ID fields of those tables in the Import Options dialog.

See Projects for more information.
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The import process

After you’ve chosen the file to import and setup the import settings, click OK to begin the import process. ADR Manager looks at each block of information in the import file and fills a new record using as much information as it can gather from the block.
You can control how that information is gathered in the setup options described above. Once the information has been gathered, ADR Manager examines the partially filled record to make sure whatever fields were imported are valid. Then it looks in the
database for a record that may already exist with the same properties. If a duplicate is found, a dialog appears asking you what you want to do. For example:

Depending on the situation, you have several options to choose from:

Skip imported record – You can skip this record and continue importing the other records from the file.
Replace existing record with imported one – You can replace the record that is already in the database with the imported one. Note that there must be enough imported information to create a complete record, otherwise an error will occur and
the import process will be aborted (all previously imported records will be cancelled).
Merge imported fields into existing record – This option lets you merge the imported information into the existing record. Use this option if you only want to change one or two fields without affecting the other fields. For example, if you export
only cue IDs and cue Dialogue fields into a text file, you can spell check the text file using a word processor then import the file back into the database using the Merge imported fields into existing record option during the import.
Import as a brand new record – You can add a new record even though another record already exists with the same values. Note that certain tables do not allow duplicate records with the same field values – in this case, the option is not
available. If you choose this option, there must be enough imported information to create a complete record, otherwise an error will occur and the import process will be aborted (all previously imported records will be cancelled).

If you want the same option to automatically apply to all other records in the import file, check the “Apply to all” checkbox. To continue, click OK. To cancel importing this and all previously imported records from the file, hit Cancel.

If you chose Import as a brand new record or Replace existing record with imported one, ADR Manager uses the imported fields to fill in other empty fields in order to “flesh out” the record more. Finally, the program makes sure all of the required
fields necessary to save the new record are filled and valid. If everything checks out, the record is saved and the process is repeated for the next block of information in the import file.
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Preparing to export

If you want to export records, first select them in the active window. For instance if you want to export cues, you must click, shift-click, and/or command-click on them in the ADR Cue List Window, then choose Export… (command-E) under the File
menu.

A dialog will appear asking you to choose an export format:

Choose the format in the popup menu and click OK.

Depending on what you are exporting, an options dialog may appear. See Exporting to tab delimited files, Exporting to XML files, Exporting reports, or Exporting a project for more information about the export options dialog.

Exported time fields will be in the same time format as the currently displayed time format, unless you are exporting to an ADRStudio or CMX text file.

TIP: Exporting and then importing certain fields lets you modify data without changing other data in the datafile. For instance, you could export only the ID and dialogue fields of ADR cues to a tab-delimited text file, bring the file into a word
processor or spreadsheet program, run a spell checker over the data, then import the file back into ADR Manager.
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Exporting reports

When you export a report, ADR Manager automatically names the file with the report name. Therefore, when you export a report, a “Select folder” dialog will appear, letting you choose a folder but not letting you type in a filename.

Since the report name is used as the filename, you must not use characters in the report name that would make it an invalid filename for your operating system. In particular, on the Macintosh you cannot use a colon (:). On Windows, you cannot use
a forward slash (/), a backward slash (\), a colon (:), an asterisk (*), a question mark (?), a double quote (“), a greater-than sign (>), a less-than sign (<), or a vertical bar (|).

You can export more than one report at a time. Shift-click or command-click on the reports you wish to export, then choose Export. A “Select folder” dialog will appear, as described above. Each report will be saved as a separate file in the selected
folder, with each filename matching the report name.
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Exporting tab delimited files

If you are exporting to a tab delimited text file, the following dialog appears:

The Fields tab lets you specify which fields are to be exported.

The popup at the top of the tab area shows what table you will be exporting from.

Choose fields to export by checking them. Drag the order of fields to change the order they will be exported to the file.

WARNING: Be careful when importing and exporting ID fields (such as "ID", "Reel ID", "Scene ID", etc). Every record in the database is given a unique ID which you can import and export. This allows you to unambiguously match data in
an import file to records in the database, rather than relying on other fields in the import file such as the name of the record. In general you should only import or export an ID field to and from the same database, never between different
databases. The only time you should import IDs from another database is if you are importing an XML file that contains multiple tables, such as importing a file when creating a project. In this case, records within the import file rely on IDs to
link to one another.

The Options tab lets you set the following options:
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Put column headers in first row – If you want each column to have a header, check this box. By including column headers in the export file, you can easily import the file into other database applications (or back into ADR Manager) by linking
fields in the file to fields in the database.
Carriage return substitution - When exporting fields that contain carriage returns, such as a cue’s dialogue field, it is important to replace the carriage return with some other character. Here is where you designate the character you want as a
substitute for carriage returns.
List items delimiter - Certain fields may contain lists of items, such as the names of the takes for a cue. Those items must be delimited by a character. You can specify what that delimiter is here.
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Exporting XML files

If you are exporting from the Project Info window, you must choose which tables you will be exporting first. If you are exporting from a List window (such as the ADR Cue List window) to an XML file, the following dialog appears:

Choose fields to export by checking them.

WARNING: Be careful when importing and exporting ID fields (such as "ID", "Reel ID", "Scene ID", etc). Every record in the database is given a unique ID which you can import and export. This allows you to unambiguously match data in
an import file to records in the database, rather than relying on other fields in the import file such as the name of the record. In general you should only import or export an ID field to and from the same database, never between different
databases. The only time you should import IDs from another database is if you are importing an XML file that contains multiple tables, such as importing a file when creating a project. In this case, records within the import file rely on IDs to
link to one another.

The Options tab lets you set the following options:

List items delimiter - Certain fields may contain lists of items, such as the names of the takes for a cue. Those items must be delimited by a character. You can specify what that delimiter is here.
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Choosing tables to export

If you are exporting from the Project Info window, you can export records from several different tables into the same file. This feature lets you maintain links between different tabless, such as the links between ADR cues and reels.

Choose which tables you want to export by checking them. You can check/uncheck all of them by option-clicking on a checkbox. When done, click on the Export... button. You can then choose which fields you want to export for each table.

TIP: To ensure that the links between records in different tables are maintained, include the ID fields of those tables in the Export Options dialog.

See Projects for more information.
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Copying record data to the clipboard

Another way to move data out of ADR Manager and into another program is to copy selected records from any window to the clipboard using Copy under the Edit menu. The data will be stored as text. For each row in the window, the field value in
each column will be put on the clipboard, separated by a tab. A carriage return will be added after each row – however, if a carriage return exists within a field, the record will be split up between rows. You can paste the text from the clipboard into a
word processor or spreadsheet application by using Paste under the Edit menu in that application.

You cannot paste record data from the clipboard into an ADR Manager window.
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ADR Cues

This section describes the details of importing and exporting cues. For an explanation of how records are imported in general, see The import process.

See the list of fields that you can import and export for ADR cues.

IMPORTANT: Imported cues will not have lineage ties to other cues unless you export and re-import the "Ancestor cue ID" field with the data. You should only include this field if you are importing back into the same database from
which you exported.

When importing cues, make sure the cue names you are importing adhere to the cue naming convention you have setup for this database.
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ADR Cue fields

The following table shows the default ADR Cue fields that are imported and exported in tab-delimited and XML files.

Column name Format Notes
ID Number The cue’s record ID. A good use of this field is when you export cues in order to

process one or more fields, then merge the changed fields back into the
database.

Name Up to 16 characters Importing: If not blank, should adhere to database cue naming convention.
Character ID Number The cue’s character ID.
Character abbreviation Text The cue’s character abbreviation, as stored in the cue name.
Character name Up to 64 characters Importing: If blank, the cue name is parsed to see if a character abbreviation is

embedded. If one is not found that matches a character record, user may create
new character record.

Segment type Must be set to:
reel

 

Segment name Reel number (use 00 for the WILD reel) Importing: If blank, the cue name is parsed to see if a reel number is contained in
the name. If one is not found that matches a reel record, an error occurs.

Segment dupe date Date in the format MM/DD/YY Importing: If not present, uses reel with matching number in current reel set. If
current set is “All reel dupes”, an arbitrary dupe with matching number is chosen.

FFOA Time value in the currently displayed database time format. Importing: If this field is blank, then LFOA must also be blank and segment name
must be 00 (the cue is WILD)

LFOA Time value in the currently displayed database time format. Can be blank, which means the cue is open-ended.
Dialogue Up to 2 billion characters  
Public Notes Up to 2 billion characters  
Private notes Up to 2 billion characters  
Status Must be one of the following strings:

spotted
printed
recorded
transferred
loaded
cut
premixed
final mixed

Importing: If blank or invalid, field is set to “Spotted”.

Is omitted Must be one of the following strings:
true
false

Importing: If blank or invalid, field is set to “False”.

Is locked Must be one of the following strings:
true
false

Importing: If blank or invalid, field is set to “False”.

Is wild Must be one of the following strings:
true
false

Importing: Currently ignored

Priority Must be one of the following strings:
highest
high
medium
low
lowest

Importing: If blank or invalid, field is set to “Medium”.

Segment ID Number The cue’s reel ID.
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Segment ID Number The cue’s reel ID.
Segment dupe order Number Importing: Currently ignored
Segment continuity index Number Importing: Currently ignored
Ancestor cue ID Number The cue’s ancestor cue ID.
Take IDs A list of take IDs.  
Take names A list of take names.  
Scene ID Number Importing: Ignored. The cue’s scene is determined by the cue’s start time and

reel.
Scene name Up to 10 characters Importing: Ignored. The cue’s scene is determined by the cue’s start time and

reel.
Scene continuity index Number Importing: Currently ignored
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Importing cues from a Pro Tools session text file

You can spot regions in a Pro Tools session, then bring them into ADR Manager to create cues. You do this by creating a region for each cue, entering cue information into the region name, then exporting the session as a text file. ADR Manager will
create a cue for each imported region, parsing the track names and region names to fill the fields of cue records.

To import a Pro Tools session to create cues in ADR Manager, follow these steps:

1. Create a session.
2. Create “spotting” tracks. You may want to create one track for each character. Or you may want to create several tracks for a particular character, one for TV lines, one for high priority lines, etc. You don’t have to worry about creating too many

tracks because you can choose which tracks to import later.
3. Enter cue information into the track name, such as the character abbreviation. Cue information in the track name is applied to all regions on that track. The cue fields' information must be within delimiters (see step 7 below).
4. On the spotting tracks, create regions. Regions can contain online or offline media. A region can have a fade in, fade out, or crossfade and ADR Manager will include them as part of the cue.
5. Enter cue information into each region name, such as dialogue, notes, and status. Cue information in the region name overrides the same information in the track name, if any. All cue information must be within delimiters (see step 7 below). 

Here is a sample Pro Tools “spotting” session. In this example, the regions contain cue dialog (delimited by “”), priorities (delimited by <>), and notes (delimited by {}). The track names contain character abbreviations (delimited by []). Remember,
any information in the track name (the character abbreviation) is applied to all regions on that track.

6. In Pro Tools, save the session as a text file by choosing File > Export > Session Info as Text. Make sure the following options are set:

It doesn’t matter whether “Include File List”, “Include Clip List”, "Include Markers", or "Include Plug-In List" are checked or not
“Include Track EDL’s” must be checked
“Show Subframes” must not be checked
It doesn’t matter whether “Include User Timestamps” is checked or not
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It doesn’t matter whether “Include User Timestamps” is checked or not
Fade Handling should be set to “Show Crossfades”. ADR Manager will merge fade ins and outs with regions and count them as part of the region’s start and end time inclusively. Crossfades will be split into two equal halves, with the first
half added to the end of the previous region and the second half added to the start of the next region.
Time format must match the currently displayed time format in ADR Manager
The text file format must be “TextEdit ‘TEXT’”

7. In ADR Manager, select File > Import and choose “Text file (Pro Tools session)”. Choose the Pro Tools session text file you just created.
8. A dialog will appear letting you select the reel you will be importing into, the tracks you want to import, and a list of fields to scan. See Importing from a Pro Tools session text file for information on how to use this dialog.
9. The regions are imported and converted into cues.

You can save the import settings (the delimiters and carriage return substitution text) to a disk file by clicking on the Save... button, and reload them at a later date by clicking on the Load... button.
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Exporting cues to an ADRStudio™ v3 text file

ADR Manager can export cues to ADRStudio format. ADRStudio is an application you can use to drive Pro Tools during an ADR recording session.

If the currently displayed time format is not timecode, the cue times in the exported file will be converted to timecode. All selected cues must be from the same reel and dupe date.

For more information about ADRStudio, contact Gallery Software.
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Exporting cues to a CMX text file

You can export selected cues as a CMX text file. This format is useful to feed into another application that conforms or assembles sound files for an editing session.

To export to a CMX text file, all selected cues must be from the same reel dupe and the current time format must be timecode. You cannot select more than 999 cues at one time to export to a CMX file.

Each pair of lines in the CMX file represents a cue. The first line in each pair consists of the following specially formatted fields:

Event number – A 3-digit zero-padded sequential number
Sound roll name – “NA”
Audio channel – “A”
Cut type – “C”
Dissolve length - <blank>
Source start and end times – For the current cue, ADR Manager finds the latest ancestor cue whose status is “Recorded.” The ancestor cue’s start and end times are used as the source start and end times.
Record start and end times – The current cue’s start and end times.

The second line is a “comment” line and contains the cue name.
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Exporting cues to a Soundmaster™ text file

To export cues to a Soundmaster™ text file, all selected cues must be from the same reel dupe. You cannot select more than 9,999 cues at one time to export to a Soundmaster file.

For more information about the Soundmaster format, contact the Soundmaster Group.
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Characters

For an explanation of how records are imported in general, see The import process.

For a list of character fields that you can import and export, see Character fields.
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Character fields

The following table shows the default Character fields that are imported and exported.

Column name Format Notes
ID Number The character’s record ID. A good use of this field is when you export characters

in order to process one or more fields, then merge the changed fields back into
the database.

Name Up to 64 characters  
Abbreviation Up to 12 characters  
Actor Up to 64 characters  
Description Up to 80 characters  
Recording notes Up to 80 characters  
Lines per hour Number Set to 10 if not specified during import and creating a new record
Character type Must be one of the following strings:

Principal
Minor
Loop Group

Set to “Principal” if not specified during import and creating a new record
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Reels

For an explanation of how records are imported in general, see The import process. For a list of reel fields that you can import and export, see Reel fields.
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Reel fields

The following table shows the default Reel fields that are imported and exported.

Column name Format Notes
ID Number The reel’s record ID. A good use of this field is when you export reels in order to

process one or more fields, then merge the changed fields back into the
database.

Number Number between 0 and 99  
Dupe date Date in the format MM/DD/YY  
Version Up to 8 characters  
Timecode FFOS Time value in the database timecode format. Reel start time, in timecode
Timecode FFOA Time value in the database timecode format. Reel FFOA, in timecode
Timecode LFOA Time value in the database timecode format. Reel LFOA, in timecode
Timecode LFOS Time value in the database timecode format. Reel end time, in timecode
Feet frames FFOS Time value in the database feet frames format. Reel start time, in feet and frames
Feet frames FFOA Time value in the database feet frames format. Reel FFOA, in feet and frames
Feet frames LFOA Time value in the database feet frames format. Reel LFOA, in feet and frames
Feet frames LFOS Time value in the database feet frames format. Reel end time, in feet and frames
Segment FFOA offset Time value in seconds (i.e. 8.008) Actual time between reel start time and FFOA
Segment duration Time value in seconds Actual time between reel start time and reel end time
Action duration Time value in seconds Actual time between FFOA and LFOA
Ancestor segment ID Number The ID of the previous reel (direct ancestor) of this reel
Brief description Up to 80 characters Ignored. This field is reserved for future use.
Full description Up to 2 billion characters Ignored. This field is reserved for future use.
Parent segment type String Must be “root”. This field is reserved for future use.
Parent segment ID Number Must be “0”. This field is reserved for future use.
Parent segment name String Must be “”.This field is reserved for future use.
Parent segment dupe date Date in the format MM/DD/YY Must be “00/00/00”. This field is reserved for future use.
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Reports

This section describes the details of importing and exporting reports.
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Importing a report from a record file

You can import reports that have been exported from ADR Manager. The reports are stored in a special format that can only be imported and exported by ADR Manager. There is one report to a record file.

Follow the steps described in Preparing to import. If the import file was created using a different version of ADR Manager than the one you are using, an alert will tell you if you can open this file, and whether you should re-export the report to save it
in the new format. If that is the case, then re-export the report after you are finished importing it.

If you can import this file, a progress window will appear showing how far along the import is. If the import is a success, the new report will be given the same name as the filename from which it was imported.
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Exporting a report to a record file

To export a report, make sure the Report List Window is active. Click on the report you want to export. You can only export one report at a time. Then select Export… under the File menu.

Reports stored as record files can be imported into other ADR Manager databases.
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Scenes

This section describes the details of importing and exporting scenes. For an explanation of how records are imported in general, see The import process. For a list of scene fields that you can import and export, see Scene fields.
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Importing scenes from a Pro Tools session text file

You can spot regions in a Pro Tools session, then bring them into ADR Manager to create scenes. You do this by creating a region and entering scene information into the region name, then exporting the session as a text file. ADR Manager will create a
scene for each imported region, parsing the track names and region names to fill the fields of the scene records.

To import a Pro Tools session to create cues in ADR Manager, follow these steps:

1. Create a session.
2. Create a “spotting” track.
3. On the spotting track, create regions. Regions can contain online or offline media. A region can have a fade in, fade out, or crossfade and ADR Manager will include them as part of the cue.
4. Enter scene information into each region name, such as name and brief description. All scene information must be within delimiters (see step 7 below).

Here is a sample Pro Tools “spotting” track. In this example, the regions contain scene names (delimited by parentheses), and brief descriptions (delimited by {}).

5. In Pro Tools, save the session as a text file by choosing File > Export > Session Info as Text. Make sure the following options are set:

It doesn’t matter whether “Include File List” and “Include Region List” are checked or not
“Include Track EDL’s” must be checked
“Show Subframes” must not be checked
It doesn’t matter whether “Include User Timestamps” is checked or not
Fade Handling should be set to “Show Crossfades”. ADR Manager will merge fade ins and outs with regions and count them as part of the region’s start and end time inclusively. Crossfades will be split into two equal halves, with the first
half added to the end of the previous region and the second half added to the start of the next region.
Time format must match the currently displayed time format in ADR Manager
The text file format must be “TextEdit ‘TEXT’”

6. In ADR Manager, select File > Import and choose “Text file (Pro Tools session)”. Choose the Pro Tools session text file you just created.
7. A dialog will appear letting you select the reel you will be importing into, the tracks you want to import, and a list of fields to scan. See Importing from a Pro Tools session text file for information on how to use this dialog.

The regions are imported and converted into scenes.
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The regions are imported and converted into scenes.

All imported scene fields are optional. Optional fields will be filled with default values (i.e. empty strings) if you don’t include them in the track or region name.
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Scene fields

The following table shows the default scene fields that are imported and exported.

Column name Format Notes
ID Number The scene’s record ID. A good use of this field is when you export scenes in order

to process one or more fields, then merge the changed fields back into the
database.

Name Up to 10 characters  
Parent segment type Must be the following string:

reel
 

Parent segment name Number between 0 and 99 Importing: Must be the name of a reel in the current reel set
Parent segment ID Number Record ID of the scene’s reel
Parent segment dupe date Date in the form MM/DD/YY Dupe date of the scene’s reel
Dupe date Date in the format MM/DD/YY Importing: ignored
Version  Importing: ignored
Brief description Up to 80 characters  
Full description Up to 2 billion characters  
Timecode FFOA Time value in the database timecode format Scene start time, in timecode
Feet frames FFOA Time value in the database timecode format Scene start time, in feet and frames
Timecode FFOS Time value in the database timecode format Reel start time, in timecode
Timecode LFOA Time value in the database timecode format Scene end time, in timecode
Timecode LFOS Time value in the database timecode format Reel end time, in timecode
Feet frames FFOS Time value in the database feet frames format Reel start time, in feet and frames
Feet frames LFOA Time value in the database feet frames format Scene end time, in feet and frames
Feet frames LFOS Time value in the database feet frames format Reel end time, in feet and frames
Segment FFOA offset Time value in seconds (i.e. 8.0) Actual time between reel start time and scene start time
Segment duration Time value in seconds Actual time between reel start time and reel end time
Action duration Time value in seconds Actual time between scene start time and scene end time
Ancestor segment ID Number The ID of the previous version (direct ancestor) of this scene
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Takes

This section describes the details of importing and exporting takes. For an explanation of how records are imported in general, see The import process. For a list of take fields that you can import and export, see Take fields.

Note that if you import takes from a tab-delimited or XML file and a take is imported that has no reel information, the take will be put in the WILD reel automatically.
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Creating a library from Avid media

You can create a library within ADR Manager of all the sound files digitized on an Avid Media Composer™ or Film Composer™. You can then search, audition, and spot the media into Pro Tools. This is particularly useful because sound files on an
Avid workstation usually have non-sensical names when viewed in the Finder, such as “n17a_8.RENA01.B99A13D74C99D.aif”.

To create a library of OMF media in ADR Manager, you must dump the information stored in Avid bins to OMF compositions, convert the OMF compositions to Pro Tools session(s) and then import the Pro Tools sessions into ADR Manager. Follow
these steps:

1. Copy the media files from the Avid drives to your Pro Tools drives using the Finder, using intermediate removable or network drives if necessary. Do not copy or “consolidate” the media using the Avid application; otherwise, the OMF
compositions created in step 3 will not link up to the media on your Pro Tools drives. You can “copy and link” (see Avid documentation), but be sure the filenames and file IDs do not get changed in the process.

2. On the Avid workstation, select all of the audio files in a bin and drag them into an empty sequence. The Avid will place the files end-to-end on the track.
3. Export the sequence to an OMF file, composition only.
4. Import the OMF composition file into Pro Tools using DigiTranslator, linking the media references to the copied media on your Pro Tools workstation.

At this point you can import the Pro Tools session directly into ADR Manager. When you are done, you will have created a library of all the media on the Avid. The take names in ADR Manager will be the clip names on the Avid workstation, and each
take will point to the appropriate media file on your Pro Tools workstation.

TIP: This option is better than importing takes via a folder scan (see next section) because clip names rather than sound filenames are used to name the new takes.
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Importing takes via a folder scan

To quickly build or add to a library of existing media, you can have ADR Manager scan a folder (and its subfolders) for any recognizable sound files. ADR Manager currently supports AIFF and WAVE (including Broadcast WAVE) sound file formats.

To scan a folder, select Folder scan in the Import dialog and choose a folder. An additional dialog will appear giving you the option to scan subfolders as well. ADR Manager will then scan the folder (and subfolders) for any recognizable sound files
and create takes for each, based on the sound file’s name.

If a sound filename adheres to the take naming convention you have defined for your database, then ADR Manager will parse the sound filename, create a new take, and automatically link the take to the cue(s) it is related to. See Take naming
preferences for more information.
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Take fields

The following table shows the default Take fields that are imported and exported.

Column name Format Notes
ID Number The take’s record ID. A good use of this field is when you export cues in order to

process one or more fields, then merge the changed fields back into the
database.

Name Up to 80 characters  
Number Number between 1 and 50  
Dialogue Up to 2 billion characters  
Notes Up to 80 characters  
Rating Must be one of the following strings:

A
B
C
D
F
NG

 

Rating index Number between 1 and 6 Corresponds to rating (i.e. 1 = “A”, 6 = “NG”)
Cue names A list of cue names. Exporting: A delimiter character (specified in the Export Options dialog) is inserted

between each cue name.
Importing: A delimiter character (specified in the Import Options dialog) is
expected between each cue name.

Is circled Must be one of the following strings:
True
False

Importing: If blank or invalid, field is set to “False”.

Sound name  Filename, including the extension (which may be hidden in the Finder)
Sound pathname  Full pathname, including the filename and extension (which may be hidden in the

Finder)
Is wild Must be one of the following strings:

True
False

Importing: Ignored

FFOA Time value in the format specified in the Import Text file options. Can be blank. Importing: If this field is blank, then LFOA must also be blank and segment name
must be 00 (the take is WILD)

LFOA Time value in the format specified in the Import Text file options. Can be blank.  
Audition channel Must be one of the following strings:

mono
.L
.C
.R
.Lc
.Rc
.Ls
.Cs
.Rs
.Lfe

 

Cue IDs A list of cue IDs. Exporting: A delimiter character (specified in the Export Options dialog) is inserted
between each cue ID.
Importing: A delimiter character (specified in the Import Options dialog) is
expected between each cue ID.
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Projects

You can import and export an entire project by displaying the Project window and choosing Import or Export from the File menu. You can choose which tables you want to import or export, then choose which fields from each table you want to
import or export.

Importing and exporting from the Project window is different than importing and exporting from a list window, such as the ADR Cue List window, because it allows you to group records from different tables in one file, maintaining the links between
those records within the file. However, you cannot select which records of each table you want to import or export - all records from the table will be selected.

You can rebuild an entire database by importing a project XML file when you open a newly created blank database. This is useful, for example, for converting old ADR Manager databases by exporting them to an XML file then importing the XML file
at project creation. See Creating a project for more information.

TIP: You can use the utilities found in the ADR Manager > Utilities folder to export databases created with ADR Manager v2 or v3 to XML files. For more info, see the corresponding manual for each utility, located in the Utilities folder.

For an explanation of how records are imported in general, see The import process.

ADR Manager 5 User Manual 260



Project fields

The following table shows the default project fields that are imported and exported.

Column name Format Notes
Name Up to 80 characters  
Displayed time system Must be one of the following strings:

timecode
feet frames

 

Displayed time format Must be one of the following strings:
non drop frame running at 30 fps
non drop frame running at 29.97 fps
drop frame running at 29.97 fps
25 frame running at 25 fps
24 frame running at 24 fps
35mm running at 25 fps
35mm running at 24 fps
35mm running at 23.976 fps

 

Timecode format Must be one of the following strings:
non drop frame running at 30 fps
non drop frame running at 29.97 fps
drop frame running at 29.97 fps
25 frame running at 25 fps
24 frame running at 24 fps

 

Feet frames format Must be one of the following strings:
35mm running at 25 fps
35mm running at 24 fps
35mm running at 23.976 fps

 

Auto lock cues by omit state Must be one of the following strings:
(empty string)
disabled
omitted
not omitted

If the empty string or "disabled", the setting is turned off.

Auto lock cues by status Must be one of the following strings:
(empty string)
disabled
Spotted
Printed
Recorded
Transferred
Loaded
Cut
Premixed
Final mixed

If the empty string or "disabled", the setting is turned off.

Distinguish reels by Must be one of the following strings:
version
dupe date

 

Update ancestor cues action Must be one of the following strings:
never
ask whether to
always
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Check for software updates Must be one of the following strings:
true
false

 

Cue naming preferences Fields corresponding to the checkboxes and options in the Cue Naming and Take
Naming preferences

This field can only be imported/exported using XML format.

Full description Any text up to 2 billion characters  
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Scripting
Starting with version 3, you can control ADR Manager using apple events. Apple events are messages that can be sent between applications. Usually apple events are triggered through the use of a key macro program, such as iKeys, QuicKeys or
KeyQuencer, or from an AppleScript. Using apple events, you can talk to ADR Manager while you are in another program such as Pro Tools.

Be aware that only certain windows respond to apple events. The details of each apple event is listed in this section. The full installation of ADR Manager also comes with some sample apple scripts that send apple events. You can use them or
modify them to suit your needs.

For more information about what apple events and applescripts are, please refer to Apple documentation.
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Which windows accept apple events

The following table shows what public apple events can be sent to ADR Manager when certain windows are forefront:

 New Cue Modify Cue ADR Cue List New Scene Modify Scene Scene List
Get start time X X X X X X
Get end time X X X X X X
Set start and end times X X  X X  
Set start time X X  X X  
Set end time X X     
Set embedded time X X  X X  
Grab start time X X  X X  
Grab end time X X     
Grab embedded time X X  X X  
Import takes from Pro
Tools session text file* X X X X X X

Any window not listed in the above table will not accept apple events.

Get start / end times will retrieve the appropriate time from the currently selected record in the active window.

Set start / end time will stuff the passed time values into the respective fields in the currently active window.

Set embedded time will insert the time passed in the apple event to the Dialogue field in the New Cue and Modify Cue windows, and to the Full Description field in the New Scene and Modify Scene windows.

Grab start / end time will stuff the current incoming MIDI time value into the respective fields of the currently active window.

Grab embedded time will insert the current incoming MIDI time value into the Dialogue field in the New Cue and Modify Cue windows, and to the Full Description field in the New Scene and Modify Scene windows.

*The “Import takes from Pro Tools session text file” apple event can be received regardless of what window is active.
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Apple event parameters

The parameters for public ADR Manager apple events are as follows:

 Event ID Event type Parameters

Get start time ADRM GetS
Returns a string with a
correctly formatted time
value

Get end time ADRM GetE
Returns a string with a
correctly formatted time
value

Set start end times ADRM SetB

- Accepts a string with a
correctly formatted start
time value
- Accepts a string with a
correctly formatted end
time value

Set start time ADRM SetS
Accepts a string with a
correctly formatted time
value

Set end time ADRM SetE
Accepts a string with a
correctly formatted time
value

Set embedded time ADRM SetB
Accepts a string with a
correctly formatted time
value

Grab start time ADRM GrbS < None >
Grab end time ADRM GrbE < None >
Grab embedded time ADRM GrbM < None >

Import takes from Pro
Tools session text file ADRM ImTP

- Filename
- “” | “Auto-create takes” |
“Don’t auto-create takes”
- “” | “Import bad take
names” | “Don’t import
bad take names”

Strings with correctly formatted time values must be in the current time format of the database. Any leading or trailing spaces in the string will be stripped out before the time value is used.

Here is an example line from an apple script that sets the start time of the currently active record (cue or scene) in the New or Modify window:

«event ADRMSetS» “120+12”

Here is an example line from an apple script that retrieves the start time of the currently active record (cue or scene) in the New/Modify/List window:

set startTime to «event ADRMGetS»

The “Import takes from Pro Tools session text file” event allows you to feed ADR Manager a text file that can be imported, just as if you had chosen the file by selecting Import… under the File menu when the Take List window was active. The first
parameter is the full pathname of a file. The second parameter answers the “Do you want to auto-create takes?” dialog, if the take being imported does not already exist. The third parameter answers the “Do you want to import a take whose name
could not be parsed?” dialog, if the take name could not be parsed. Here is some sample syntax for using this event in an apple script:

«event ADRMImTP» {
 (myFile as string), 
 "Auto-create takes", 
 “Import bad take names”
}
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Apple scripts

ADR Manager ships with several sample AppleScripts that show you how to send apple events to the application. The script applets are in the ADR Manager > Scripts folder, and can be launched by double-clicking on them or launching them via a
utility such as iKey, QuicKeys, or Keyquencer.

Set start end times – Copies the start and end times of the current selection in the Pro Tools Edit window and pastes them into the start and end fields of the New Cue or Modify Cue window, or into the start time field in the New Scene or
Modify Scene window. The current time is not used in this script.
Current time to start time – Enters the current time into the start time field of the New Cue, Modify Cue, New Scene, or Modify Scene window. One of these windows must be open and at the forefront, otherwise an error occurs. You can see
what the current time is by looking at the Transport Window, but the Transport Window does not have to be open for ADR Manager to accept this apple event.
Current time to end time – Enters the current time into the end time field of the New Cue or Modify Cue window. One of these windows must be open and at the forefront, otherwise an error occurs. You can see what the current time is by
looking at the Transport Window, but the Transport Window does not have to be open for ADR Manager to accept this apple event.
Insert current time – Enters the current time into a field of the New Cue, Modify Cue, New Scene, or Modify Scene window. If the cursor is in a time field, the current time is entered into the field. If the cursor is in a text field, such as a
dialogue or description field, the current time is inserted at the cursor location, replacing any highlighted text. The cursor must be in an appropriate field in one of the above windows, otherwise the command is ignored. You can see what the
current time is by looking at the Transport Window, but the Transport Window does not have to be open for ADR Manager to accept this apple event.
ADR Mgr activate – Brings ADR Manager to the forefront, if it’s running.
Pro Tools active – Brings Pro Tools to the forefront, if it’s running.
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Backing up

ADR Manager is built on top of a database engine called 4th Dimension (4D), and therefore employs certain features of the 4D engine. In particular, 4D includes a full database backup and restore module that can be configured in the ADR Manager
Preferences window (see Backup preferences for the recommended settings). This appendix is provided to give you a more in-depth understanding of the 4th Dimension backup and restore mechanisms.

The 4D backup module allows backing up a database currently in use without having to exit it. Each backup can include the structure file, the data file (as well as any segments) and additional files or folders. These parameters are first set in the
application Preferences. Backups can be started manually or automatically at regular intervals without any user intervention. Specific language commands, as well as specific database methods, allow integrating backup functions into a customized
interface. Databases can be restored automatically when a damaged database is opened. Also, the integrated backup module can take advantage of the log file. This file keeps a record of all operations performed on the data and also ensures total
security between two backups. In case of problems with a database in use, any operations missing in the data file are automatically reintegrated the next time the database is opened. A specific window allows you to view the log file contents at any
time. The integrated backup module allows you to:

Start a complete backup of database files at any time (structure file, data file, log file, attached files, etc.),
Set up automatic backups at regular intervals — on a hourly, daily, weekly or monthly basis,
Set advanced parameters for backups (number of sets, file compression, options for startup after a restore, etc.),
Automatically restore a database and its attached files in case of incident,
Automatically integrate missing operations stored in the log file into a restored database,
Roll back operations performed on database data.
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Managing backups

Backing up the database consists of generating a copy of the database and all its necessary files at a given moment. This copy is placed in one or more backup file(s). Any backup file can later be opened using 4th Dimension in case of any incidents
that damage the current database; the database will then be restored to its previous state (at the time it was copied).
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Performing a backup

Each backup is performed while taking into account the parameters set in the application preferences. The preferences can be used to define every aspect of the backup:

Files to include in the backup (data / log, structure, user structure and attached files)
Location of backup files (main backup file and log backup file)
Management of log file
Backup scheduling
Backup options: number and rotation of backup sets; handling of active transactions or index operations; handling of failures; segmentation, compression and integrity of backup files
Setting automatic restore options

These parameters are set at default values corresponding to standard use; changing these values is optional.
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Starting a backup

In ADR Manager, a backup can be started in two ways:

Manually, using the Backup... command under the File menu
Automatically, using the scheduler that can be set in the application Preferences.

The choice will depend on your use of the database and your backup strategy.

You cannot start a backup until all New and Modify windows are closed, as well as any conform windows.

Once the backup is started, 4th Dimension displays a dialog box indicating the progress of the backup. The Stop button lets the user interrupt the backup at any time.

The result of the last backup (successful or failed) is stored in the "Last Backup Information" area of the Backup/Configuration page of the Preferences. It is also recorded in the database Backup journal.
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Accessing the Database During Backup

During a backup, the database is locked for both read and write; all processes are frozen. No actions can be performed.

However, if the action waiting to be executed comes from a command launched prior to the backup, you should not cancel it because only operations remaining to be performed are cancelled. Also, a partially executed command can cause logical
inconsistencies in the database.

ADR Manager 5 User Manual 271



Encountering problems during a backup

It may happen that a backup is not executed properly. There may be several causes of a failed backup: user interruption, attached file not found, destination disk problems, incomplete transaction, etc. 4th Dimension processes the incident according
to the cause. In all cases, the status of the last backup (successful or failed) is displayed in the Backup journal.

User interruption: The Stop button in the progress dialog box allows users to interrupt the backup at any time. In this case, the copying of elements is stopped and an error is generated. You can intercept this error in the On Backup Shutdown
database method.
Attached file not found: When an attached file cannot be found, 4th Dimension performs a partial backup (backup of database files and accessible attached files) and returns an error.
Backup impossible (disk is full or write-protected, missing disk, disk failure, incomplete transaction, database not launched at time of scheduled automatic backup, etc.):
If this is a first-time error, 4th Dimension will then make a second attempt to perform the backup. The wait between the two attempts is defined on the Backup page of the Preferences.
If the second attempt fails, a system alert dialog box is displayed and an error is generated. You can intercept this error in the On Backup Shutdown database method.
Backups blocked due to an incomplete transaction or index operation are handled using a specific mechanism.
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Configuration of backup files

The Configuration page of the application Preferences lets you set the backup files and their location, as well as that of the log file. It also provides information on the last backup.

ADR Manager 5 User Manual 273



Backup contents

This area allows you to define which files and/or folders to copy during the next backup.

The upper portion of the area lists the 4th Dimension database files and indicates their current size. You must set each file to include in the backup by checking the corresponding option. A dimmed option means that the corresponding file is not
available in the database. You can select the 4th Dimension files that you want, depending on how often they are updated, their strategic interest, their size, etc. No file is required.

The lower portion lists the file access paths of any attached files in the backup.

Data File: Database data file. When this option is checked, the current log file of the database, if any, is backed up at the same time as the data. The backup causes the closing and backup of the current log file, then the creation of a new log
file. This prevents the size of the log file from becoming excessively large.
Structure File: Database structure file. This option allows you to backup the application file itself.
User Structure File (optional): Database User structure file that contains customized user forms (not available in ADR Manager v4).
Attachments: This area allows you to specify a set of files and/or folders to be backed up at the same time as the database. These files can be of any type (documents or plug-in templates, labels, reports, pictures, etc.). You can set either
individual files or folders whose contents will be fully backed up. Each attached element is listed with its full access path in the "Attachments" area.
Add Folder: When you click this button, 4th Dimension displays a dialog box that allows selecting a folder to add to the backup. In case of a restore, the folder will be recuperated with its internal structure. You can select any folder or volume
connected to the machine, with the exception of the folder containing the database files.
Add: When you click this button, 4 Dimension displays a dialog box that allows selecting a file to add to the backup. You cannot select a database file as an attached file.
Remove: This button allows you to remove the selected file from the list of attached files.

Note: It is possible that one or more attached files are not accessible when the backup is executed (modified name or access path, disk disconnected, etc.). In this case, the backup is executed without the missing file(s) and an error is generated.
The error is indicated in the Backup journal.
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Backup file destination folder

This area allows defining the location where backup files and log files (if any) are stored. 4th Dimension generates two types of backup files: backup files and backup log files. Backup files are special for two reasons:

They can contain several files (structure, data, attached files, etc.).
They are secured using internal verification mechanisms (which can be set on the "Backup" page of the Preferences).

By default, 4th Dimension stores these files next to the database data file. It is strongly advised to set a location on another disk volume to reduce the risk of data loss in case of disk failure on the drive containing the database.

To modify the location where these files are stored, click the [...] button: A selection dialog box appears, which allows selecting a folder or disk where the backups will be placed. The "Used Space" and "Free Space" areas are updated automatically
and indicate the remaining disk space on the disk of the selected folder. You should make sure that the free space is sufficient for all of your backups. If a backup fails due to a lack of disk space, an error is generated. The error is indicated in the
information area and in the Backup journal.
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Backup file names

4th Dimension names backup files using a specific naming system on which the automatic restore functions are based. This naming system cannot be changed.

Standard backups are named Databasename[xxxx].4BK, where databasename is the name of the database data file and xxxx is the number of the backup. For example, the 26th backup of the Invoices database is named Invoices[0026].4BK.
Backups of log files are named Logname[xxxx].4BL, where logname is the name of the log file of the database and xxxx is the number of the backup (starting at 0). For example, the 13th backup of the log file is named Log[0012].4BL.

Please note that log file backups start at 0 while database file backups start at 1. For the first database file backup (backup[0001].4BK for example), the log file backup is named log[0000]: it represents the changes made in the data file starting at its
"empty" state and can only be integrated into an empty data file. Consequently, a log backup named, for example, log[0025].4BL must be interpreted as the "26th backup of the log file, corresponding to operations performed between the 25th and
26th database backup". log[0025].4BL thus corresponds to the backup[0025].4BK backup.

Note: The backup numbering ranges are as follows:

backup: 1 to 9999
log file backup: 0 to 9998.
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Last backup information

The "Last Backup Information" area provides information on the last database backup. Information is provided if at least one backup has taken place.

Last backup: Date and time of the last backup.
Next scheduled backup: Date and time of the next backup; information is provided in this area if a backup schedule has been put into place.
Backup file name: Access path and file name of the last main backup. If the backup is segmented, the name of the first segment is displayed.
Log backup file name: Access path and file name of the last log file backup (if any).
Status: This area displays the error code of the last backup, as well as a description of this code. If the backup was executed properly, the area remains blank. For scheduled backups, you can use this area to verify that the last backup
occurred as scheduled.
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Backup settings

Like the configuration settings, backup settings are used for each backup. Moreover, any changes to these settings are optional. Their default values correspond to the standard use of the backup function.

The backup settings are defined on the Backup page of the application Preferences.

These settings are specific to each database opened with ADR Manager.
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Keep only the last X backup files

This parameter allows activating and configuring the mechanism used to delete the oldest backup files. It lets you keep a specific number of the last backup files on the backup disk — the oldest file is then deleted at each new backup— and thus
avoids the risk of saturating the disk drive.

This feature works as follows: once the current backup is complete, 4th Dimension deletes the oldest archive if it is found in the same location as the archive to back up and has the same name (you can request that the oldest archive be deleted
before the backup in order to save space).

If, for example, the number of sets is set to 3, the first three backups create the archives MyBase-0001, MyBase-0002, and MyBase-0003 respectively. During the fourth backup, the archive MyBase-0004 is created and MyBase-0001 is deleted.

Based on the space on the disk that you set aside for your backups, you can determine the maximum possible number of backup sets using the following equation:

Maximum number of sets = (Space available for backups / Maximum backup size) - 1 set

You must reduce the maximum number of sets by 1 because 4th Dimension, by default, first performs the current backup, then deletes the oldest archive from the disk. This behavior can be changed.

By default, the mechanism for deleting sets is enabled and 4th Dimension keeps 3 backup sets. To disable the mechanism, simply deselect the option.
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Glossary

Active window

A window that is in front of all other windows. To make a window active, simply click on it anywhere. If a window is not open, you can open it by choosing the appropriate menu item under the Windows menu.

Ancestor cue

A copy of a cue that exists in an earlier reel dupe. For instance, if there were a cue called JK101 in reel 1 v1 and another copy of JK101 in reel 1 v2, then the cue in v1 is considered the ancestor of the cue in v2. Likewise, the copy in v2 is considered
the descendant of the copy in v1.

Command key

The command key on the Macintosh is either of the two keys with the apple and the swirly design on it, just to the left and right of the space bar on an extended keyboard. When the manual says to use a command key you must hold down one of
these two keys while typing the appropriate key. For example, if the manual says to “type command-period”, hold down one of these special command keys while typing a period.

Conform action

A conform action is a single action in a list of actions called a conform note. In ADR Manager, conform actions insert and delete time in reels to match edits made to picture. You can enter conform actions using the Conform window (available under
the Manage menu when the Reel List window is active).

Conform note

A list of conform actions that, when applied to a reel dupe, adjust the edits and locations in a reel dupe to match a new picture dupe.You can enter conform actions using the Conform window (available under the Manage menu when the Reel List
window is active).

Cue sheet

A cue sheet is a type of report that displays cues. ADR Manager comes with many predefined cue sheets, as well as other types of reports. The predefined cue sheets have been designed for ADR editors, mixers, assistants, and actors.

Current time

The time value that ADR Manager maintains via MIDI communication with an outside source. The current time can be inserted in various time and text fields using menu commands, keyboard shortcuts, and applescripts.

Database

All of the information for a project lives in a single database. The database is separate from the ADR Manager application. A database is created by ADR Manager when you click on the New button while starting up ADR Manager, or choosing New
database under the File menu while another database is open.

Descendant cue

A copy of a cue that exists in a later reel dupe. For instance, if there were a cue called JK101 in reel 1 v1 and another copy of JK101 in reel 1 v2, then the cue in v2 is considered the descendant of the cue in v2v1 Likewise, the copy in v1 is
considered the ancestor of the copy in v2.

Dialog

A dialog is a Macintosh term for a window that appears on your screen. A dialog usually requires you to click on an OK button before continuing. Do not confuse the term “dialog” with the term “dialogue”.

Dialogue

Dialogue is the words that an actor says. A cue consists of dialogue, a start and end time, and various other information. Do not confuse the term “dialogue” with the term “dialog”.

Export

Exporting is a way of getting a subset of information out of your database and into another file. Typically you export certain information out of your database in order to import it into a new database so that you don’t have to retype it all over again in
the new document.
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the new document.

Field

A field is a term used in the database world to refer to a single piece of data of a particular type. It can be a number, text, or any other types. You might have to type something in a box to fill in a field, or check a checkbox, or click on a radio button. A
record consists of several fields. For example, a “character” record contains a “character name” field, an “actor name” field, and an “abbreviation” field.

FFOA

The First Frame Of Action. This is the start time of a reel, scene, cue, or take.

Hold region

You can hold a region after deleting (removing) it from a reel. Usually, you hold a region so that you can insert it later. Deleting, holding, and inserting regions is typically done when rebalancing reels or changing the order of scenes within a reel.

Import

Importing is a way of getting a subset of information into your database. Typically you import a file that was the result of a previous export. Importing and exporting is done so that you can copy information from one database to another without
retyping it all over again.

LFOA

The Last Frame Of Action. This is the end time of a reel, scene, cue, or take. By industry convention, the LFOA is inclusive, meaning that the frame refered to by the LFOA is included in the range of time. For example, if a reel starts at 01:00:00:00
and its LFOA is 01:00:00:01, it is 2 frames long (it consists of frames 01:00:00:00 and 01:00:00:01).

Lineage

The chronological order of the copies of a particular cue in different reel dupes. Copies in earlier reel dupes are considered ancestors of the copies in later dupes.

Project

The entire film, television show, video game, or other media production for which an ADR Manager database is created. Also called "show" or "production".

Record

A record is a term used in the database world to refer to information about an object, like a character, reel, or cue. A record consists of several fields. For example, a “character” record contains a “character name” field, an “actor name” field, and an
“abbreviation” field.

Record file

A record file stores records in a special format that is readable and writable only by the ADR Manager program. A record file may contain only one record, as in a report record file, or it may contain many records, as in a cue record file. Record files
can only be created by exporting, and only be read by importing.

Reel dupe

A reel dupes is a particular version of a reel. Reel dupes are created as the picture department makes changes to the reels in a project. ADR Manager requires that all reel dupes have unique dupe dates.

Reel dupe status

The reel dupe status field in a cue keeps track of the reel dupe in which a particular cue’s status changed. For instance, if a cue was recorded to v2.0 of a reel, then the reel dupe status is 2.0. Reel dupe status is independent of which reel dupe the
cue actually lives in, so in our example the cue may live in v3.0 of the reel but still display “recorded to v2.0” as its status.

“Remove” reel

When performing a move using the Move Time dialog, the remove reel is the reel you will be removing the region from. The region will be inserted into the “insert” reel.

Report
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A report is a list of records that is printed to a printer. Cue sheets are reports, as are Reel Lists and Line Count Tables.

Segment

A linear section of time in a project. Segments can be nested; in other words, segments can live within other segments. For instance, scenes are segments within reels, which are, in turn, segments within a project.

Session text file

A file that is exported from Pro Tools using the File > Export Session As Text menu item. The file contains general session information and lists of tracks, regions, and sound files.

Show

The entire film, television show, video game, or other media project for which an ADR Manager database is created. Also called “project”.

Status

A cue always has a particular status, like spotted, recorded, or cut. You typically change the status of a cue after you spot, record, or cut it. This lets you do searches and print reports based on cues’ statuses.

Structure file

The ADR Manager application file. Structure file is a term used by 4th Dimension, which is the database program ADR Manager is based upon.

Table

Records representing the same kind of object all live in the same table. For instance, character records live in the “character” table, whereas ADR cue records live in the “ADR cue” table. Also called record type.

Tag

(An advanced term) Some of ADR Manager’s records are variable in length, so in order to find them their location is stored in an address table. If an address table is damaged, 4D Tools uses markers, or “tags”, stored in the header of every record to
rebuild the address table.

Take

A recording of a cue. A cue typically has several takes, each of which may refer to a sound file on disk. Some takes span more than one cue if, for instance, the actor decided to perform several cues together in one long recording.

Text file

A text file is file that consists of readable letters. You can look at or change the information in a text file by opening it up in a word processor.

XML

Stands for Extensible Markup Language. XML files are text files that are specially formatted to allow, among other things, easy and accurate transfer of information between computer programs.
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